
Arrange Icons

Rearranges any icons (minimized windows) on the desktop, starting at the bottom left.

Back to Window menu



Change Lengths...

Allows you to change the length of one or more notes. It displays a Dialog where you set the amount by 
which the notes will be changed, and the Scope of the change.

The lengths may be changed in the following ways:

By Amount Make notes Longer or Shorter by a definable number of ticks.
Make Legato Change so there are no rests between the notes.
Remove Overlaps Change so notes don't overlap.
Fixed Length Make all notes the same length.

Back to Procedures Menu



Change Timing...

Allows you to change the time taken to play a group of events. It displays a Dialog where you set the 
Percentage of the original time for the events to be played in. For example, a setting of 50% will result in 
the notes being played in half the time, while 200% will make them play in double the time of the original. 
All types of event are affected, so a melody line with pitch bend will still sound right after having its timing 
changed - the relative positions of the notes and pitch bend data will be maintained.

Back to Procedures Menu



Clear

Removes the selected items from the song. This does not copy the items to the clipboard - and may not 
be pasted back into the song.

Back to Edit menu



Clipboard

An area of computer memory used for temporary storage of data.



Close All

Closes all windows which are capable of being closed except the Track Window.

Back to Window menu



Conductor Window

Zoom In - display fewer bars in the same space.

Zoom Out - display more bars in the same space.

To get to the furthest extent of a zoom, hold down the Control key while clicking on a zoom button.

Button

Close the window.

Selector

This affects how Conductor Points line up when you move them. For example, if it is set to 'Bar', they will 
'snap' to the nearest bar.

Displays

1. The Information Line shows detailed information about a selected point. You can adjust these values 
with the mouse.

2. The Time line shows the bars and beats currently being displayed. The width of each bar depends on 
the Time Signature - this can change if there are Time Signature changes defined in the Time Signature 
Display. By clicking on the time line while holding down the CONTROL key, the Play Position will jump to 
the mouse position.

3. The Time Signature Display is where Time Signature Points are shown. The horizontal position 
indicates time.

4. The Key Signature Display is where Key Signature Points are shown. The horizontal position 
indicates time. 

5. The Tempo Display is where Tempo Points are shown. The horizontal position indicates time. The 
vertical position indicates tempo - the higher the point, the faster the tempo.

Selecting Conductor Points



You can select points in any one of the three displays with either of these three methods:
1. Click on a point - it changes colour to indicate selection. Click on another one and that becomes 

the selected point. If you hold SHIFT and click on a point you can toggle its status between selected and 
normal. By using SHIFT clicking you can select several points.

2. With the left mouse button click on a part of the display where there isn't a point. Any selected 
points become deselected. While still holding down the left mouse button, drag down and to the right, 
enclosing points in the dotted 'drag rectangle' as you go. Release the mouse button. The points inside the 
drag rectangle become selected. This method is called lassooing.

3. By using SHIFT clicking you can select several conductor points.    You can use the Up and Down 
arrow keys to move selection to adjacent points.

When one point is selected, detailed information about it is given in the Information Line. You can use the 
Up and Down arrow keys to move selection to adjacent points.

Using the Edit functions

When using functions from the Edit menu, whether points are affected depends on their selection states. 
Only the selected points    will be affected. If no points are selected,    If no points are selected, none will 
be affected.
One method of copying one or more points is to select them and use the Copy function to place a copy of 
them on the clipboard. You can then Paste them into the display at the current Play Position.

Moving and Copying Conductor Points

Selected points can be moved and copied. Click on any one of the group and drag to a new position then 
let go of the mouse button. If you hold down the CONTROL key before you click, a copy of the points will 
be made at the new position, leaving the originals intact. The newly copied points then become the 
selected ones. Time and Key Signature Points can be dragged horizontally only. The first Tempo Point 
can only be dragged vertically to make sure it stays at position 1:01:000. The first Time and Key Signature 
Points cannot be dragged at all for the same reason.

Mouse Tools

To select a different mouse, hold down the right mouse button to bring up the Mouse Tool Selector. 
Move the mouse until the one you want is highlighted. Let go of the right mouse button - the selector 
disappears and the mouse cursor changes to the new shape.

1. The Arrow is at the top left so you can change back to it quickly - click the right button and release 
immediately - there's no need to drag.

2. The Pencil is used for entering new points. Click in the Time Signature, Key Signature or Tempo 
Displays and a new point is added. A warning message is displayed if there is already a time or key 
signature at that position. Time Signatures must be entered on bar lines in order to make musical sense. 
When you enter a Time Signature, it will be 4/4. If you need to change this, click on it to select it, then 
change its value in the Information Line with the left and right mouse buttons. Similarly, a Key Signature 
starts off as C, so click on it and change it in the Information Line to the signature you require.

3. The Eraser is used to delete points. Click on a point with the eraser and it disappears. If you click on 
one of a group of selected points, all the selected points are deleted. The first entry in each display cannot 
be deleted - in order to make musical sense the Conductor must contain an initial Tempo, Time Signature 
and Key Signature.



Playback

During playback the Transport Window shows the changing Tempo and Time Signatures providing the 
Conductor Switch is turned on.

Undo & Redo

You can use the Undo function to reverse the effects of the last editing operation. You can then use the 
Redo function to reverse the effects of the Undo function.

See also:
Adjusting Values, Transport Window.



Configure Fast Menu...

Displays a Dialog where the contents of the Fast Menu Window can be chosen.

To add a function, click on its name in the Functions list, then click on the Add button. The new function 
will now be visible in the Selections list. You can change the order in which a function will appear by 
clicking on its name in the Selections list, then clicking on the Up or Down buttons.

To remove a function from the Selections list, click on its name, then click on Delete.

To remove all functions from the Selections list, click on the Empty button.

Back to Window menu



click above for help on menus

ON-LINE REGISTRATION - Unlock Your Shareware Version
Introduction 
The Virtual Keyboard
Tutorials
Windows
Keyboard Shortcuts
Mouse Tools
Products
Trouble-Shooting 
Support

Sound Studio lets you record and edit up to 4 Stereo Audio tracks along with 256 MIDI tracks. It has a 
'Virtual Keyboard' with 20 professionally arranged styles. It has support for Video for Windows .AVI files 
which allows you to compose a soundtrack to your favourite Video clip. Sing along to Karaoke files and 
try your hand at audio and midi mixing. Give your music that professional touch with...

Evolution Sound Studio!

If you have Internet access from your PC, you can click on the web help buttons scattered around this 
help file to take you to pages with more information on the specific help topic you're after.

Extra help: You can access help on any of the menu items in the program by first selecting the menu 
item and then pressing F1.



Delete Events...

Allows you to delete one or more events. It displays a Dialog where you choose which types of events are 
to be deleted, and the Scope of the change (for Notes and Polyphonic After touch).

If you are deleting Controllers, there are 128 of them to choose from, including Volume, Pan, Data Entry 
etc. Set the Controller Scope to be All or Specific. If deleting a specific Controller, use the combo box to 
choose the one you want to delete.

Back to Procedures Menu



Delete Identical Events

Allows you to delete events which start at the same position and are identical in all respects.

When this is called from the Track Window only the selected pattern(s) will be treated. If you have not 
selected any patterns, all patterns on the selected track will be treated.

If you call it from an editing window (e.g. Piano Roll or Event) you can define which events are treated. If 
you select a number of events, only those events which are selected will be treated. If you have not 
selected any events, all events will be treated.

Back to Procedures Menu



Describe Clipboard...

Informs you what data, if any, is currently stored on the Clipboard. This window is for display purposes 
only and may not be edited.

Back to Edit menu



Devices...

If your computer has any MIDI interfaces installed, they will show up in the Devices Dialog. You can 
choose which ones to use by clicking on their names. A device is in use if it is selected (white text on a 
black background). Note that Inputs and Outputs are treated separately, so you can, for example, turn 
off the MIDI Out on the MPU-401 but still use its MIDI In.

The devices in use will be shown in the various selectors used in other parts of the program, such as the 
Metronome Dialog and Track Columns.

If you have problems with no MIDI input or output - try various combinations of MIDI IN/Out drivers until 
you hear sound. Try highlighting only one input and one output at any one time.
If you have an XG compatible soundcard- you must press the XG button to the right of the MIDI OUT you 
are using. The same applies if you have a GM or a GS card. 
After pressing OK - you will get a window asking if you wish to see the correct patches for the mode you 
are in. You should normally press OK for this -which will display the correct voice names and will show the 
variation sound names when the bank values are changed.

Back to Options menu



Select Drum Columns...

Displays a Dialog where you can choose which of the columns are displayed in the Drum Window. For 
example, if you prefer to see Drum Names but not the Channels and Notes they assigned to, turn on the 
Drum Name switch and turn off the Channel and Key switches.

Back to Options menu



Drum Window

Zoom In - display fewer bars in the same space.

Zoom Out - display more bars in the same space.

To get to the furthest extent of a zoom, hold down the Control key while clicking on a zoom button.

Toggle Switches

Speaker Switch - enable sending of selected hits to MIDI Out. When the speaker is selected - it will also 
play the drum sounds mapped to the top row of your QWERTY keyboard (¬ to the Tab button).

MIDI Edit Switch - enable MIDI Input to edit selected hit. This allows you to use an external keyboard to 
alter the pitch of notes currently highlited.

Step Switch - enable Step Time entry. This allows you to insert notes sequentially at your own pace from 
an external keyboard or by using the on-screen keyboard.

Buttons

Close the window.

Restore the pattern's original contents.

Selector

Determines the resolution of the Hit Display. This value is also used as the step advance amount in Step 
Time entry.

Displays

1. The Drum Display shows the name of each drum and various settings associated with it. You can 
choose which settings are visible by changing which Columns are visible. Click on any of the column 
headings and the Select Drum Columns Dialog will be displayed. Here you can turn columns on and off 
as required.

To the right of the columns is the Divider. You can drag this left and right so that some or all of the 
columns are obscured by the Hit Display.



2. The Time Line shows the bars and beats currently being displayed. The number of beats per bar 
depends on the Time Signature - this can change if there are Time Signature changes defined in the 
Conductor Window. By clicking on the time line while holding down the CONTROL key, the Play Position 
will jump to the mouse position.

3. The Information Line shows detailed information about a selected hit. You can adjust these values 
with the mouse.

To the right is the name of the current Kit. When the program loads, the GM.DRM Drum Kit file loads 
automatically. This contains the General MIDI Kit.

4. The Hit Display is a grid where notes are shown as coloured LEDs - based on the drum machine 
layout of a row of LEDs which indicate hits. Here, however, different colours are used to indicate velocity. 
The possible colours are: Red, Purple, Blue, Green, Dark Cyan, Dark Grey, Grey, Light Grey. If a hit is 
Red, it is at or above the Velocity setting for that drum. If it is Purple, it is at or above 10 below the 
Velocity setting. Each colour change represents a further reduction of 10.

Drum Settings

Name Can contain up to 20 characters.
Ch MIDI Channel.
Key MIDI Note associated with this drum.
Vel MIDI Velocity of hits when entered with the large Drum Stick.
Len The length in ticks of the note created when a hit is entered.

Drum settings can be changed directly with the mouse or in the Drum Settings Dialog. If you want to give 
a drum a different Name, double click on it and the Drum Settings Dialog is displayed. Here you can type 
the new Name and change any of the settings which appear in the Drum Columns. You can also rename 
the Kit. When you change the Key or Channel of a drum, a warning is given if that Key-Channel 
combination is already in use by another drum. It is possible to define a Kit which uses all 16 Channels, 
and with the same Key used on different Channels e.g. E1 used on Ch10 and Ch11 to play Snare Drums 
on two different patches.

If you decide to use more than one Channel (in case more than one synth or synth patch is being used for 
drum sounds), set the channel of the track containing the drum patterns to 0 so no rechannelization 
occurs when MIDI is sent.

If you click once on a drum's Name, you can move it up or down to a new position by dragging it with the 
mouse. This makes it possible to change the order of the drums to put them in a preferred order, e.g. to 
put all the Toms together.

Drum Buttons

Mute Prevents any MIDI data from being sent by a drum.
Solo MIDI data will be sent from the soloed drum ONLY. All other drums are muted. You can still click 
on the drum buttons to turn muting off if you want to hear other drums as well as the soloed one. When 
you click on a solo button, the statuses of all the mute buttons are stored, so that when solo is turned off 



the mute buttons return to their previous settings. If you then solo the SAME drum the statuses of the 
mute buttons return to what they were when the drum was soloed. If you solo a DIFFERENT drum to last 
time, all mute buttons are turned on.

Selecting Drum Hits

You can select hits with either of these two methods:
1. Click on a hit - it turns black to indicate selection. Click on another one and that becomes the 

selected hit. If you hold SHIFT and click on a hit you can toggle its status between selected and normal. 
By using SHIFT clicking you can select several hits.

2. With the left mouse button click on a part of the Hit Display where there isn't a hit. Any selected hits 
become deselected. While still holding down the left mouse button, drag down and to the right, enclosing 
hits in the dotted 'drag rectangle' as you go. Release the mouse button. The hits inside the drag rectangle 
become selected. This method is called lassooing.

3. By using SHIFT clicking you can select several drum events.    You can use the Up and Down arrow 
keys to move selection to adjacent notes.

When one hit is selected detailed information about it is given in the Information Line. You can use the Up 
and Down arrow keys to move selection to adjacent hits.

Using the Edit, Options & Procedures functions

When using functions from the Edit and Procedures menus, whether hits are affected depends on their 
selection states. Only the selected events will be affected. If no events are selected, ALL hits will be 
affected. Remember though, that in the Procedures Menu functions the Scope setting may exclude some 
of them.
One method of copying one or more hits is to select them and use the Copy function (Edit Menu) to place 
a copy of them on the clipboard. You can then Paste them into the pattern at the current Play Position.

Moving and Copying Drum Hits

Selected hits can be moved and copied. Click on any one of them and drag to a new position then let go 
of the mouse button. If you hold down the CONTROL key before you click, a copy of the hits will be made 
at the new position, leaving the originals intact. The newly copied hits then become the selected ones.

Functions Menu

Add Drum Adds a new drum at the bottom of the list.
Delete Drum Deletes the selected drum from the list.
Delete All Drums Deletes all drums in the list.

Mouse Tools

To select a different mouse, hold down the right mouse button to bring up the Mouse Tool Selector. 
Move the mouse until the one you want is highlighted. Let go of the right mouse button - the selector 
disappears and the mouse cursor changes to the new shape.



1. The Arrow is at the top left so you can change back to it quickly - click the right button and release 
immediately - there's no need to drag.

2 & 4. The Drum Sticks are used to enter new hits. The large stick enters a hit at the Velocity setting for 
that drum. The small stick enters a hit at a velocity 10 less than the Velocity setting. These two sticks 
therefore allow the entry of two levels of velocity, which can be regarded as normal and accented hits. If a 
stick clicks on an existing hit, it changes that hit's velocity.

3. The Eraser is used to delete hits. Click on a hit with the eraser and it disappears. If you click on one of 
a group of selected hits, all the selected hits are deleted.

5 & 6. Velocity Modifiers - The Up arrow increases the velocity of a hit by 10. This would make a purple 
hit red. The Down arrow decreases the velocity of a hit by 10. This would make a purple hit blue.

Step Time Entry

The Step Switch must be in the ON position. Notes arriving at MIDI In are recorded at the current Play 
Position with a length determined by the Grid setting. When you release the notes on the MIDI keyboard 
the Play Position advances by the same amount. To advance the Play Position without entering a note, 
press the space bar.

Using the PC Keyboard

The top row of keys on the computer keyboard can be used to play drums. The key on the far left plays 
the selected drum (the one whose name is highlighted) and the next one plays the drum below and so on. 
This makes it possible to play any set of drums simply by changing which drum is selected. In order for 
this feature to work - you must have the loudspeaker icon enabled.

You can also use the keys in step time entry. The Play Position advances automatically. Press the space 
bar to advance the Play Position without inserting a note.

The Note and Velocity of a selected hit can be changed by MIDI input or the keys.

Undo & Redo

You can use the Undo function to reverse the effects of the last editing operation. You can then use the 
Redo function to reverse the effects of the Undo function.

See also:
Adjusting Values, Conductor Window.



Edit Menu
The Edit Menu contains the following Menu Items:

Undo
Redo
Copy
Cut
Paste
Clear
Select All
Describe Clipboard...

Back to Contents



Event Window
Toggle Switches

Speaker Switch - enable sending of selected notes to MIDI Out.

MIDI Edit Switch - enable MIDI Input to edit selected note.

Step Switch - enable Step Time entry.

Buttons

Close the window.

Restore the pattern's original contents.

Insert an event of the type shown in the Ins Type selector.

Delete the selected event(s).

Make an identical copy of the selected event.

Selectors

Note Length - used in conjunction with the Insert button and in Step Time entry.

Choose the type of event to be added when the Insert button is pressed.

Use the Display Filters to specify which event types are shown. In this example any Notes, Program 
Changes and Pitch Bend will be shown.

The last three column headings change depending on what type of event is first in the list, or if any are 
selected, the type of the first selected event. In this example they are describing the Key, Velocity and 
Length of a note.

You can use the mouse to directly change the values in these columns, plus the event position.

Each type of event is shown in a different colour: the colours are the same as those used in the Piano 
Roll Window's Velocity Display.



During playback the left hand column shows a moving arrow which points to the events as they are 
played. If you click in this column while holding down the CONTROL key, the Play Position will jump to the 
mouse position.

Selecting Events

You can select events with either of these two methods:
1. Click on an event's name - it turns black to indicate selection. Click on another one and that 

becomes the selected event. If you hold SHIFT and click on an event you can toggle its status between 
selected and normal. By using SHIFT clicking you can select several events.

2. Click on an event's name - any selected events become deselected. While still holding down the 
mouse button, drag up or down, selecting more events as you go. Release the mouse button when you 
have selected all you want.

3. By using SHIFT clicking you can select several events.    You can use the Up and Down arrow keys 
to move selection to adjacent notes.

To deselect all selected events, click in the left hand column.

The Event window lists all possible GM MIDI controllers. It also lists XG controllers by name.
Controller 71 - Resonance (Harmonic content)
Controller 72 - Release Time
Controller 73 - Attack Time
Controller 74 -Filter Cut Off Frequency

Using the Edit, Options & Procedures Functions

When using functions from the Edit and Procedures menus, whether events are affected depends on their 
selection states. Only the selected events will be affected . If no events are selected, ALL events will be 
affected. Remember though, that in the Procedures Menu functions the Scope setting may exclude some 
of them.
To copy one or more events select them and use the Copy function (Edit Menu) to place a copy of them 
on the clipboard. You can then Paste them into the pattern at the current Play Position.

System Exclusive Editor

This allows you to edit directly the contents of a System Exclusive message. You can move the text caret 
around and type in new values in hexadecimal. To call it up, double click on the name of a Sysex event.

The default sysex message is called "Vanilla Sysex". There are other sysex commands which you can 
enter which are compatible with Yamaha's XG standard. These allow you to alter drastically the 
characteristics of the voices. Selecting one of these sysex messages from the list will enter a default 
sysex command into the event list. 

The default data value for these commands will be 00, so for any effect to take place you should enter 
your own data/part    values. Please refer to your XG documentation on which values to enter. 



Step Time Entry

The Step Switch must be in the ON position. Single notes and chords arriving at MIDI In are recorded at 
the current Play Position with a length determined by the Note Len setting. When you release the notes 
on the MIDI keyboard the Play Position advances by the same amount. 

Undo & Redo

You can use the Undo function to reverse the effects of the last editing operation. You can then use the 
Redo function to reverse the effects of the Undo function.

See also:
Adjusting Values, Piano Roll Window.



File Menu
The File Menu contains the following Menu Items:

New
Open
Save Song
Save As...
Revert to Saved
Merge Song....
Merge MIDI File...
Delete...
Print
Printer Setup
Quit

File Formats

The contents of each type of file are as follows:

Song (.SNG)

Tracks used.
Patterns used.
Timebase.
Tempo & Time Signature.
Song Start Time & Frame Format.
Left & Right Locators.
Lyric channel.
Notepad.

Pattern (.PAT)

Contents of pattern.

Drum Kit (.DRM)

Contents of Drum Kit.

Patch List (.PLS)

Text based voice list.

MIDI (.MID)

Standard MIDI File format, Type 0 or 1.

Definitions (.DEF)

Contains values from the Audio /Options Menu items:

Preferences...
Metronome Settings...
Devices...
Mixer Settings...



Audio System Settings...
Lyric Font...

Also, the current drum kit file plus the Port-Channel-Patch List connections and the knowledge of 
which Patch Lists are in use.

The file DEFAULT.DEF is saved each time you Quit from the program, and loaded the next time you run 
it, so these settings are preserved between sessions. 

Window Layout (.WND)

For each Window and the Program Window
Size and position.
Whether maximized or minimized.

Transport Window
Auto Return.
Record Mode.
Toggle switches.

Track Window
Visible Columns.
Horizontal & Vertical Zoom levels.
Snap settings.

Piano Roll Window
Horizontal & Vertical Zoom levels.
Grid resolution.
Speaker, MIDI, & Step switches.

Event Window
Note Length.
Insert Type.
Speaker, MIDI & Step switches.
Display Filters.

Score Window
Resolution.
Note Length.
Speaker, MIDI & Step switches.
Contents of Score Settings Dialog.

Drum Window
Zoom level.
Grid Resolution.
Speaker, MIDI & Step switches.
Visible Columns.

Conductor Window
Zoom Level.
Snap.

Fast Menu Window
Menu Items.

Mixer/Audio/Lyrics Window
Size
Minimized / Maximized status
Whether Open
Position of Scroll Bars

The file DEFAULT.WND is saved each time you Quit from the program, and loaded the next time you run 
it, so these settings are preserved between sessions.

Back to Contents



Introduction & Getting Started

Quick Start - Make music NOW!
What is Sound Studio?
Sound Studio Highlights
What you need
Sound Cards
Testing the sound card
The MIDI Interface
Sequencer basics
Digital Audio basics
CD sound
Harry Nyquist and his theorem
Direct-to-disk recording
Setting up your equipment
Selecting the MIDI Interface

What is Sound Studio?

Sound Studio is a powerful Audio / MIDI sequencer with integrated digital audio record and playback 
facilities. You can record and arrange music for a MIDI synthesizer and record digital audio patterns such 
as vocal riffs, drum loops, ambient background sounds and so on.

Sound Studio also has a Chord Track so you can add instant accompaniments in a variety of styles to 
your music. This can be used in conjunction with the Virtual Keyboard (VK-61) and is very easy to use 
and can save hours of arranging time.

Sound Studio supports up to 256 midi tracks. Using Sound Studio is like having your own band or 
orchestra - except you have much more control over your music with Sound Studio than you have over a 
band!

Sound Studio Features List

- 61 Note virtual keyboard "VK-61"
- Enhanced style play with 2 Variations & Fills, intro and outro
- Supplied with 20 fully arranged styles. 
- Piano mode, Fingered and Single Finger Chord style play and record
- Chord recognition
- Recordable Chord Track with 15 chord types
- Recordable Melody Track funtionality direct from the VK-61
- Convert chord track to midi tracks
- 256 MIDI Tracks 
- 4 Recordable Stereo Audio Tracks 
- Multi-track record (including multi-track MIDI record)
- Audio record and playback at 11.025, 22.05 or 44.1kHz
- AVI Support - Play video file in sync with music
- Audio track bounce down
- Audio input monitor
- Audio normalise function and swap L-R function
- Audio trim sample function
- Import & Export of wave files
- Glue facility for joining Audio or MIDI patterns together
- Realtime reverb, echo and delay for Audio tracks



- Realtime Panning and Volume for Audio tracks
- Punch In / Out
- Adjustable programmable mixer controls
- Multi-part score edit and printing
- Lyrics display and edit from score window
- Windows '95, '98 & NT support
- 'Big Time' Display
- Full GM, GS & XG Patch Lists Supplied
- Patch lists can be customised
- 16 Patch Lists can be in use at any one time.
- Custom background colours with coloured patterns and autodetect patterns
- Mini piano roll display

Sound Studio Highlights

As its name suggests, Sound Studio is a professional piece of software with many high-end features. 
However, because of its design and intuitive user-interface it's easy to use by professional musicians and 
beginners alike. Here are just a few of its many features:

*61 Key Virtual Keyboard called the VK-61. The program starts with this screen showing and you can get 
straight into playing by switching it on and hitting a key. You have 20 different music 'styles' to choose 
from and different play modes including 'playrite'. Using this it is impossible to play a wrong note!

* Intuitive Track window where you can copy and drag music patterns to create a song.
(We suggest you use a screen resolution of at least 800 x 600 to view all edit screens comfortably)

* Audio tracks where you can record audio parts in sync with your MIDI arrangement.

* Chord Track to let you create instant accompaniments with a few mouse clicks.

* A programmable Mixer which shows Controller information present in the tracks and which allows you to 
perform real-time mix downs.

* A grid-based Drum editor to help create and edit drum tracks.

* An easy-to-use Piano Roll editor which displays note velocity and MIDI Controller data.

* A multi-stave Score editor where you can see, edit and print your music in traditional notation.

* A Lyrics window which displays lyrics on screen in time to the music.

* A graphic Conductor window where you can quickly make adjustments to the time and key signatures.

* Full support for Standard MIDI Files.

* Patch Lists which let you select sounds by name rather than number.

* Support for multiple MIDI outputs - you can channel some tracks to your sound card's FM output, some 
to its Wave table sound and others to a MIDI interface.

Sound Studio has many more powerful features which you'll soon become familiar with, all fully explained 
in this help file.

What you need



To run Sound Studio you require the following:

* A IBM PC or compatible.

* An Intel Pentium processor or compatible running at a minimum speed of 90 MHz, preferably faster.

* Windows '95, '98 or NT.

* Minimum Requirement = 16Mb of RAM ( Increasing RAM size will improve overall performance of the 
program).

* 5Mb of hard disk space for the program plus additional hard disk space to store digital audio files. CD-
quality stereo sound uses 10Mb of hard disk space per minute although you don't have to use such high 
quality if you don't need it. See the section on Digital Audio basics for more information

* An SVGA resolution monitor. A better display will let you see more of the contents of each window and 
it's easier to work with more than one window at the same time.

* A PC sound card with a MIDI interface or a separate MIDI interface. If you want to use Sound Studio's 
digital audio playback facilities, you will also need a sound card which supports digital audio. See the 
sound card section for more information.

* A MIDI input device to record MIDI data. A keyboard is the most popular device but you could use a 
MIDI guitar or MIDI wind controller. The MK-261 keyboard for example is ideal for use with this program. 
Evolution produces other small keyboards specifically designed for use with computers. Ask Evolution for 
more information (contact details are in the Technical Support section). Even without an input device, you 
can still enter music into Sound Studio through step-time note entry and with the program's Keyboard.

* A MIDI output device in order to hear the music. If you have a sound card, you can use its built-in 
sounds. If you are using a standard MIDI interface this will be a synthesizer, sound module or sampler. 

Sound Cards

There are dozens of PC sound cards on the market. Sound Studio will work with any Windows-
compatible card, that is one which has drivers for Windows. You will see these in the Drivers section of 
the Control Panel and be able to select them in the MIDI Mapper in the Control Panel. All modern sound 
cards are compatible.

Sound Studio works with MIDI and audio data so there are two aspects of the sound card to consider. 
Most modern sound cards have a set of on-board sounds which can be used to play the MIDI parts. Most 
cards, too, also support digital audio. In order to work with Sound Studio, the card must have separate 
drivers for MIDI and audio. Again, all modern ones do.

Some older cards do not support digital audio. They will still work with Sound Studio providing they have 
Windows drivers but you will not be able to use Sound Studio's digital audio playback facilities. Also, 
some older cards use the same device driver for both audio and MIDI which will not allow you to play 
MIDI and audio simultaneously in Sound Studio.

A very important point about sound cards is whether or not they have 'full duplex' support. Sound Studio 
allows you to play and record audio simultaneously. It also allows you to record the midi from your 
soundcard as an audio track or tracks. This is only possible if your sound card has 'full duplex' support.

Testing the sound card



Make sure your sound card is installed correctly and the drivers are set up properly before using Sound 
Studio. The software which comes with the sound card should include routines to test the card. You must 
make sure it is running correctly under Windows, not just DOS.

1) From the start menu, go to settings-control panel and double click the multimedia control panel. 
You should be able to select an audio input and output device here
Click the MIDI tab
Here, it should be possible to select one device from the list of available devices for MIDI output

2) Try playing the CANYON.MID file which Windows installs automatically in the Windows\Media 
directory

3) Then try playing a .WAV file. Again, there should be some in the Windows\Media directory

If none of these steps above work it means the drivers have not been loaded. Go back to the Drivers 
Control Panel and install the correct drivers. Refer to your sound card's manual and the Windows Users' 
Guide for more information.

The MIDI Interface

Nearly all sound cards have a built-in MIDI interface which is accessed from a joystick connector on the 
backplane of the card. To use it you need a MIDI adapter. Evolution keyboards come with a lead that has 
a midi plug on one end and a joystick connector on the other. There is a diagram in your "Getting Started 
Guide" will give you more help on connecting this lead. If your soundcard does not have a joystick 
connector you may need to get hold of a MIDI interface.

There are also several dedicated MIDI interfaces available. Many are on plug-in cards which are fitted 
and installed into the PC just like a sound card.

There are also external MIDI interfaces which connect to the PC's printer port or serial port. You can 
install them without opening up your PC and they are ideal for use on portable PCs. You still have to 
install driver software for them. Some have a Thru socket which enables you to plug in your printer and 
use it without removing the interface. Other's don't.

Sequencer basics
If you're completely new to computer-based sequencing, read this otherwise you can skip to the next 
section.

A sequencer is the computer equivalent of a multi-track audio tape recorder - but with several important 
differences. On a traditional multi-track machine, each instrument will typically be recorded on its own 
track. To construct a song, each part has to be recorded from the beginning through to the end.

A MIDI sequencer such as Sound Studio has many more tracks than any multi-track recorder it's possible 
to build. Instead of forcing you to work from the beginning of a song to the end, Sound Studio uses 
patterns which enables you to assemble a song from many different phrases, dropping them into the song 
wherever you wish. This is infinitely more flexible and is the way many composers think and work.

Another important difference lies in the type of data the systems use. Multi-track recorders use audio 
data, sequencers use MIDI data which is simply lists of numbers. Every MIDI event has a corresponding 
set of numbers so you can alter any MIDI event simply by changing the numbers.

You can, for example, adjust the volume of a single note, add pitch bend to it or even change its sound 
completely. These things are impossible to do with a multi-track. You can change the tempo of a piece 



without changing the pitch and vice versa - another multi-track impossibility.

In short then, a sequencer gives you an enormous amount of control over every aspect of your music.

There's one very important point to remember - a sequencer stores details about a MIDI performance 
such as which keys where pressed, how hard, how long they were held down for, when the pitch bend 
wheel was moved and so on. It does not store the sounds used, rather it uses a system of Bank Select 
and Program Change messages to select sounds on the playback instrument.

This is actually very helpful as it means you can also change the sound used by a music part, changing a 
flute line to a trombone or set of bagpipes. Try to do that with a multi-track!

Digital Audio basics

If you're familiar with the principles of digital audio you can skip to the next section.

Digital audio recording is the process of converting audio data - sound - into digital data, essentially a list 
of numbers, which can be stored on a computer. The device which does this is built into most sound cards 
and is known, quite helpfully, as an Audio-to-Digital converter. This is often abbreviated to ADC.

To convert the digital data back into sound, the card uses a DAC converter. No prizes for guessing what 
this means.

To capture sound, the ADC takes a sample of it so-many times each second. This is known as the sample 
rate and it's measured in kHz or so-many thousand samples per second. The higher the rate, the more 
samples the ADC takes and the more accurate the digital representation of the sound will be.

The sampling resolution is the accuracy or fineness of the measuring scale used to store the sound and is 
measured in bits. There are two resolutions currently in common use - 8 bits and 16-bits - and most 
modern sound cards support both. Some of the latest generation of sound cards have a higher resolution, 
18 bits, which should result in even higher quality, professional sound reproduction.

To give you an idea of the relevance of the sampling resolution, imagine two people are building a 
house. One is using a measuring stick marked to the nearest foot. The other has a stick marked to the 
nearest inch. The one using the finer scale will build a more accurate house and although the other's may 
not fall down, it will certainly be a bit rough around the edges. That's how we perceive sound recorded at 
a lower sample resolution.

CD sound

CD quality audio is recorded at a sample rate of 44.1kHz with 16 bit resolution. Many Multimedia 
programs use a lower rate such as 22.05kHz or even 11.025kHz, and many use 8 bits. This is often quite 
adequate if the sound is played through inexpensive PC speakers but you would almost certainly be able 
to tell the difference if it was played through a good hi fi system. Sound Studio will only support 16 bit 
samples. It will not import 8 bit samples.

Harry Nyquist and his theorem

A little bit of theory here. Mathematician Harry Nyquist developed a sampling theorem which says, 
roughly, that in order to capture any sound accurately you must sample it at twice its highest frequency. 
(To be strictly accurate, the highest frequency is about 30 to 50 percent of the sample rate but half is near 
enough for most folk who aren't recording engineers.)



The average human ear can recognize frequencies up to about 15kHz. Even the most sensitive ears 
rarely sense anything over 20kHz which is why CDs recorded at 44.1kHz sound so clear.

Bear in mind Harry's theorem when you're recording. You may be able to use a lower resolution 
particularly if you're recording speech. However, if you record music at a lower resolution and it doesn't 
sound very good you'll know why!

Direct-to-disk recording

One minute of CD-quality sound requires 10Mb of storage space. Clearly it's impractical, not to say 
expensive, to store this in RAM. So it's not, it's saved to disk. The saving has to be done on the fly, while 
the sound is being recorded, and you need a reasonably fast hard disk if the data is to be saved 
accurately and played back without a glitch.

Most modern disks are well up to the job but some older ones may cause a glitch, especially if they are 
running in a slow PC. Just something to bear in mind.

When you record digital audio using Sound Studio it saves it direct-to-disk 

Setting up your equipment

Make sure the MIDI interface or sound card and Sound Studio are correctly installed. If you are using an 
external MIDI keyboard connect it's MIDI Out to the interface's MIDI In.

If you are using the sounds on another keyboard or sound module, connect its MIDI In to the interface's 
MIDI Out. If you are using the sounds on a sound card this is not necessary.

If you want to use Sound Studio's audio playback facility, make sure the sound card's audio output is 
connected to a pair of speakers or to a mixer and other amplification equipment.

Selecting the MIDI interface

VERY IMPORTANT

You must tell Sound Studio which MIDI devices you want to use before you do anything else, so after 
starting the program, go to the Options menu and select Devices...    The window will show which MIDI 
Input and Output    devices Sound Studio has recognized.
The Audio driver must be enabled from your Windows Multimedia Control panel.

If you cannot see your sound card or MIDI interface here it means the drivers have not been installed so 
check the card or interface's documentation and install the drivers. When the drivers are properly installed 
you will see them in the Drivers Control Panel and in this window.

You must select at least one Input and one Output device by clicking on them to highlight them. You can 
select any or all devices. If you select more than one Input device, Sound Studio will accept input from 
them all during recording. 

Avoid using the MIDI Mapper as this tends only to add confusion. All MIDI devices can be individually 
selected in the Devices dialogue box. Sound Studio is designed to not select the MIDI Mapper by default.

If you select more than one Output device, you can assign any of them to any of the tracks during 
playback, allowing you to send music lines to different MIDI devices. There's more about this later in the 
help document.



Go on to Tutorials



Help Menu
The Help Menu contains the following Menu Items:

Contents
Menus
Windows
Keyboard Shortcuts
How to Use Help
About Sound Studio...

Back to Contents



How to Use Help

Displays the built-in information on using the MS Windows Help system.



Keyboard Shortcuts

Action
Key(s)

  

Transport Window
Return to Zero Home
Go to end of last pattern End
Metronome On / Off M
Cycle On / Off C
Follow On / Off F
Conductor On / Off O
Edit Solo On / Off E
Punch In and Out On / Off P
Rewind Left Arrow
Forward Right Arrow
Stop (+ Enter a Rest in Step 
Time entry)

Space

Play Return / Enter
Record +
Jump to Left Locator L
Jump to Right Locator R

Quantize directly (using 
current settings)

Q

Next Page (Score Print 
Preview)

Pg Up

Previous Page (Score Print 
Preview)

Pg Dn

Change Note Len Setting 
(Score Window)

1 to 7, D, T, N

Play Drum Sounds (Drum 
Window)

All keys on the top row

Track Window
Track and record select Arrow keys
Delete pattern Del (when pattern selected)
Delete selected track Del (when no patterns selected)

View Menu
Display Track Window F2
Display Piano Roll Window F3
Display Event Window F4
Display Score Window F5
Display Drum Window F6
Display Conductor Window F7
Display Notepad Window F8
Display Mixer Window F9
Activate Menu Bar F10
Display Keyboard Window F11
Display Lyrics Window F12
Display Instant Chord Track Shift + F7
Display Audio Window Shift + F8



Display Track Settings Shift + F9
Display Pattern Settings Shift + F10

Edit Windows
Go to next event (Edit 
Windows)

Down Arrow

Go to previous event (Edit 
Windows)

Up Arrow

Edit Menu
Insert Event (Event) Insert
Delete / Clear Delete
Undo Alt + Backspace or Ctrl + Z
Redo Shift + Alt + Backspace or Ctrl + A
Copy Ctrl + Insert or Ctrl + C
Cut Shift + Delete or Ctrl + X
Paste Shift + Insert or Ctrl + V
Move selected events Ctrl + Cursor Keys

File Menu
Open Ctrl + O
Save Song Ctrl + S

Procedures Menu
Transpose Ctrl + T
Change Velocity Ctrl + H
Change Lengths Ctrl + L
Quantize Ctrl + U
Move Events Ctrl + J
Change Timing Ctrl + I
Delete Events Ctrl + D
Thin Out Continuous Events Ctrl + N
Delete Identical Events Ctrl + Y
Reverse Notes Ctrl + R

Window Menu
Cascade Windows Shift + F5
Tile Windows Shift + F4
Close a Window Ctrl + F4
Next Window Ctrl + F6
Show / Hide Transport Bar Ctrl + F7
Show / Hide Editors Strip Ctrl + F8
Show / Hide Fast Menu Ctrl + F9

Keyboard Window
Intro 1
Variation 1 2
Variation 2 3
Fill 1 6
Fill 2 7
Outro 0
Stop SPACE
Start / Play ENTER



The Virtual Keyboard

-- Click on the picture to learn more about each of the functions --

The Virtual Keyboard is designed to get you making music with Sound Studio straight away! 
It is already switched   on   so ... 

Press a key near the bottom of the keyboard and ... 

Instant music! 

Next click on the 'playrite' button for real easy play!

Using the keyboard you can play and record a backing track and a melody and then listen to it back. 
To record your Chord track in realtime using the screen keyboard take a look at the Chord Track Tutorial



Lyric Font...

Displays a Dialog where you can choose a font, whether it is bold or italic, and its size. This font is used in 
the Lyrics Window. Large text is useful if you want to sing the lyrics, while a smaller font is better for 
viewing the lyric sheet as a whole because more lines can fit in the window.

Back to Options menu



Lyrics Window
This window displays any lyrics present in your song or MIDI file. 

During play each lyric event is highlighted when it is time for it to be sung. Many files contain words split 
into syllables, which helps you scan the word correctly while singing. When the play position is moved, 
the highlighting changes to show the position in the lyric sheet at that point in the song.

If you want to edit the lyrics, or enter your own, select the pattern containing the lyric melody and open 
the Score Window. Note that the Score Settings dialog allows you to define the MIDI channel containing 
the lyric melody, to ensure the lyrics are shown in the right place.

To change the display settings goto the Options menu and select Lyric Font. Here you can choose a 
different font, or change its size and style.

See also:
Score Window.



MIDI Settings...

Timebase defines how many ticks make up one beat. The larger the number, the shorter the time 
between each tick, and the more faithfully real time performances can be recorded and played back. 
However, the PC has to work harder at higher time bases, so if you don't need high precision, use a lower 
value.

Note that if all your patterns are quantized to 16ths, a timebase of 48 will still be 12 times finer than you're 
actually using (there are 6 MIDI clocks in a 16th note and the MIDI clock has a timebase of 24: 6 x (48/24) 
= 12).

Evolution changes its timebase to suit that of any Standard MIDI File (.MID) it loads, so you can open the 
MIDI Settings Dialog to see what timebase the file is set to.

Message Filters are a set of switches which determine the MIDI message types allowed to enter at MIDI 
In. Remember though that if, for example, you turn on the Pitch Bend filter, you won't be able to record 
any pitch bend!

Channel Filters are another set of switches which allow you to keep out MIDI messages, but here you 
can keep out all message types on any number of the 16 MIDI channels.

Thru Channel Messages is a switch which determines whether channel-based messages, such as notes 
and pitch bend, received at MIDI In are echoed to MIDI Out.

Thru Real Time Messages is a switch which determines whether timing messages are echoed to MIDI 
Out.

Reset Controllers on Stop means that when you stop the sequencer, Evolution sends a number of 
messages on each MIDI channel which do such things as center pitch bend wheels, zero modulation 
wheels and turn off hanging notes.

Kill Notes on Cycle tells Evolution to turn off any notes which are currently being played when the Right 
Locator is reached (assuming the Cycle switch is on). It prevents unwanted notes hanging on when play 
jumps to the Left Locator.

Chase Events tells Evolution to make sure that when you move the Play Position, external MIDI 
instruments are told what all their settings should be at that point in the song - program change, pitch 
bend, modulation wheel etc. - so the song sounds right when you restart play.

Back to Options menu



Menu Items

Each Menu contains a number of items used to access various functions. Each item may act directly or 
call up a Dialog Box. Menu Items which are followed by three dots (...) call up a Dialog Box. Others act 
directly.



Merge MIDI File...

This allows you to load a MIDI file from disk and merge it into the song you are currently working on. The 
tracks of the MIDI file are placed at the bottom of the track list, so there's no danger of them overwriting 
the existing tracks.

The tempo and time signature of the original MIDI file are not affected, so again there's no danger of 
losing the settings of the piece you are working on.

Merge MIDI files is a useful tool for merging XG MIDI files from programs such as XG Edit.

Back to File menu



Merge Song...

This allows you to load a song from disk and merge it into the song you are currently working on. The 
tracks of the song being merged are placed at the bottom of the track list, so there's no danger of them 
overwriting the existing tracks.

The tempo and time signature of the original song are not affected, so again there's no danger of losing 
the settings of the piece you are working on.

Back to File menu



Metronome Settings...

The Metronome Settings Dialog allows you to tailor the Metronome to your requirements. You can have a 
beep from the PC speaker and / or a click played on an external MIDI instrument.

If you use the MIDI option you can determine separately the notes used by the first beat of the bar and by 
the other beats, plus their velocities.

If you turn on the Record Only switch the metronome operates during recording only. Turn this switch off 
if you want to hear the metronome during playback.

The Count in Bars setting defines how many bars of metronome clicks will be given before recording 
begins.

See also:
Transport Window.

Back to Options menu



Mixer Settings...

The top two knobs (i.e. the red and blue ones) can have their use redefined. You can select from several 
message types and set the maximum and minimum values sent when you move the knobs.

Even XG controllers can be assigned making it very easy to have real time filter sweeps and other 
awesome effects in your mixes.

The Dialog also contains the following switches:

Text Under Faders Three radio buttons are available:
Volume    the word Volume itself is displayed.
Track Names    the program checks the ports and MIDI channels of the tracks and displays the name of a 
track under the matching mixer channel for the appropriate port.
Patch Names    the program checks the ports and MIDI channels of the tracks and displays the name of a 
patch under the matching mixer channel for the appropriate port. This is taken from the patch list 
associated with that port-channel assignment.

MIDI Input to mixer This allows you to decide whether messages arriving at MIDI In move the controls.

Song to mixer This lets you decide whether MIDI messages in the song are sent to the mixer controls - if 
it is turned on the knobs and faders move in real time as the song plays the corresponding MIDI 
messages. They also move when you relocate the Play Position - the Chase Events feature in the MIDI 
Settings Dialog which sends the current values of volume, pan etc. via MIDI also updates the positions of 
the mixer controls. If the Song to mixer switch is turned on part way through a song or MIDI File the 
controls update even if playback has been stopped.

Record mixer movements This switch enables recording of the movements of the knobs and faders. 
Other actions recorded are Flatten Mixer (flatten all the controls in the mixer), pressing a channel's Flat 
button (flatten all a channel's controls), and CONTROL clicking on an individual control to flatten it.
When playing back a recording of mixer moves which contains more than one MIDI channel, it is best to 
set the track's channel to 0 (no rechannelization) so the same channels are played back. If only one MIDI 
channel was recorded the track's channel can be assigned to that channel or left at 0, whichever is 
preferred.

Volumes Only This switch causes the mixer to display the Volumes and meters only. It allows you to see 
more mixer channels on screen at once as the space used by each channel is much less.

See also:
Mixer Window.

Back to Options menu



Mixer Window

The Mixer contains a set of 16 MIDI channels for each MIDI Output driver in your system. Each channel 
contains a Record button, a Volume slider, 3 knobs, 2 switches and a meter. All except the meter can 
transmit MIDI data to your sound card or external synthesizer. Click on a control and move the mouse up 
or down (there's no need to move the mouse when you click on a button or switch). 

Along the top of the mixer screen is a row of MIDI Devices recognised by your system. As long as your 
sound card has been installed correctly - the devices will be displayed across the top

The record buttons correspond to the Rec buttons on the track window
Not all sound cards and synthesizers support Reverb and Chorus.

In addition to sending data via MIDI Out, the mixer can also respond to data arriving at MIDI In and to 
data contained in a song. The controls move in response to the same messages they are capable of 
sending, so the Volume faders move in response to MIDI Volume data and so on. You can decide how the 
mixer responds with switches in the Mixer Settings Dialog.

The mixer screen in Sound Studio also allows you to control the levels of each Audio channel. As long as 
an Audio driver is installed on your PC it will be recognised by our program. Along the top of the mixer 
screen will be an Audio button. When this button is pressed it displays 16 tracks of audio faders and 
knobs. The Audio tracks must be present in the track window for them to be accesible from the mixer 
screen. 

If you click on a Port name and it displays a grey looking mixer, it means you haven’t enabled that port 
from the Options/Devices menu. This mixer is a multiple port mixer which means you have a separate 



mixing console for each of your outputs. This is ideal if you are playing the internal sounds on your 
soundcard AND sending MIDI messages to an external sound module/synth.
The last Port name is called Audio. This is where we change the levels of the Audio patterns. Click on the 
Audio button at the top right of the mixer screen.

The Audio device in use is dependent on the device set up in the Multimedia section of your control panel 
(Win95).

Each Audio track has it’s own set of Volume slider, Pan control, Reverb Depth Control, Reverb Delay 
control, mute and solo buttons.
First, we’ll only change the volume level.

The mixer screen has a VU display area for both MIDI and Audio tracks. If the Audio recording is in 
stereo, you should see 2 narrow coloured strips flashing independently of each other in the VU meter 
section of the mixer. If the recording was done in mono, both coloured strips will flash in tandem. If you 
wish to conserve processing power for other purposes, you can turn off the VU meters in the mixer screen 
by disabling the Display Audio Meters on Mixer option in the Preferences section of the Audio System 
Settings menu. 

Try moving the volume fader up and down by clicking on it with the left mouse button and moving it 
vertically. You are now behind the desk of a professional Digital Mixing console - on your own PC ! 
Try reducing the volume levels of each audio track until no distortion occurs.

Grouping Volume Faders
One of the most handy features of real life mixers is the ability to grab hold of numerous sliders and slide 
them up or down together. Your only limitation is the number of hands you have! Sound Studio allows you 
to group faders together with a simple right mouse button click and move them all at once using the 
mouse. 
You can group as few as 2 or as many as 16 faders together for realtime automation. 

How to group the faders
It's quite easy to group the faders together - all you do is click on a fader using the right mouse button. 
You'll notice the center band change colour to red. Another click will change it to green. There are 8 
colours in total which you can toggle through until you get back to the grey coloured fader (no grouping). 

By grouping all 16 faders you can create fade ins or fade outs to your songs. By doing this however - 
please remember that it will create a vast amount of MIDI data and could cause glitches in timing. In this 
case you should trim down the MIDI data.

By default, a fader is not part of any group, and its centre band is grey.
A right click on a volume fader changes the colour of its centre band. The colour identifies which group it 
is part of. There are 8 groups, enough for 8 pairs in each mixer if necessary.

If you press the Snapshot button the positions of all the knobs and faders are sent via MIDI. If you are 
recording and the 'Record mixer moves' switch is turned on, these settings will be recorded. It is a good 
way of storing the settings for a song once you have set them up.

If you press the Auto Size button the window is resized so it is the exact width and height of one set of 16 
channels. If the Volumes only switch in the Mixer Settings Dialog is on, it is accounted for.

To flatten all channels, press the Flatten Mixer button.



The buttons across the top of the window allow you to go directly to a port without using the vertical scroll 
bar. The highlighted button shows which mixer is at the top of the window.

See also:
Adjusting Values. Using the Mixer Screen to alter the Delay, Echo and Reverb Levels



New

This removes the current song from memory - use it when you want to start a new song.

Back to File menu



Notepad Window
This allows you to include textual information with each song. The contents of the Notepad are saved in 
the song file and displayed automatically when a song is loaded.

When you type, word wrapping happens automatically, and you can use the Copy, Cut, Paste, Clear, and 
Undo functions from the Edit Menu. If you use Copy or Cut to place text on the clipboard, you won't lose 
any patterns or events already there.

See also:
Adjusting Values.



Open

Loads a file from disk. The following file types are allowed:

Song (.SNG)
Pattern (.PAT)
Drum Kit (.DRM)
Patch Lists (.PLS) - this option is enabled only when patch list screen is open.
MIDI File (.MID)
Definitions (.DEF)
Window Layout (.WND)
Wave file (.WAV) - this option is only enabled when importing wave files into the Audio window.

File types currently available are shown in the drop down menu in the file-open dialogue box labelled 'List 
Files of Type':

Shown here are the file types available when you first go to file-open.

Back to File menu



Patch Lists...

Evolution's Patch List system allows each MIDI instrument connected to your system to have its own 
Patch List to describe the patches available in that instrument.

There are two ways to call up the Patch Lists Dialog.
1. Click in the Patch column in the Track Window. It is the track whose Patch entry is clicked on which will 
be changed.
2. Click on MIDI Menu and choose the Patch Lists... entry. In this case it is the selected track's setting 
which will be changed.

A Patch List file contains:
1. The name of the Instrument (up to 18 characters)
2. A prefix (up to 7 characters)
3. 128 patch names (each up to 18 characters)

The prefix is important because if the track's Patch column simply showed 'Organ', it would be impossible 
to tell which instrument's organ sound was being used, so if an MT-32 was receiving on that track's MIDI 
channel, 'MT32 Organ' would be displayed, as opposed to 'GM Organ' or 'U220 Organ'.

The Patch Lists Dialog contains the following:

Current Instrument This combo box contains the names of all patch lists in memory. You can choose 
which instrument's patch list is displayed. Up to 16 patch lists can be held in memory.

Add This button lets you load a new patch list from disk.

Remove This button removes the current patch list from memory. It can be reinstated later by pressing 
the Add button.

Number This shows the number of the currently selected patch. You can type a new number here as one 
way of changing patch.

List of Patches This shows the names of all patches in the list. It shows 64 at a time and has a horizontal 
scroll bar which allows you to choose which 64 are visible. Clicking on a patch name selects it, copies its 
name to the Patch Name field and puts its number in the Number field. Double-clicking on a name selects 
it and exits the Dialog as though OK had been pressed.

Bank This value is the one shown in the Bank column of the Track Window. It is given here so you can 
change it at the same time you change patch.

Bank Type There are different types of bank message. This switch allows you to decide which type of 
message is sent. GM has no bank messages, so the Bank value is disabled if you choose GM.

GS Variations These buttons give you easy access to the bank numbers of the most important GS 
variations. They are only available when Bank Type is GS.

XG  This button gives you easy access to the bank numbers of the    XG variations. 

Set to OFF Click on this button to exit the Dialog and change the Prog setting to OFF.

Routings... Displays the Routings Dialog (see below).

OK This button exits the Dialog and installs the selected patch in the track's Patch column and its number 
in the Prog column.



Cancel This button exits the Dialog without changing patch.

As is usual in Windows Dialog boxes, the Return / Enter key activates the default button. Initially this is 
the OK button, so pressing return closes the Dialog and installs the selected patch in the track's Patch 
column and its number in the Prog column. The Tab key exits the current field. This is the key to use if 
you have typed a new entry and want to keep it but not exit the Dialog.

Routings Dialog

This provides an easy way of telling the program which instruments are connected to each Output Port. 
Often one Port can be sending MIDI to more than one instrument, so you can enter which instrument is in 
use on each channel. These connections are used by the Patch List system to decide which List to 
display when the Patch Lists Dialog is called up. For example, if Track 4 uses Port B, MIDI Channel 7, the 
system needs to know which instrument is connected to Port B and is receiving on Channel 7. The same 
knowledge is used when the text in the Track Window's Patch column is printed. These routings are 
changed when a new instrument is chosen from the Current Instrument combo box in the Patch Lists 
Dialog. For example, if you click on Track 4's Patch column to call up the Patch Lists Dialog and change 
the current instrument, this change is stored by the system and will also show up in the Routings Dialog. 
You do not have to use the Routings Dialog to set the Port-Channel-Patch List connections, but it is an 
easier way of looking at the information, and in ensuring that in future the correct Patch Lists are 
displayed whenever the Patch Lists Dialog is called up.

The Dialog contains the following:

Port A combo box containing all the MIDI Output Ports in use. Use this to choose which Port's 
connections are displayed.

Channel Instrument Combo boxes Allow each MIDI Channel in the current Port to be 'connected' to any 
of the Patch Lists.

Drum Switches Allow you to decide whether each MIDI Channel in the current Port is a drum channel. 
Patterns on a drum track can be edited in the Drum Window. Notes on drum tracks are not fed in to the 
Chord readout in the Transport Window. Not all sound cards will support playback of drums on MIDI 
channels other than 10.
The XG standard will allow you to assign drum channels to numerous MIDI channels. To do this you 
would click on all the channels you wanted to assign to drums and call up the appropriate drum kit list for 
that channel.

Set All Channels to Button and Combo Box provide a quick way of 'connecting' all MIDI Channels on a 
Port to the same Patch List.

The Port-Channel-Patch List connections and the knowledge of which Patch Lists are in use is stored 
in .DEF files, so when DEFAULT.DEF is saved on Quit, everything is remembered ready for the next 
session. When you first use Evolution, there will be no DEFAULT.DEF file present: this will cause the 
program to load in 16 Patch Lists by default.

In the Track Window, when you change a track's Channel or Port setting the program also updates the 
Patch column to make sure the correct Patch List is used to show the patch name.

The Track Settings and Pattern Settings Dialogs each contain a Patch button. It contains the patch name 
which corresponds to the Program / Port / Channel settings. Pressing it calls up the Patch Lists Dialog. 
Changing the Program, Channel or Port values also updates the patch name.

See also:
Track Window. XG Patch screen
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Piano Roll Window

Zoom In - display fewer bars in the same space.

Zoom Out - display more bars in the same space.

Vertical Zoom In - display fewer notes in the same space.

Vertical Zoom Out - display more notes in the same space.

To get to the furthest extent of a zoom, hold down the Control key while clicking on a zoom button.

Toggle Switches

Speaker Switch - enable sending of selected notes to MIDI Out.

MIDI Edit Switch - enable MIDI Input to edit selected note.

Step Switch - enable Step Time entry.

Buttons

Close the window.

Restore the pattern's original contents.

Selectors

Determines the resolution of the Note Display. This value is also used as the note length in Step Time 
entry.

Determines which events are shown in the Velocity Display.

Displays

1. The Timeline shows the bars and beats currently being displayed. The number of beats per bar 
depends on the Time Signature - this can change if there are Time Signature changes defined in the 
Conductor Window. By clicking on the timeline while holding down the CONTROL key, the Play Position 
will jump to the mouse position.



2. The Information Line shows detailed information about a selected note. You can adjust these values 
with the mouse.

3. The Note Display is a grid where notes are shown as rectangles. The horizontal position indicates 
start time. The width of the rectangle shows the note length.

4. The Velocity Display can contain note velocities, after touch, controllers, channel pressure and pitch 
bend. You can edit them with the mouse. Each type of event is shown in a different colour: the colours are 
the same as those used in the Event Window.

5. The Screen Keyboard, at the left edge of the window, has four uses:
a) It indicates the pitch of notes in the Note Display.
b) By clicking on it you can play MIDI notes.
c) You can use it to enter notes in step time.
d) It shows notes arriving at MIDI In.

Selecting Notes

You can select notes with either of these four methods:
1. Click on a note - it turns black to indicate selection. Click on another one and that becomes the 

selected note. If you hold SHIFT and click on a note you can toggle its status between selected and 
normal. 

2. With the left mouse button click on a part of the Note Display where there isn't a note. Any selected 
notes become deselected. While still holding down the left mouse button, drag down and to the right, 
enclosing notes in the dotted 'drag rectangle' as you go. Release the mouse button. The notes inside the 
drag rectangle become selected. This method is called lassooing.

3. By using SHIFT clicking you can select several notes. You can also lasso many notes, hold the 
SHIFT key down and click on other notes to select them.
When one note is selected detailed information about it is given in the Information Line. You can use the 
Up and Down arrow keys to move selection to adjacent notes.

4. By pressing the up and down cursor keys you can step through all of the notes in the piano roll 
window. This is a good way of detecting if you have doubled notes (notes hidden under other ones).

Selecting Events in the Velocity Display

The velocity display area at the bottom of the piano roll window is the place to draw in your MIDI 
controllers using the mouse. By default it shows the velocity values of all notes, but you can configure it to 
show events such as Pan, modulation, expression - or indeed any MIDI controller event! Use the pencil 
tool to insert MIDI events and use the crosshairs to edit those values. 

Either of the above methods can be used, and the events turn black. If note velocity is being displayed 
you can select notes by selecting their velocities. When lassoing events in the velocity display the drag 
box needs to encompass all of the event in order for it to be selected.



To create controller fade-ins and fade-outs select the pencil tool, hold down the SHIFT key on the 
computer keyboard, then click once to select the point at which the fade is to start and click again for 
where you want the fade to end. This method will create a controller entry for each grid amount. To create 
more controller data set the grid amount to a greater resolution 32..64.. To create less controller data, set 
the grid amount to a lesser amount 4.. 2.. It is not recommended that you use this function with the grid 
set to off as this will generate a large amount of MIDI data.

To create a velocity fade-in or fade-out or to impose a ramp-effect on existing controller data, repeat the 
above steps but using the cross hairs tool instead of the pencil.

Using the Edit & Procedures functions

When using functions from the Edit and Procedures menus, whether events are affected depends on their 
selection states. Only the selected events will be affected. If no events are selected, ALL events will be 
affected. Remember though, that in the Options Menu functions the Scope setting may exclude some of 
them.
One method of copying one or more events is to select them and use the Copy function (Edit Menu) to 
place a copy of them on the clipboard. You can then Paste them into the pattern at the current Play 
Position.

Moving and Copying Events

Selected events can be moved and copied. Click on any one of them and drag to a new position then let 
go of the mouse button. If you hold down the CONTROL key before you click, a copy of the events will be 
made at the new position, leaving the originals intact. The newly copied events then become the selected 
ones.

Selected events can also by moved by holding down the CONTROL key and using the arrow keys. 
Events will be moved by a grid amount left and right and by a note up and down.

Mouse Tools

To select a different mouse, hold down the right mouse button to bring up the Mouse Tool Selector. 
Move the mouse until the one you want is highlighted. Let go of the right mouse button - the selector 
disappears and the mouse cursor changes to the new shape.

1. The Arrow is at the top left so you can change back to it quickly - click the right button and release 
immediately - there's no need to drag.

2. The Pencil is used for drawing and sizing. In the Note Display you can draw in a new note or change 
the size of an existing note. To move the start position of a note click on the left half; to move the end of a 
note click on the right half. Drag the mouse to the required position and release the mouse button.

You can also draw in the Velocity Display. If any event type except Velocity is chosen as the display type, 
you can use the pencil to draw in new data, a pitch bend curve, for example.

3. The Eraser is used to delete events. It works in both the Note and Velocity Displays. Click on an event 



with the eraser and it disappears. If you click on one of a group of selected events, all the selected events 
are deleted.

4. The Cross hairs cursor is used for modifying existing data in the Velocity Display. Hold down the left 
button and drag the mouse around - if the cross hairs move across any data it will change to a new value 
proportional to the height of the cross hairs in the display. You can use a single click to change a single 
value or drag the mouse right and left to reshape a controller curve. If Velocity is the display type you can 
create a crescendo by dragging the cross hairs left to right across the velocities, moving up the screen as 
you go.

5. The Knife is used to slice a note in two. The position you click on the note determines the end position 
of the first note and the start of the second one.

6. The Glue is used to join two notes of the same pitch to create one new note which starts where the first 
note started and ends where the second one ended. Click anywhere on a note and it will be glued to the 
next note of the same pitch.

Step Time Entry

The Step Switch must be in the ON position. Single notes and chords arriving at MIDI In are recorded at 
the current Play Position with a length determined by the Grid setting. When you release the notes on the 
MIDI keyboard the Play Position advances by the same amount. To advance the Play Position without 
entering a note, press the space bar.

You can also use the Screen Keyboard to enter notes -- click on one of the notes and a note of that pitch 
is recorded. The Play Position advances automatically to insert the next note.
Undo & Redo

You can use the Undo function to reverse the effects of the last editing operation. You can then use the 
Redo function to reverse the effects of the Undo function.

See also:
Adjusting Values, Event Window, Conductor Window.



Preferences...

Within the Options menu you will find a Preferences section which allows you to configure various 
aspects of the program to suit your own personal tastes!

If ever you’re working on a song and you wished the program did this, or didn’t do that, then check out the 
preferences menu as there’s a good chance the feature you are after is hidden away in here. The 
preferences menu contains many options including disabling warning messages that occasionally pop-up 
when you least expect them!

Copy Patterns as Parents determines the type of pattern created when you copy a pattern. If the box is 
checked, patterns are copied as Parents and have a solid outline. If the box is unchecked patterns are 
copied as Children and have a dotted outline. For more details on Parent and Child patterns see the 
section in the Arranging Tutorial.

Chord Track Conflict Warning determines whether or not a message is displayed if one ore more of the 
MIDI tracks is set to the same MIDI channel as any of the parts in the chord track. If you attempt to record 
on channels 10 to 15 whilst the chord track is open, a conflict warning will appear explaining that the 
channels are already in use. If you ignore the warning, the chord track will continue to play - but your 
recorded MIDI tracks will pick up the same voices as those used in the chord track. The best thing to do in 
this case is to either record on channels 1 to 9, or remove the chord track. Also make sure that the VK-61 
Virtual Keyboard is switched off.

Conductor Warning determines whether you get a warning message if you change or insert a Conductor 
Point in the Conductor window which will affect the timing relationship between MIDI and Audio data. 
Audio patterns play back at a fixed speed whereas MIDI tracks can be set to play at any speed by 
changing the tempo. If you change the speed of MIDI playback, the audio patterns will not then be in sync 
with the MIDI patterns.

Ask before extract type 0 MIDI file determines whether you are asked before the program extracts the 
contents of a type 0 MIDI file. Format 0 files can contain several MIDI channels in one track. If this box is 
checked when Sound Studio loads a Type 0 file it will ask if you want to extract the channels. If the box is 
not checked it will automatically extract them.

Leave MIDI file data unchanged
Sound Studio has an intelligent way of reading in MIDI files by extracting the useful information such as 
bank select values and program changes and placing them in the track columns. Sometimes however 
you would want to see exactly what is embedded in the MIDI file. Enabling this mode will allow you to see 
all the data in the event list window. By being in this mode - the patch names will not appear in the patch 
column.

Number Program Changes from 1
Some patch lists have the program numbers going from 1 to 128 rather than from 0 to 127. This option 
allows you to change modes to see the numbering system starting from 1. The patch lists will be 
unaffected by this. This feature is very convenient for XG lists as they start from 1 rather than 0.

If Single Edit Window is checked, it’s only possible to have one edit window open at any one time. If the 
Score editor is open, for example, and you open the event editor, the score editor will close and the event 
editor will then show the contents of the pattern. Also, if an editor is open and you select another pattern, 
its contents will appear in the editor. This is not possible when using multiple edit windows as you must 
select a pattern before opening a new edit window. Use this option if you prefer the screen to be relatively 
clear of editors.

When Show Midi Pattern Names is checked, each pattern in the track window will have its pattern name 
displayed on it. Often this will be the same as the track name but it is possible to give each pattern a 



name by highlighting each pattern in turn and selecting pattern settings from the view menu. 

Show Midi Pattern Contents allows the user to see a mini piano roll display for each of the patterns in 
the track window. This can be very useful for seeing where you are in an arrangement. The display can 
be enhanced by clicking on the vertical zoom in tool.

The Timer Resolution slider tells the Windows Multimedia Timer how often to supply timing pulses to the 
program. The resolution is in milliseconds and the values range from 1 to 20. On slower computers, lower 
resolutions will require more of the computer’s processing power which may not leave much for other 
tasks. 

If you experience timing problems, increase the Timer Resolution until playback is steady. The three 
buttons offer useful preset guides for users of 386, 486 and Pentium PCs but don’t be afraid to 
experiment with the settings if you experience timing difficulties.

Double clicking on a MIDI pattern, by default, will open up the piano roll edit screen. If you’re not too 
keen on working in this editor and would rather work in any of the other editors, then this is where you can 
customise the double click action of your mouse. You can decide whether a double click on a MIDI pattern 
takes you to the Piano roll editor, Event, Score or Drum editors. If you’d rather use the editor’s strip to 
access the various editor screens, then why not select the Pattern Settings option when double clicking 
on MIDI patterns. The Pattern settings screen will display various parameters which are pattern specific, 
i.e. volume, pan, reverb level, program number etc.

Double clicking on an audio pattern will, by default, open the Audio edit window. You can however 
configure it so that a double click will take you to the Audio pattern settings window, allowing you to 
quickly change the pattern name or the timing offset of the sample.

The Track and Program window background options allow you to customise your working environment to 
suit your mood! It’s amazing how a different background colour can sometimes bring on a quick burst of 
inspiration that’s perfect when nearing the end of a project! Some of the backdrops are, how would you 
say,. "loud"- and a bit of an eyesore if selected for a long duration of time, so, by default some more 
pleasant background colours are used. 
Sometimes if playing an AVI file, or by task switching between other applications you might notice that the 
background colours will change colour slightly. This is due to palette clashing caused by viewing in 256 
colours. To avoid this - go to your control panel in Windows and change your display settings to 16 
colours or 16bit HiColor.

This allows you to set the velocity level of the notes played from the screen keyboard. It’s default value is 
100 but you can have any value between 1 (very quiet) and 127 (loudest possible note). 

Screen keyboard MIDI velocity sets the velocity value used when clicking on the Virtual Keyboard 
(VK-61).

Default Chord Track Volume sets the default value for the volume of the chord track. This affects 
program startup and file-new. The volume during normal program use can be easily adjusted using the 
style volume slider or by changing the volume of the chord track in the track window.

Sound Studio will extract a MIDI file into patterns and tracks upon load. This operation can be limited by 
means of the Ask before extract type 0 MIDI file option and the Leave midi file data unchanged option 
as explained above. 

In addition to these two options there are extra options in the Pattern creation after loading MIDI file 
section that can control exactly how the patterns are created. These options are as follows:

If Remove Gaps is selected, Sound Studio will chop up the extracted patterns on each track and make 
multiple patterns containing the MIDI data. Where there is no MIDI data on a track each gap will be 



removed. It is possible to control the resolution of this function in beats by setting the Smallest gap to 
remove option. 

Sound Studio can also be instructed to find repeated sections in MIDI files. This reduces the size of any 
resulting Song File saved and also allows work to be carried out on a parent 

See also:
Track Window.

Back to Options menu



Quantize...

Allows you to change the start positions of one or more notes so they are more regularly placed. Notes 
move forward or backward depending on where the nearest beat or division of a beat is. A Dialog is 
displayed where you decide the Quantize Setting (16ths etc.), the Percentage by which the notes will be 
moved, and the Scope of the change.

The percentage setting allows notes to be lightly or heavily quantized. With a Quantize Setting of 16ths, a 
percentage of 50 will make notes move half way to the nearest 16th, while 100% will make them move all 
the way.

You can also change the quantize setting directly from the track window with the pull down menu next to 
'Q-Rec'.

Back to Procedures Menu



Quit

Choose this when you want to close the whole program.

Back to File menu



Reverse Notes

Allows you to change the start positions of a group of notes so they play in reverse order.

When this is called from the Track Window only the notes in the selected pattern(s) will be reversed. If 
you have not selected any patterns, the notes in all patterns on the selected track will be reversed.

If you call it from an editing window (e.g. Piano Roll or Event) you can define which notes are reversed. If 
you select a number of notes, only those notes which are selected will be reversed. If you have not 
selected any notes, all notes will be reversed.

Back to Procedures Menu



Save...

This is where you can save a file you are working on. When you enter the File Dialog, the name of the file 
last accessed is shown and the directory shows only files of that type. You can change the file type by 
clicking on one of the radio buttons at the right side of the Dialog.

If you are saving a song, you could use the Save Song function, which is quicker.

If you are saving a MIDI file, you can save either a Type 0 file (a single track) or a Type 1 file (two or more 
tracks). The program checks to see how many tracks contain patterns. If only one track contains patterns, 
it saves a Type 0 file, otherwise it saves a Type 1 file.

If you have several tracks containing patterns, but want to save a Type 0 file, choose Select All from the 
Edit Menu, then Merge Patterns from the Track Window's Functions Menu. Delete the old tracks so only 
the 'Merged' track remains. Choosing Save... will now save this as a Type 0 file.



Save As...

When you want to save a new file for the first time this is the function to use. You need to specify which 
type of file you want to save, then type in the name in the filename entry at the top of the Dialog.

You can also use this to save a file you are working on with a different name, thereby copying it.

If you are saving an untitled song, you could also use the Save Song function.
If you are saving a MIDI file, you can save either a Type 0 file (a single track) or a Type 1 file (two or more 
tracks). The program checks to see how many tracks contain patterns. If only one track contains patterns, 
it saves a Type 0 file, otherwise it saves a Type 1 file.

If you have several tracks containing patterns, but want to save a Type 0 file, choose Select All from the 
Edit Menu, then Merge Patterns from the Track Window's Functions Menu. Delete the old tracks so only 
the 'Merged' track remains. Choosing Save As... will now save this as a Type 0 file.

If you would like to save the contents of the audio window as a new wave file, first double click the audio 
pattern and then go to the file menu and Save As... Any audio data between the left and right markers will 
be saved - which means you can save off certain ranges within your sample as completely new wave 
files. If the start and end points are set to 0 and 999999 respectively, the whole sample will be saved as a 
wave .WAV file.

The save window works using the standard Windows convention. Locate the directory path and type in 
new file name then click on OK. If the same file-name is chosen, you will be warned that you are 
overwriting another file.

Back to File menu



Scope

The Scope setting allows you to restrict the range of notes which will be treated. For example you may 
want to change only notes From G 2 To C 4. The values are inclusive, so in this example G 2 and C 4 
would be treated as well as all notes between. Alternatively you can choose to treat All notes.

If you call the Options menu function (Transpose etc.) from an editing window (e.g. Piano Roll or Event) 
you can define scope more precisely. If you select one or more notes, only those notes which are 
selected will be treated. This overrides the Scope setting, and the Scope controls in the Dialog are 
disabled. However, if you have not selected any notes, the Scope setting acts just as if you had called it 
from the Track Window.



Score Settings...

Displays a Dialog containing the settings which help determine the layout of the score display, both when 
editing and printing.

Margins (points from the edge of the screen / 
page)

Left, Right, Top, Bottom

Spacing (points)
Inter-note the horizontal distance between notes / 

rests.
Inter-stave the vertical distance between staves.

Text Sizes (points)
Title size of the font used for the song title 

printed at the top of the page.
Names + Bars size of the font used for the patch name 

and bar number.

Clef can be Treble (normal, 8va above, 8va 
below), Bass (normal, 8va above, 8va 
below), Treble and Bass.

T & B Split Point the lowest note placed on the Treble 
Stave when using the Treble and Bass 
clef.

Detect Automatically this switch turns Automatic Clef Detection 
off if required.

Detect Now this button tells the program to detect the 
clef immediately. The Stave Display 
updates if a different clef is calculated.

Printing
Print Page Numbers the page number will be printed at the foot 

of each printed page if this is turned on.
Maximum Staves this lets you limit the number of staves 

printed on each page.

Sloping Beams these switches turn this feature on or off 
as required.

Screen, Printer

Display Bar Numbers this switch turns on the numbering of bars 
and applies to both screen and printer.

Simplify Display this switch makes the display less exact 
but easier to read. It reduces the number 
of short rests by modifying note durations. 
This is only a visual change, the MIDI 
data is not affected.

Lyrics on Channel type in the MIDI channel containing the 
lyric melody. The Score Window needs to 
know this so it can display the lyrics under 
the correct notes.



Back to Options menu



Score Window
Toggle Switches

Speaker Switch - enable sending of selected notes to MIDI Out.

MIDI Edit Switch - enable MIDI Input to edit selected note.

Step Switch - enable Step Time entry.

Buttons

Close the window.

Restore the pattern's original contents.

Switches the Stave Display between Print Preview and Edit.

Selectors

Determines the shortest note and rest drawn in the Stave Display.

This value determines the shape of the Note cursor and is used in Step Time entry.

Off allows you to input all possible note lengths into the score editor and is the fastest way of inserting 
notes when using the mouse.
64 represents a hemi-demi-semi quaver
32 represents a demi-semi quaver
16 represents a semi-quaver
8 represents a quaver
4 represents a crotchet
2 represents a minim
1 represents a semi-breve

A "T" after the number signifies a triplet value
A dot (.) after the number will add half that notes' length to itself. It will turn a crotchet for example (1 beat) 
into a dotted crotchet (one and a half beats).

Displays

1. The Information Line shows detailed information about a selected note. You can adjust these values 
with the mouse.



To the right is a display of the pitch and position (bars:beats:ticks) of the mouse.

2. The Stave Display is where notes are shown on a stave. The clef can be changed in the Score 
Settings Dialog. If you click on an empty part of the Stave Display while holding down the CONTROL key, 
the Play Position will jump to the mouse position.

Single or Multi channel Staves

If you select a pattern containing notes on one MIDI channel and then open the Score Window, a single 
part display is created. If you open the window with a pattern containing notes on two or more MIDI 
channels, a multiple stave system display is generated, with each instrument having its own stave.

You may cut, copy and paste notes between channels in the multiple stave display. If you attempt to insert 
notes on a stave within the multiple stave display and get a warning message - it means the pattern 
length needs to be increased in the track window as there is not enough workspace within than pattern to 
insert notes.
See also the Score window tutorial

Selecting Notes

You can select notes with either of these two methods:
1. Click on a note - it turns red to indicate selection. Click on another one and that becomes the 

selected note. If you hold SHIFT and click on a note you can toggle its status between selected and 
normal. 

2. With the left mouse button click on a part of the Stave Display where there isn't a note. Any 
selected notes become deselected. While still holding down the left mouse button, drag down and to the 
right, enclosing notes in the dotted 'drag rectangle' as you go. Release the mouse button. The notes 
inside the drag rectangle become selected. This method is called lassooing. To continue lassooing. notes 
in later bars, hold the mouse against the right edge of the window and the display will flow more notes 
into the lasso rectangle.

3. By using SHIFT clicking you can select several notes.    You can use the Up and Down arrow keys 
to move selection to adjacent notes.

When one note is selected detailed information about it is given in the Information Line. You can use the 
Up and Down arrow keys to move selection to adjacent notes.

Using the Edit, Options & Procedures functions

When using functions from the Edit and Procedures menus, whether events are affected depends on their 
selection states. Only the selected events will be affected. If no events are selected, ALL events will be 
affected. Remember though, that in the Procedures Menu functions the Scope setting may exclude some 
of them.
One method of copying one or more events is to select them and use the Copy function (Edit Menu) to 
place a copy of them on the clipboard. You can then Paste them into the pattern at the current Play 
Position.



Moving and Copying Notes

Selected notes can be moved and copied. Click on any one of them and drag to a new position then let 
go of the mouse button. If you hold down the CONTROL key before you click, a copy of the notes will be 
made at the new position, leaving the originals intact. The newly copied notes then become the selected 
ones.

Functions Menu

Delete Lyrics... Deletes all the lyrics in the song.

Mouse Tools

To select a different mouse, hold down the right mouse button to bring up the Mouse Tool Selector. 
Move the mouse until the one you want is highlighted. Let go of the right mouse button - the selector 
disappears and the mouse cursor changes to the new shape.

1. The Arrow is at the top left so you can change back to it quickly - click the right button and release 
immediately - there's no need to drag.

2. The Note cursor enters a note with a length specified by the Note Len combo box. The pitch and 
position are calculated from where the mouse button clicks on the stave. These values are shown in the 
Information Line. The Note cursor can also be used to change the length of an existing note - the note's 
length changes to that of the cursor.

3. The Eraser is used to delete notes. Click on a note with the eraser and it disappears. If you click on 
one of a group of selected notes, all the selected notes are deleted. The eraser can also be used to 
delete lyrics - just click on the lyric.

4. The Glue is used to join two notes of the same pitch to create one new note which starts where the first 
note started and ends where the second one ended. Click on a note and it will be glued to the next note 
of the same pitch. This can also be thought of as a means to tie two notes.

5, 6. The Sharp and Flat cursors are used for modifying existing notes. One sharpens a note, the other 
flattens it. If the SHIFT key is held down the note changes by an octave, otherwise it changes by a 
semitone.

7. The Pen is used to enter and edit lyrics. Click on an existing lyric and an edit control appears, into 
which text can be typed. TAB moves to the next lyric, RETURN terminates editing.

If you want to add lyrics, click on the head of the note under which the lyric is needed; a new lyric is 
created. When you have finished editing this lyric, press TAB to advance to the next note without a lyric 
and type again. When you have finished, press RETURN to stop editing.

When you make a change to the lyrics, they will immediately be reflected in the Lyric Window if it is open. 



You can cause a line feed by typing a lyric event containing a # sign only. This allows you determine the 
line breaks for when the lyrics are printed in the Lyric Window.

Step Time Entry

The Step Switch must be in the ON position. Single notes and chords arriving at MIDI In are recorded at 
the current Play Position with a length determined by the Note Len setting. When you release the notes 
on the MIDI keyboard the Play Position advances by the same amount. To advance the Play Position 
without entering a note, press the space bar.

Time and Key Signatures

Different time signatures can be displayed, allowing any changes in the Conductor Window to be acted 
upon when the score is displayed.

Automatic Clef Detection

On entry to the Score Window the program scans the pitches and works out the best clef to display the 
notes on. It is not called at any other time, so it is still possible to change the clef in the Score Settings 
Dialog without the program changing it back. You can turn Automatic Clef Detection off.

Using the PC Keyboard

The keys 1 to 7 on the top row of the PC keyboard can be used to change the value in the Note Len 
combo box. The 'D', 'N' and 'T' keys select the dotted, normal or triplet version. If the Note cursor is in 
use, its shape changes.

Print Preview

The Print Preview / Edit switch toggles between Print Preview and the normal Edit display. The Print 
Preview display is a scaled version of what will appear on the printed page. The scale depends on the 
window size - on an 800x600 display a better display is possible than on a 640x480 display thanks to the 
extra display area available. The size of the displayed page depends on size of the    window, so use 
maximise for best results.

The Page number is printed and two arrow buttons are displayed to allow the page to be changed - the 
PgUp and PgDn keys operate these buttons as well as the mouse.

Undo & Redo

You can use the Undo function to reverse the effects of the last editing operation. You can then use the 
Redo function to reverse the effects of the Undo function.

See also:
Adjusting Values, Conductor Window.



Select All

Selects all items in the current window. Selected items are black (except muted patterns which change 
from light grey to dark grey).

Back to Edit menu



TG300B Voices

Bank Select    MSB=Bank Number, LSB=000

Instrument   
Program

Bank
Voice Name

Piano 1 0 GrandPno
8 GrndPnoK
16 MelloGrP
126 A-Piano1
127 a.piano1

2 0 BritePno
8 BritPnoK
126 A-Piano2
127 a.piano2

3 0 E.Grand2
1 ElGrPno1
2 ElGrPno2
8 ElGrPnoK
126 A-Piano3
127 a.piano3

4 0 HnkyTonk
8 HnkyTnkK
126 A-Piano4
127 e.piano1

5 0 E.Piano1
8 Chor.EP1
16 VX El.P1
24 60sEl.P1
25 HardEl.P
26 MelloEP1
32 El.Pno1K
126 A-Piano5
127 e.piano2

6 0 E.Piano2
8 Chor.EP2
16 VX El.P2
24 DX Hard2
32 El.Pno2K
126 A-Piano6
127 e.piano3

7 0 Harpsi.1
8 Harpsi.3
16 Harpsi.K
24 Harpsi.2
126 A-Piano7
127 e.piano4

8 0 Clavi. 2
8 Clavi. K
126 E-Piano1
127 hnkytnk 2



Chromatic 
Percussion

9 0 Celesta
126 E-Piano2
127 e.organ1

10 0 Glocken
126 E-Piano3
127 e.organ2

11 0 MusicBox
126 A-Guitr1
127 e.organ3

12 0 Vibes
1 HardVibe
8 VibesK
126 A-Guitr2
127 e.organ4

 13 0 Marimba
8 MarimbaK
17 Balafon2
24 Log Drum
126 A-Guitr3
127 pipeorg1

14 0 Xylophon
126 E-Guitr1
127 pipeorg2

15 0 TubulBel
8 ChrchBel
9 Carillon
126 E-Guitr2
127 pipeorg3

16 0 Dulcimer
1 Dulcimr2
8 Cimbalom
126 Slap-1 2
127 acordion

Organ
17 0 DrawOrgn

1 70sDrOr1
8 DetDrwOr
9 70sDrOr2
16 60sDrOr1
17 60sDrOr2
18 60sDrOr3
24 CheezOrg
32 DrawOrg2
33 EvenBar 
40 Organ Ba
126 Slap-2
127 harpsi1

18 0 PercOrgn
1 70sPcOr1
8 DetPrcOr
32 PercOrg2
126 Slap-3
127 harpsi2

19 0 RockOrgn



8 RotaryOr
16 SloRotar
24 FstRotar
126 Slap-4
127 harpsi3

20 0 ChrchOrg
8 ChurOrg2
16 ChurOrg3
24 OrgFlute
32 TrmOrgFl
126 Slap-5
127 clavi1

21 0 ReedOrgn
126 Slap-6
127 clavi2

22 0 Acordion
8 AccordIt
126 Slap-7
127 clavi3

23 0 Harmnica
1 Harmo 2 
126 Slap-8
127 celesta1

24 0 TangoAcd
126 Finger-1
127 celesta2

Guitar
25 0 NylonGtr

8 Ukulele
16 NylonGt3
24 VelGtHrm
32 NylonGt2
40 LequintG
126 Finger-2
127 synbras1

26 0 SteelGtr
8 12StrGtr
9 Nyln&Stl
16 Mandolin
32 SteelGt2
126 Picked-1
127 synbras2

27 0 Jazz Gtr
1 MelloGtr
8 PdlSteel
126 Picked-2
127 synbras3

28 0 CleanGtr
8 ChorusGt
126 FretlsBs
127 synbras4

29 0 Mute.Gtr
8 FunkGtr1
16 FunkGtr2
126 A-Bass
127 synbass1



30 0 Ovrdrive
126 Choir-1
127 synbass2

31 0 Dist.Gtr
8 FeedbkGt
9 FeedbGt2
126 Choir-2
127 synbass3

32 0 GtrHarmo
8 GtFeedbk
126 Choir-3
127 synbass4

Bass
33 0 Aco.Bass

126 Choir-4
127 newagepd

34 0 FngrBass
1 FngBass2
126 Strngs-1
127 synharmo

35 0 PickBass
8 MutePkBa
126 Strngs-2
127 choir pd

36 0 Fretless
1 Fretles2
2 Fretles3
3 Fretles4
4 SynFretl
5 Smooth
126 Strngs-3
127 bowed pd

37 0 SlapBas1
8 ResoSlap
126 Strngs-4
127 soundtrk

38 0 SlapBas2
126 E-Organ1
127 atmosphr

39 0 SynBass1
1 SynBa1Dk
8 AcidBass
9 FastResB
10 TeknoBa 
16 ResoBass
126 E-Organ2
127 syn warm

40 0 SynBass2
1 ClkSynBa
2 ModulrBa
3 Seq Bass
8 DX Bass
9 X WireBa
16 RubberBa
17 SynBa2Dk
18 MelloSB1



19 SmthBa 2
126 E-Organ3
127 synfunny

Strings
41 0 Violin

8 SlowVln
126 E-Organ4
127 synecho1

42 0 Viola
126 E-Organ5
127 rain

43 0 Cello
126 E-Organ6
127 synoboe

44 0 Contrabs
126 E-Organ7
127 synecho2

45 0 Trem.Str
8 SlowTrStr
9 Susp Str
126 E-Organ8
127 synsolo

46 0 Pizz.Str
126 E-Organ9
127 synrdorg

47 0 Harp
126 SoftTP-1
127 synbell

48 0 Timpani
126 SoftTP-2
127 squareld

Ensemble
49 0 Strings1

1 Slow Str
8 Orchestr
9 Orchstr2 
10 TremOrch
11 ChoirStr
16 S.Strngs
24 VeloStr 
126 TP/TRB-1
127 strsect1

50 0 Strings2
1 70s Str
8 LegatoSt
9 Warm Str
10 S.SlwStr
126 TP/TRB-2
127 strsect2

51 0 Syn.Str1
1 Syn Str4
126 TP/TRB-3
127 strsect3

52 0 Syn.Str2
126 TP/TRB-4
127 pizz.str



53 0 ChoirAah
8 S.Choir
9 MelChoir
32 Ch.Aahs2
126 TP/TRB-5
127 violin 

54 0 VoiceOoh
126 TP/TRB-6
127 violin 2

55 0 SynVoice
8 SynVox2
126 Sax-1
127 cello 1

56 0 Orch.Hit
1 OrchHit2
8 Impact    
16 LoFiRave
126 Sax-2
127 cello 2

Brass
57 0 Trumpet

1 Trumpet2
24 BriteTrp
25 WarmTrp
126 Sax-3
127 contrabs

58 0 Trombone
1 Trmbone2
126 Sax-4
127 harp 1

59 0 Tuba
1 Tuba 2
126 Brass-1
127 harp 2

60 0 Mute.Trp
126 Brass-2
127 guitar 

61 0 Fr.Horn
1 FrHorn2 
8 FrHrSolo
16 HornOrch
126 Brass-3
127 guitar 

62 0 BrasSect
8 BrssSec2
126 Brass-4
127 elecgtr1

63 0 SynBras1
1 PolyBrss
8 SynBras3
9 QuackBr
16 AnaBrss1
126 Brass-5
127 elecgtr2

64 0 SynBras2
1 Soft Brs



8 SynBras4
16 AnaBrss2
17 VelBras2
126 Orch-Hit
127 sitar

Reed
65 0 SprnoSax

127 a.bass 
66 0 Alto Sax

8 HyprAlto
127 a.bass 

67 0 TnrSax 
8 BrthTnSx
127 e.bass 

68 0 Bari.Sax
127 e.bass 

69 0 Oboe
127 slapbas1

70 0 Eng.Horn
127 slapbas2

71 0 Bassoon
127 fretles1

72 0 Clarinet
127 fretles2

Pipe
73 0 Piccolo

127 flute1
74 0 Flute

127 flute2
75 0 Recorder

127 piccolo1
76 0 PanFlute

127 piccolo2
77 0 Bottle

127 recorder
78 0 Shakhchi

127 panpipes
79 0 Whistle

127 sax1
80 0 Ocarina

127 sax2
Synth Lead

81 0 SquareLd
1 Square 2
2 Hollow
3 Mellow
4 SoloSine
5 Shmoog    
6 LMSquare
8 SineLead
127 sax3

82 0 Saw.Lead
1 Saw 2      
2 PulseSaw
3 ThickSaw
4 Big Lead



5 VeloLead
6 HeavySyn
7 DynaSaw
8 Dr. Lead
16 WaspySyn
127 sax4

83 0 CaliopLd
2 Pure Pad
127 clarint1

84 0 Chiff Ld
127 clarint2

85 0 CharanLd
8 DistLead
127 oboe

86 0 Voice Ld
127 eng.horn

87 0 Fifth Ld
1 Big Five
127 bassoon 1

88 0 Bass &Ld
1 Big&Low 
2 Fat&Prky
127 harmnica

Synth Pad
89 0 NewAgePd

1 Fantasy2
127 trumpet1

90 0 Warm Pad
1 ThickPad
2 Horn Pad
3 RotarStr
4 Soft Pad
127 trumpet2

91 0 PolySyPd
1 PolyPd80
127 trmbone1

92 0 ChoirPad
1 Heaven2 
127 trmbone2

93 0 BowedPad
127 fr.horn1

94 0 MetalPad
1 Tine Pad
2 Pan Pad
127 fr.horn2

95 0 Halo Pad
127 tuba

96 0 SweepPad
1 PolarPad
8 Converge
9 Shwimmer
10 Celstial
127 brssect1

Synth Effects
 97 0 Rain

1 HrmoRain



2 AfrcnWnd
8 ClaviPad
127 brssect2

98 0 SoundTrk
1 Ancestrl
2 Prologue
127 vibe1

99 0 Crystal
1 SynMalet
2 SftCryst
3 RndGlock
4 LoudGlok
5 GlockChi
6 ClearBel
7 XmasBell
8 VibeBell
9 DigiBell
16 ChorBell
17 AirBells
18 BellHarp
19 Gamelmba
127 vibe2

100 0 Atmosphr
1 WarmAtms
2 NylnHarp
3 Harp Vox
4 HollwRls
5 NylonEP
6 AtmosPad
127 symallet

101 0 Bright
127 maletwin

102 0 Goblins 2
1 GobSyn 2
2 50sSciFi
127 glocken

103 0 Echoes
1 EchoBell
2 Echo Pan
3 EchoPad2
4 Big Pan
6 SynPiano
127 tubulbel

104 0 Sci-Fi
1 Starz
127 xylophen

Ethnic
105 0 Sitar

1 Sitar    
2 DetSitar
8 Tambra
16 Tamboura
127 marimba

106 0 Banjo
1 MuteBnjo
8 Rabab



16 Gopichnt
24 Oud
127 koto

107 0 Shamisen
127 sho

108 0 Koto
8 T. Koto
16 Kanoon
127 shakhchi

109 0 Kalimba
127 whistle

110 0 Bagpipe
127 whistle

111 0 Fiddle
127 bottle

112 0 Shanai
1 Shanai2 
8 Pungi
16 Hichriki
127 breath

Percussive
113 0 TnklBell

8 Bonang
9 Gender
10 Gamelan
11 S.Gamlan
16 Rama Cym
127 timpani

114 0 Agogo
127 melotom

115 0 SteelDrm
127 deepsnar

116 0 WoodBlok
8 Castanet
127 e.perc1

117 0 TaikoDrm
8 Gr.Cassa
127 e.perc2

118 0 MelodTom
1 Real Tom
8 Mel Tom2
9 Rock Tom
127 taiko

119 0 Syn.Drum
8 Ana Tom
9 ElecPerc
127 taikorim

120 0 RevCymbl
127 cymbal

Sound Effects
 121 0 FretNoiz

1 CuttngNz
2 Str Slap
3 CttngNz2
127 castanet



122 0 BrthNoiz
1 Fl.KClik
127 triangle

123 0 Seashore
1 Rain
2 Thunder
3 Wind
4 Stream
5 Bubble
127 orchehit

124 0 Tweet
1 Dog
2 Horse
3 Bird 2
127 telphone

125 0 Telphone
1 Tel.Dial
2 DoorSqek
3 DoorSlam
4 Scratch
5 WindChm
6 Scratch2
127 bird

126 0 Helicptr
1 CarEngin
2 Car Stop
3 Car Pass
4 CarCrash
5 Siren
6 Train
7 Jetplane
8 Starship
9 Burst
16 Coaster 
127 jam

127 0 Applause
1 Laughing
2 Scream
3 Punch
4 Heart
5 FootStep
127 efctwatr

128 0 Gunshot
1 MchinGun
2 LaserGun
3 Xplosion
127 efctjngl



Technical Support
Evolution Electronics offers free technical support for registered Sound Studio users.
email:    support@evolution.co.uk

If you have a problem, before contacting Technical Support, please read the relevant section of the 
manual. If telephoning for support please have the phone close to the PC which is running the software. 
Please remember that the lines are usually very    busy, so email would be the better option.

Please check the trouble shooting section for possible solutions to your problems:

When asking for technical assistance, please have the following information to hand:

VERSION NUMBER e.g. 1.08... (To be found in "About Sound Studio..." from Help menu)
OPERATING SYSTEM: e.g. Windows 95
HARDWARE PLATFORM: e.g. IBM PC
CPU: e.g. Pentium II
CPU speed: e.g. 300 MHz 
RAM:      e.g. 64Mb 
SOUND CARD: e.g. SoundBlaster Live!

Our address if you would like to write to us is:

Evolution Electronics
8 Church Square,
Leighton Buzzard,
Bedfordshire,
UK
LU7 7AE.

Our phone number when calling from the UK is:
Tel: 01525 372621
Fax: 01525 383228

International:
Tel: +44 1525 372621
Fax: +44 1525 383228

The support department is available by sending an email to support@evolution.co.uk

Updating your software

To update your software to the latest version visit our web site on http://www.evolution.co.uk/updates/. 
Here you will find patches exclusively for Evolution own brand products. Simply download the free 
updates, run the patch program and quickly update your software.

Back to Contents



The Arranging Tutorial
What we are going to do is show how powerful the pattern-based approach to sequencing is, and how 
easily a song can be constructed using some of the features in Sound Studio. This will give you a good 
understanding of how Sound Studio works so you can use the same principles and techniques in your 
own music.

Parent and Child Patterns
Adding Audio Files
The Toolbox
Moving and Erasing patterns
Loading Audio files
Saving your work
Mixing
Adding Reverb and Chorus
Recording the Mixer settings
Staggering the Mixer data
Quiet in the mix
Mixing the audio track

Open the file called TECHDEMO.SNG. This contains several patterns spread across the tracks rather 
than the one-pattern-per-track arrangement of Sheba. We will use these patterns as our building blocks.

It's normal practice to have the Name column on view. It will help if you can also see the Patch, 
Transpose and Ch columns. Check them in the Select Track Columns dialogue box as described earlier.

The patterns are configured for General MIDI. If you are using a non-GM instrument, select sounds 
similar to those listed in the Patch column.

You might want to play the song as it is. You can tell it's a Coda short of a full Sonata but we'll soon fill in 
the missing pieces. Adjust the Zoom controls so you can see all the patterns in the Pattern Display area. 
You may want to zoom in and out as the music plays.

We're going to construct a piece of Techno music which is based on repeating riffs and we'll begin by 
constructing the bass line. Listen to the Bass pattern in the first couple of bars. It's a bit bland. Hold down 
the Control key and click and drag the pattern onto the same position in Track 2.

You'll see the new pattern has a dotted outline. If it doesn't you've probably changed the Preferences so 
open Preferences... in the Options menu and uncheck the Copy Patterns as Parents box.

Parent and Child Patterns

If you copy a pattern as a Parent then you simply create a completely new individual pattern the same as 
the original. The result is similar to copying and pasting a section of text in a word processor.

However, if you copy a pattern as a Child, it has no events of its own but uses those of its Parent. If you 
change the events in a Parent pattern then all the Children patterns automatically use the new events too. 
This is perfect for riff-based sequences because if you decide to change one of the riffs, all the others 
change as well. It saves an awful lot of work! 
By unchecking the box you can tell the program you want to copy patterns as Children rather than as 
Parents. The difference is important and illustrates just one of the many flexible features of pattern-based 
recording.

However, you can play the Children patterns back on any MIDI channel and apply processes such as 
Transpose to them which gives them a bit of independence of their own. Let's do this with the bass line.



Assuming you've copied a Child Bass pattern to Track 2 and set the Snap value to 8. 

As this is on its own track you can assign it to any MIDI channel and give it any Program Change number 
you like. However, let's stick with the Syn Bass sound and either assign Track 2 to MIDI channel 1 or else 
leave Track 2 on MIDI channel 2 and select the Syn Bass sound. The first option conserves MIDI 
channels but the second gives you more flexibility, should you need it.

Now when you play the first couple of bars, each of the notes in the bass line will repeat, creating a 1/8th 
note bass line.

Click in the Transpose column and take the Child pattern down by -12, an octave. Sounds a bit more 
interesting, doesn't it? Notice that the Child pattern is still playing the same notes as the Parent but we 
have simply transposed them.
[If you can't see the transpose column you may need to click on the word 'Patch' which will bring up the 
'Select Track Columns' dialogue box and then click the 'Transpose' option]

The next step is to copy these two patterns to provide a longer bass line. Click and drag a box around the 
two Bass patterns. This is known as lassooing and to select a pattern in Sound Studio this way you have 
to capture the start of the pattern in the lasso. You don't have to drag a box completely around the pattern 
to take in the end of it. When a pattern has been captured or highlighted in this way it turns black.

We want to create seven copies of this dual Bass pattern. You can set the Snap value back to Bar for this. 
Put the mouse on a part of the highlighted patterns, hold down the Control key and click and drag the 
patterns to the right until the start of the top one is on Bar 3. Release the mouse button. You don't have to 
be terribly precise as the Snap function will place the patterns on the nearest bar.

Now, the patterns you have just placed will be highlighted so continue to hold down the Control key, click 
and drag the patterns onto bar 5 and release the mouse. Continue until you have made seven copies of 
the patterns. The last one will begin on bar 15.

The Pattern Display window will scroll automatically as you copy the patterns past the right hand edge so 
there's no need to release the mouse button to click on the scroll bar.

Play the song.

Just to illustrate the purpose and usefulness of the Parent/Child pattern relationship, highlight the first 
pattern, the original Parent, and click on the Event editor. We'll look at this more closely later but for now 
pick out the second F#2 in the list and click on it with the left mouse button three times. It will be 
transposed downwards to Eb2. Now when you play the piece that note will be played by all the Child 
patterns.

Put it back to F#2.

Next, we'll fill out the drum part. As you did before, while holding down the Control key click and drag the 
Hit Hats pattern to the right until the start is on Bar 5. Repeat this to create six copies in all, the last one 
starting at bar 15.

The Tambourine comes in at bar 5. Copy this six times so the last pattern starts at bar 17.

Now copy the Vibes pattern five times.

Adding Audio Files

That's the first part done. The Strings and the Hit parts are in place and don't require any further editing. 
But what happens after the hit? Not a lot. Let's liven it up by adding some vocals.



The ability to record / import digital audio to MIDI tracks is one of Sound Studio's major features. 

We will now insert a voice saying the letters of the word "TECHNO" into the audio track. There is more 
than one way of doing this but we'll plumb for the easy way. Zoom in until you can see each bar number 
in the Timeline. Set Snap to 4.

The Toolbox

Right-click and hold in the Pattern Display area and the Toolbox appears.

Each editor has a Toolbox and some tools appear in more than one editor. There is a complete list of all 
the Tools in the Basic Operations chapter. At the moment we're just interested in the Pencil so move the 
pointer to it and release the Mouse button.

Scroll the window so you can see bar 11 and click the Pencil in the first audio track halfway between the 
numbers 11 and 12. an Audio pattern will appear 1/4 of a bar long.

These are markers or place-holders for the audio data and they tell the program when to play the audio in 
relation to the rest of the song. The audio is not held in the computer's memory but read directly from disk 
so you don't need a lot of RAM in order to use audio files.

Moving and Erasing patterns

If you accidentally create a pattern where you don't want one you can click and drag it to the correct 
location or erase it. Right-click in the display area, select the Eraser and release the mouse button. Now 
click with the Eraser on the unwanted pattern and it will be deleted.

Another way to remove unwanted patterns is to highlight them and press the Delete key on the 
computer's keyboard. If you do not have a pattern highlighted, the program will assume you want to 
delete the selected track. Don't worry though, if there are any patterns on the selected track, the program 
will warn you before deleting.

Also, if you delete a pattern accidentally, you can select Undo from the Edit menu or hold down the Alt 
key and press the Backspace key. You can also hold down the CTRL key and press Z.

Now we have to tell the program which audio files we want it to play.

Loading Audio files

Right-click briefly in the Pattern Display area and the mouse pointer will run into an Arrow again. Double-
click on the first Audio pattern and the Audio Window opens.

Click on the button labelled 'Click to select a WAV file' near the top of the window and a file dialogue box 
opens looking for a file with a .WAV extension. These are standard Windows audio files and you will see 
several in the Sound Studio\Tutorial directory including ones called T, E, C, H, N and O.



Double-click on T.WAV or click on it to highlight it and then click on the OK button. A representation of the 
waveform appears in the window. This window also shows the size and format of the file.

Click the OK button At the moment, each Audio pattern is exactly quarter of a bar long but if you click on 
OK here, the length of the pattern will be adjusted proportionally so you can see where the audio file will 
stop playing. Click OK.

Now open the other audio patterns, load the E, C, H, N and O WAV files.

Each file lasts for about a quarter of a bar but you will see that some patterns are slightly longer than 
others. If you are working with very short samples or zoom out of the display to get an overall view of the 
arrangement, the audio patterns may become little more than a line wide. By not Resizing the Pattern to 
match the Wave Length you keep the patterns at their original size which will make them easier to see 
and manipulate.

Now let's finish fill in the gap which leads to the Piano and Drum parts. We need half a Tambourine 
pattern so right-click in the Pattern Display area and select the Knife tool.

Zoom in so you can see the last Tambourine pattern clearly, set Snap to Bar and click the Knife in the 
middle of the pattern under bar 18 in the Timeline. With Snap set to Bar you don't have to be very 
accurate and the pattern will split in two.

You'll notice that it has also taken on a solid outline. In other words, it has ceased to be a Child pattern 
and has become a Parent pattern. This has happened because you edited it. As the two patterns no 
longer contain the event of the Parent pattern they have become Parents in their own right.

Right-click briefly to select the Arrow again. Hold down Control and click and drag the right-most pattern a 
bar along so it fills bar 19. Now Control click and drag the previous Child pattern, the one occupying bars 
15 and 16, to bar 20. Create three more copies, extending the Tambourine line to the end of bar 28.

Let's have some more voice. Lasso the five Audio files and Control click and drag them to the right so the 
first audio part, the T, is at the start of bar 18. Click anywhere in the Display area to deselect the parts and 
set the Snap value to 4.

Drag the E to the middle of bar 18. We want the next four files to each occupy a beat in bar 19 so zoom 
right in and drag the files onto consecutive beats.

Now Control drag the Drums pattern three times and the Piano pattern. They should both come to the end 
of bar 28 in line with the Tambourine pattern. Now Control drag one copy of the SynBass pattern.

Saving your work

Before you continue, save the song. Select Save As... in the File menu and the file dialogue box appears.

You want to save entire piece so make sure that Song Files is selected in the File Type box (shown 
above). Type a name into the Filename box and press Return or click on OK. You don't have to add 
the .SNG extension, Sound Studio will do that for you automatically.



If you want to compare it with the arrangement we prepared earlier, load the TECHNO.SNG file.

Mixing

The final step is to mix the piece. The original patterns were recorded to sound pretty well "mixed" on our 
GM unit but they may not sound exactly the same on yours. In any event, there are still a few tweaks to 
perform.

Open the Mixer by clicking on its icon.

The MIDI Outputs available in your system will appear long the top of the window. These are the same as 
the Port settings in the Track window. Select the one you are using by clicking on it and then click on the 
Auto Size button.

This will automatically resize the window so it is the exact height and width of one set of 16 channels. If 
you have a small monitor or are running Sound Studio in a low resolution you may want to make the 
mixer smaller to hide the higher-numbered channels which you aren't using. You can do this by clicking 
and dragging on the borders of the window in the usual way.

To set the Mixer controls to a default setting, click on the All Flat button. This will set Reverb and Chorus 
to off, Pan to centre and Volume to maximum.

Select Mixer Settings... from the Options menu. This lets you determine how the Mixer works and what 
the mixer controls actually control.

The two boxes labeled User 1 and User 2 let you configure the top two rotary dials in the Mixer to control 
a range of Controllers. There's more about this in the Reference section but leave them set to Chorus 
Depth and Reverb Depth for now.

Select one of the items under Text Under Faders to decide what information you want to see under each 
Mixer channel. We prefer Patch Names so you can see what sound the Mixer is controlling but if you 
name your tracks you might prefer to set it to Track Names.

The following boxes let you decide how MIDI data and the Mixer interact. If you are only using one MIDI 
Out Port, we'd suggest keeping the first three boxes checked even though you don't need all the facilities 
at the moment. There's more about these settings in the Reference section.

Now play the song.

First of all, use the faders to set suitable volume levels for each of the tracks. Maximum volumes for all 
sound fine on our equipment but even General MIDI modules vary from one to the other.

Now, experiment with the Pan settings. Pan the first Bass track hard right and the "echo" hard left. Put the 
Vibes slightly right of centre and the strings slightly left of centre.

We usually leave the drums in the middle but you might like to pan the Piano slightly left and the Syn Saw 
slightly right. These are just suggestions, of course. Place the sounds wherever you like in the stereo 
image.

Adding Reverb and Chorus



Next, add some Reverb. This can really fill out a sound. Strictly speaking, Reverb is not a feature of 
General MIDI although many GM units have a Reverb feature. You'll soon be able to tell if yours is one by 
turning up the reverb level and seeing if the sound takes on a "spacey" quality.

Try adding reverb to the original bass line or to the "echo". If you have the two bass parts on different 
MIDI channels you can put reverb on one and not the other.

See how it affects the other parts including the drums. Many beginners add reverb to everything and 
although this appears to "beef up" a song it can result in the "swamp" effect and make the parts blur into 
one another. Still, if that's the effect you're after...

You may like to add a little Chorus to some of the parts. If your sound source supports it, it will thicken a 
sound.

Use the Mute and Solo buttons in the Mixer to hear what the parts sound like in isolation.

Recording the Mixer settings

Now, having fine tuned the song, you want it to sound like this every time it's played so we need to record 
the settings into the song itself. This is easy to do using the Mixer's Snapshot button.

Make sure the Record mixer movements box is checked in the Mixer Settings dialogue box. From the 
Functions menu in the Track editor select Add MIDI Track or simply click on the Add MIDI Track button.

A new track will appear at the bottom of the track list. Click on the button in the Rec column. If this column 
is not on screen, check it in the Select Track Columns box. Now, during recording, when you click on the 
Snapshot button the data will be recorded onto the track.

However, you'll notice that the song begins at the start of the very first bar so there's no room to insert this 
information. Click on Select All in the Edit menu and all the patterns will highlight. Zoom in and use the 
scroll bars so you can see the bar markings in the Timeline clearly. Set Snap to Bar. Click on the first 
Bass pattern in the song and drag it to bar 2. The whole song will move along a bar.

Now click somewhere on the Mixer window or on the Mixer icon to bring it to the front. Click on the 
Record button in the Transport window and, unless you've altered the Metronome settings, a one-bar 
count in window will appear counting down from four to one. If the Metronome icon is selected in the 
Transport window, you'll also hear a click.

As soon as the program starts recording, click on the Snapshot button and then on Stop. Let's just check 
what you've recorded.

Select the pattern in the Track window and click on the Event Editor icon. Make sure the Controller 
button in the Display Filter is on and you will see a list of Controller data similar to this:



Scroll through the list and you will see that each MIDI channel has an entry for Volume, Pan, Reverb and 
Chorus. If you've checked the Song data to mixer box in the Mixer Settings window, the Mixer controls 
will move in response to the data during playback. Try it. Flatten the Mixer controls and then start 
playback.

Not working? Check the MIDI channel the track is set to. It's probably set to channel 11 which means all 
the data is going to MIDI channel 11 and none to the other channels. Scroll this down to 0 with the left 
mouse button. Now the data will be transmitted on the MIDI channels which are used in the pattern rather 
than being forced onto a MIDI channel by the Ch setting.

Staggering the Mixer data

A couple more points before we move on. If you hit the Snapshot button after the count in, the events will 
be spread a few ticks apart. If you clicked on Snapshot before the count in had finished, the events will 
still have been recorded but they will all be on the very first bar and beat position.

MIDI is a serial protocol which means it can only transmit one item of data at a time. If events are at the 
same time position it sends them one after the other, albeit very quickly. However, if there are a lot of 
events, the last one could arrive significantly later than the first one, even though they have the same time 
position in the editor.

Now, most instruments respond to MIDI data very quickly but they do take a finite time to react to it and 
some may be swamped if they receive too much data at once. It may ignore some data or it may cause a 
glitch in the system. The Snapshot button staggers the events to minimize problems such as this.

Depending on your instrument, you may be able to stack all the set-up events on the first beat but it's 
usually best to play safe and spread them out a little, particularly if you are also using System Exclusive 
data to put an instrument into GM, GS or XG mode. 

It's now common practice to use the first bar for set up data and to begin the song proper at bar 2.

Quiet in the mix

Finally, you will have noticed that the Snapshot button records data for all MIDI channels, regardless of 
whether or not the song uses them. The extra data won't do any harm and hardly takes up any space in 
the file but you can turn this to your advantage.

Some instruments emit a little bit of background noise. This is usually caused by the sound generation 
circuitry. So, as well as adjusting the volume levels for the MIDI channels you are using, set the ones you 



aren't using to 0 to reduce any background noise.

Congratulations! You have learned some of the main principles of pattern-based arranging and know your 
way around Sound Studio's Track window and Mixer.

If you haven't done so already, look at the other files. Most were created using a pattern-based approach 
and you can see how Parent and Child patterns have been used to structure the pieces.

Mixing the audio track

We have mixed the MIDI tracks but what about the audio track? Audio playback is through your sound 
card so you must use your sound card's software to set the overall output level of the audio then use 
Sound Studio's Mixer screen to tweak the levels. Most sound cards come with a set of utilities for playing 
MIDI and WAV files and virtually have a software mixer.

Whichever mixer you have, use the Wave control to set a suitable balance for the audio track. You may 
also be able to pan the audio parts left and right. If you are also using the sound card to play the MIDI 
parts, you will be able to adjust their volume with the mixer, too

That's the end of the Arranging Tutorial.

What do you mean, the Techno song isn't finished? Well, it's served its purpose and if you like it, why not 
finish it yourself? - after completing the rest of the Tutorial, of course!

Go back to Tutorials Screen



The Chord Track Tutorial
Arranging the Chord tracks
Realtime Style Playing
Realtime Chord Recording
Using the on-screen keyboard to record chords in realtime

We'll now look at one of Sound Studio's most interesting features - the Chord track. This lets you create a 
full six-part accompaniment very quickly in one of 20 styles.

Select New from the File menu and save whatever you've been working on. Let's create a Hooked On 
Classics piece using Liszt's Liebestraum. We've put the piece, originally in 3/4 time, into 4/4 and we'll give 
it a Disco rhythm.

First we'll create the Chord track. The chord sequence is as follows:

F A7 D7 G Gm/C F /
F A7 D7 G Gm/C F /
Gm F Dm7 A7/C
F A7 D7 G Gm/C F /

Note that the Gm/C and the A7/C symbols indicate two chords in one bar, each lasting two beats.

Set Snap to Bar and Select the Pencil tool. Click in the Chord track and drag from Bar 1 into bar 2 (You 
may need to add a chord track first from the functions menu). The Snap function will make the pattern fill 
the two bars. You'll see a new set of data appear in the Information bar which we'll get to in a moment.

Click another six patterns into bars 3 to 8. To do this click and drag a small amount within then bar, then 
the pattern will automatically fill it. You'll have a row of intro patterns filled with the chord of C.

Select the Arrow tool and click on the first pattern. A set of parameters will appear in the Information line.

Click on the Style box and a list of Styles will pop up.

Select the Disco pattern. Now click on the Chord box and select F. This is the root of the chord.

We want the chord of F major and Maj is already selected in the Type box so we can leave that alone.

Click on the button labelled Intro and change this to Variation 1.

Click on the second chord pattern and set that to F in the same way. When you get to the next chord, A7, 
select 7 in the Type box.

Change the rest of the patterns to Variation 1 also by selecting all the patterns (edit menu - select all) 
and choosing Variation 1 in the same way as above.

Carry on entering chords until you reach bar 7. We need two chords in this bar so we have to split the 
pattern in two. Click on the Chord Snap box and set it to 4. Select the Knife tool and cut the pattern in two 
and then set the chords as before.

The second set of patterns is the same as the previous set - not including the very first pattern which is 
used for an intro - so select all the patterns, hold how Control and drag them to the start of bar 9.

Now click in another four pattern - set Chord Snap back to Bar - and change the chords in them. The final 
six bars are the same as the set you copied earlier so select them again and copy them to the start of bar 



19. 

Select an instrument such as String Ensemble on Track 1 and set it to record. Click on the Record button 
and record the melody as the accompaniment plays.

You can balance the volume level of the chord track against the level of track 1 by adjusting the volume of 
the chord track. The chord track defaults to a volume level of 80.

Open the Mixer and you'll see that the accompaniment is using MIDI channels 10 to 15. The 
accompaniments have built-in sets of sounds, reverb, chorus and pan settings, and volume levels and 
these will be reflected in the Mixer - providing the Song data to mixer box is checked in the Mixer 
Settings... window. 

If you change the chord track volume, the mixer volume sliders will update when you restart the song.

Now that you've recorded the melody and chord line, try selecting different Styles. Because the chords 
are the same, the styles will still fit the melody line although some of them may sound a little strange! Try 
the March, for example.

Arranging the Chord Track

Put the Style back to Disco and select the first chord pattern. 

Each pattern contains six instruments which you can switch on and off by clicking on the LEDs in the 
Information Line.

The first two bars are an intro so lets remove the accompaniment parts leaving just the bass and drums. 
Click on the Acc1, 2, 3 and 4 LEDs to switch them off.

The next section is repeated so let's build up the accompaniment slowly. Select the first pattern in the 
section, bar 3, and deselect Acc3 and 4. Do the same with the patterns in bars 4 to 8.

Realtime Style Playing

Before recording a style Chord track you should rehearse your chord changes. To do this, click the 'on' 
button on the screen keyboard and when ready to play click on any of the notes below the split point. The 
style will continue to play until the stop button is pressed.

When in SFC mode, the lower octave of your external keyboard will be used to change the chords. To 
play a major chord, play the chord note on your keyboard. To play a 7th chord such as    a C major 7th    
(this will add the seventh note above C which is a B flat),    you need to hit the C note plus the first white 
note beneath it. This would be true for any chord. To play a minor chord you would need to play the first 
black note beneath the chord note. A minor Major 7th chord is possible by playing the white and the 
black notes beneath the chord note.

Major Chord Note only
Minor Chord    note & first white note 

below
7th Chord note & first black note 

below
Min Major 7th Chord note plus first white & 

black notes below

In fingered mode the keyboard forms the chord from the actual notes that you play.



Realtime Chord Track Recording

If you'd prefer to lay down a Chord track in real time rather than having to insert each pattern individually, 
then Sound Studio will allow you to do just that.

To record chords in realtime you will have to turn on the virtual keyboard and click the Syncro button. 
Then, just as you would with any MIDI channel, enable the Chord track for recording by pressing the 
button in the record column.
Choose your style and then hit the record button on the transport bar. This will (if selected of course) start 
the metronome count-in. Play the single fingered chords on the first beat of the bar. You can play the 
Single Fingered Chords from either an external keyboard such as the Evolution MK-261, the PC 
Keyboard or from the on-screen keyboard.

Press stop to finish your recording. On playback, the Chord track will play the chord patterns displayed in 
the Chord track unless other chords are played "on top". The styles will always play the chord patterns 
displayed if the screen keyboard is turned off.

When playing a chord using 2 or more keys of your external keyboard,    hold down the keys for the 
duration of the chord before playing another chord. This is not necessary for Major chords.

You can also record in fingered chord mode or piano mode. In fingered chord mode, the virtual keyboard 
will recognise the chord shape you play with your left hand below the split point. In piano mode, the 
keyboard will follow the chords as you play over the whole range of the keyboard.

Using the virtual keyboard (VK-61) to record chords in realtime

You can use the virtual keyboard to record your chords in realtime. To do this, if the keyboard is off switch 
it on by clicking the 'on' button. Next enable the Syncro button and then click the mouse on any note in 
the lower part of the keyboard below the split point. The split point is where the blue / pink strip meets. It 
can be moved by clicking on this strip. You can change the chord type by editing the recorded Chord track 
after you have finished recording.

See also: Keyboard Window



The Conductor Tutorial
The Conductor window is where you set and change the Time Signature, Key Signature and the Tempo.

Load BRAHMS.SNG. This is one of Brahms' Hungarian dances. Play it through you'll notice that it slows 
down and speeds up a lot. That's where a lot of its excitement comes from. Open the Conductor window.

The squares with the red dots in them are Conductor Points and these indicate places where a tempo 
change occurs. The tempo is shown down the left of the window. The Conductor window is very friendly 
and automatically resizes its contents when you resize it.

Try it now. Grab the bottom right corner of the window and drag it up and down and you'll see that the 
tempo markings and the Conductor Points change size automatically in order to fit into the window. This is 
very useful if you want to see the Conductor as well as other windows which restrict the information you 
can see if you make them smaller.

Adjust the window until it's a comfortable size and play the piece. Keep an eye on the Play Position line in 
the Conductor. You'll see that as it passes over the Conductor Points the tempo speed up or slows down. 
If you can keep your other eye on the Tempo box in the Transport window you'll see the tempo change 
when the Play Position passes a Conductor Point.

Close the Conductor and click on the Conductor icon in the Transport window to deselect it. This 
deactivates the Conductor. Now when you play the piece you'll see how flat and lifeless - and boring! - it 
is. Switch the Conductor back on.

Note, you don't have to switch the Conductor icon on when you open the Conductor window as it is 
automatically activated when you open it.

Select all three tracks in the Tracks window and open the Score editor. You'll notice that there are a lot of 
sharps in the note display. That's because the piece is in the key of A and the Conductor is still in its 
default state and telling the program that it's in the key of C.

Open the Conductor and click on the Key Signature Display to highlight it.

Two entries will appear in the Information Line. The Position will show the time in the song that the Key 
Signature occurs - in this case it begins right at the start at 1:01:000. The Key box confirms the Key 
Signature as being C.

Click on the Key box with the right mouse button and the Key Signature will change. You'll see the 
changes taking place as you do so in the Score Editor. Set the key to A and most of the sharps will 
disappear. The piece is actually in F# minor which has the same key signature as A.

The Time Signature is not right either. It should be 2/4 but it appears as 4/4/. Select the Time Signature 
Display and the Position and TimeSig boxes will tell you the Time Signature and when it starts. Click in 
the TimeSig box with the left mouse button to reduce it to 2/4. You'll see the score display change as you 
make the adjustment.

Let's say that you'd like to speed up the piece. Click on the highest Conductor Point in the first group. It 
will turn black to show it's highlighted

Its timing position will appear in the Position box and its tempo in the Tempo box. You can alter the Point 
in several ways. If you click on the Position or Tempo values, they will scroll to new ones. You can also 
click and drag the Conductor Point to a new position. When you release the mouse button its new values 
will appear in the boxes.



Remember, you can undo the last value change by selecting Undo from the Edit menu or pressing 
Ctrl+Z.

You can change several Conductor Points at the same time by clicking and dragging a lasso around them 
or by Shift-clicking on them.

If you want to add new Conductor Points, right-click in the window, select the Pencil tool and click new 
Points into the window.

You can also create new Point by holding down Ctrl while you drag a point. This makes a copy of the 
Point and places it at the position where you release the mouse button.

You can insert new Key and Time Signatures, too, very easily by clicking in the Key Signature and Time 
Signature Displays with the Pencil.

You can select each entry individually and change it with the mouse buttons. To remove an entry or one of 
the Conductor Points, click on it with the Eraser.

Note: When working with the Virtual Keyboard, the tempo of each style is linked to the first tempo value in 
the Conductor window. This means that if you change style on the VK-61, the first tempo point marker in 
the Conductor window will also change. To work with tempo changes in sequences and midi files it is 
recommended that you switch the Virtual Keyboard off.



The Drum Editor Tutorial
The Grid
The Information Line
Adjusting drum velocities
Hit colours
Creating a rock pattern
Building a drum track from patterns
Editing Child and Parent patterns

They say that the musicians who write the best drum patterns are drummers. That may be true but Sound 
Studio's Drum Editor makes drum pattern programming easier for everyone and it can help you be more 
creative.

Load the TECHNO.SNG file, highlight the first HiHats pattern and click on the Drum Editor icon.

The Drum Editor uses a programming method similar to that used by most stand-alone drum machines. 
The Drum Display on the left lists the drums which are available in the current drum kit. Drum kits can be 
easily customized and loaded and saved. There's more about this in the Reference section.

The right of the window is the Hit Display. A grid divides the bars into subdivisions of the beat and drum 
hits - the LEDs - are placed on the grid. Like the Track window, the two sections are separated by a 
Divider which you can drag left and right.

The Grid

You can adjust the resolution of the grid with the Grid selector. First of all, use the Zoom button so the two 
bars fill the display area. Set the Grid to 16. The hi hat hits fall exactly on the grid lines. Now set the Grid 
to 32 and the number of grid lines will double.

Now set it to 64. You probably won't see any change. That's because the display automatically adjusts 
itself to the current zoom setting. If the program were to draw 1/64th note lines in between the 1/32nd 
ones, the display would be incredibly difficult to read.

Click on the Zoom In button. You'll probably have to click on it twice and a single bar fills the display area 
you'll see the 1/64th beat divisions appear.

Zoom out again and set the Grid to 8. You'll see that the Closed HiHat hits are no longer on a grid line. 
Click and drag one of them and move it slightly left or right, just a little. When you release the mouse 
button, the hit will snap to one of the grid lines.

As well as displaying beat divisions, the Grid makes sure that the hits you enter fall squarely on the grid 
lines. The grid makes it easy to visualize the rhythm which helps when constructing drum patterns.

To put the pattern back to its original state, click on the Recall button and the pattern will revert to the way 
it was before you opened the Drum Editor.

Start playback. When the song reaches bar 3, the Play Position Line will appear in the editor window and 
move across the display. If you want to listen to the contents of the editor without the distraction of the 
rest of the song, click on the Edit Solo button.

The Information Line



Click on one of the hits and look at the Information Line. This gives you exact information about the hit 
and you can alter any of the parameters by left and right clicking.

Close the window by clicking on the Close button, select the Tambourine pattern and open the editor 
again. Sound Studio allows you to have several editors open at the same time but we'll work with one at a 
time at the moment to avoid any possible confusion.

Adjust the window and the zoom setting so you can see the two bars of hits. Set the Left and Right 
Locators to the start and end of the pattern - if you're using the original TECHNO.SNG file this will be bars 
5 to 6. Make sure the Edit Solo button is on and start playback.

You'll probably be able to hear that the hits are not all the same volume. If it isn't obvious, try the 
following. Select the first Tambourine Child pattern in the Track window and click on the Drum Editor icon. 
This will open a second Drum Editor window.

Set the Left and Right Locators to encompass both patterns - in TECHNO.SNG this will be from bars 5 to 
8 - and switch on Cycle mode. Right-click in the Display area to open the Toolbox.

Adjusting drum velocities

The Velocity Modifiers and the Drumstick tools are unique to the Drum Editor. The Velocity Modifiers 
increase or decrease the velocity of a hit by 16. The Drumsticks are used to enter hits onto the grid.

Select the Up Velocity Modifier and click on each of the hits in turn until they turn purple. If you click once 
too many times, the hit will turn red. No problem. Select the Down Velocity Modifier and knock it back 
down to purple.

If you want to hear the drums as you are entering them, click on the Speaker Switch:

When it's on it will transmit the hits and changes you make to the hits via MIDI. When it's off, it won't but 
the hits will still sound during playback.

Solo the track in the Track window and click on play. You'll hear the original pattern followed by a pattern 
whose velocities are all the same. The hits on the beat are louder than the others and the different 
velocities give the original pattern a rhythmic pulse. The second pattern has no velocity variations at all 
and is rather flat, lifeless and robotic. You should aim to build velocity variations into your drum patterns 
as this will make them sound more human and interesting.

Hit colours

Sound Studio uses colours to represent velocity values. Each colour represents a change in velocity of 
16. Let's see how this works by constructing a drum pattern.

Select New from the File menu. The program will tell you that the song has changed and ask if you want 
to save it. You don't as that would overwrite the original file so click on No.

Select the Pencil tool and click a pattern onto track 10 at bar 1. If Snap is set to Bar, clicking close to the 
start of bar 1 will do the trick. The pattern will be highlighted so click on the Drum Editor icon to open it.

Select the Large Drumstick. This clicks hits onto the grid at a velocity determined by the value in the Vel 
column. It defaults to the maximum velocity of 127. Click a few hits onto the grid and they'll be red.

Add some hits with the Small Drumstick. This enters hits at the default velocity minus 16. It uses a lighter 
shade of red to indicate the velocity difference. Click on the hits with the Arrow and check their velocities 



in the Information Line.

Now select the Down Velocity Modifier. Click on a red hit and keep clicking until it turns dark blue. The hit 
will cycle through the following colours and have the following velocity values:

Red 127
111
95
79
63
47
31
15

Dark Blue 1

Further clicking will not change the velocity or colour. Using the Up Velocity Modifier will increase the 
velocity in steps of 16 again so that if used now, the velocities will step up in the following sequence: 1, 
17, 33, 49, 65, 81, 97, 113, 127.

Select a drum which doesn't contain any hits and reduce the value in the Vel column to 107. Now click a 
couple of hits in using the Large and Small Drumsticks. The colours will be red and purple respectively 
because they are relative to the Velocity setting. In other words the red hit is at the maximum default 
value and the purple hit is 16 below.

You can change the default values accross the whole kit but if you're using a General MIDI sound source, 
the default values will be fine in most cases.

Creating a rock pattern

We'll use the Drum Editor to create a rock pattern. Close the Drum Editor and delete the pattern you've 
been experimenting with from the Track window. Use the Pencil to draw in a two-bar pattern on track 10 
and open the Drum Editor again.

Let's start by creating the bass and snare lines. Turn Cycle on and set the Left and Right Locators to 
cycle between bars 1 and 2. Adjust the zoom so these two bars fill the display area and set the Grid to 16.

Click on play and you will hear the pattern play as you build it up. You may prefer to switch the Speaker 
Switch off to prevent the sound of the hits you are entering from playing and disturbing the flow of the 
pattern.

Click bass and snare hits onto the grid with the Small Drumstick. You can make up your own pattern.

Add a 1/16th note hi hat line on Closed Hi Hat. Add an Open Hi Hat on the second last 1/16th on bar 2 to 
create a little lift. We need to add some accents to give the pattern a little feel so use the Up Velocity 
Modifier to increase the velocity of all the snare hits, the hits on beats 1 and 3 in both bars and the Open 
Hi Hat.

You may feel the difference between the two velocities is not great enough so use the Down Velocity 
Modifier to reduce the hits which aren't accented.

If you like what you've created, save it.

Building a drum track from patterns



An easy way to build up a drum track is to construct a few patterns and copy them in the Track window. 
You probably won't want the same two-bar pattern to play throughout an entire song so you can modify it 
slightly.

Close the Drum Editor and in the Track window, Control-drag the pattern onto bars 4 and 5. Unless you've 
altered the Preferences settings it will be a Child pattern with a dotted outline. Select it and open the 
Drum Editor.

Editing Child and Parent patterns

Add some extra hits to the pattern. At this stage it doesn't matter what you add. Now click on the Close 
button and a dialogue box will appear asking if you want to convert the pattern into a Parent pattern.

If you say Yes, it will become a Parent pattern in its own right. However, if you say No, the original Parent 
pattern will be changed and become the same as the Child pattern you've just edited, and all its Children 
will be altered accordingly to reflect the changes.

This is a logical consequence of the Parent/Child relationship. As a Child has the same notes and events 
as its Parent, you cannot change its contents because it would then cease to be a Child.

If you edit a Child, Sound Studio assumes you want to do one of two things - edit the Parent or create a 
new, original pattern. Perhaps you're working at the end of a song and the original Parent is near the 
beginning. Editing a Child saves you scrolling through to the start and if you select the No option, the 
program will helpfully edit the Parent for you.

Alternatively, you may want to modify the pattern at that position in the song but leave the Parent and its 
other Children alone so you would say Yes to convert the Child into an independent pattern.



The Event Editor Tutorial
The Display Filter
Editing selected events
Editing System Exclusive messages
Editing XG sysex messages

The Event Editor shows data in a list. It's the nearest you want to get to viewing raw MIDI data - and it's 
some way off that! However, it gives you very precise control over every aspect of your music. In many 
ways it's the most powerful of Sound Studio's editors although you won't want to use it all the time.

Each editor has a range of functions it excels at and the Event Editor is ideal for:

* Viewing all events and seeing where they are in relation to each other.

* Adjusting events' values and timing with extreme precision.

* Entering and editing System Exclusive data.

Load EVENT.SNG which is the first few bars of the lead string part in Vivaldi's Spring from The Four 
Seasons. Select the pattern, open the Event Editor and play it. It probably sounds okay although there is 
a glitch at the beginning of the third bar.

The Display Filter

Examine the part in the Event Editor. The main body of the display shows the MIDI events in the pattern. 
Above them is the Display Filter which hides certain types of event from the display.

Switch all the filters on so they are black rather than grey and you will see all the MIDI events in the 
pattern. By switching the filters on and off you will see that there is Note, Controller and Bend data in the 
pattern.

You can select any event simply by clicking on its name. Note that the last three column heading change 
according to what event is currently selected. If you highlight a Note, for example, the last three columns 
tell you the Key (note name), Velocity and Length. Select a Controller and you'll see its number and value.

Let's sort the chaff from the wheat. We'll start by getting rid of the glitch. Switch the Controller display off 
so you can see just the Note and Pitch Bend data. Look at the two sets of Bend data. It appears that they 
should be the same but the first set has acquired a few extra instructions which boost the pitch causing 
the glitch.

Highlight the offending entries - the ones with 124 and 116 values. You can do this by clicking and holding 
on one then dragging the mouse to the other or by Shift-clicking on each event. This process allows you 
to select non-consecutive events.

Now click on the Delete button at the top of the window or press the Delete key on your PC's keyboard. 
The two events will be removed.

Does that sound better? If you're not sure, use the Undo and Redo functions to compare the pattern 
before and after. You could also click on the Recall button. This restores the pattern's original contents to 
the state they were in when the editor was opened. If you close the editor then any changes you made 
are stored. If you go badly wrong while using the editor don't panic! Just press ESCAPE on the computer 
keyboard. This will close the edit window and ignore all changes.



Recall and escape are very useful features because if you make a complete pig's ear of an edit, you an 
easily go back to the original state. Likewise, if you have made an edit you're happy with, you can close 
the editor and open it again and the edit will be saved. There's a Recall button in all the editors and it is 
always possible to abandon changes by pressing ESCAPE..

Editing selected events

We sorted out the Pitch Bend so click the Bend filter off and switch the Controller on. There are a lot of 
Volume instructions here. Are they really necessary? And what effect do the Modulation instructions 
have?

Let's try a quick and dirty test. Switch the Note filter off so you only see the Controllers. Choose Select 
All... from the Edit menu and delete the selection using one of the methods described above.

Now play the piece and use Undo and Redo to compare the two versions. Put the pattern into Cycle 
mode if you wish. You'll hear that the Volume instructions do make a difference by subtly changing the 
volume of the notes as they are sounding. Perhaps the programmer should have used Expression 
instead of Volume but otherwise a lot of thought has gone into making the piece expressive.

What of the Modulation instructions? Do these have a noticeable effect on the notes? You can use the 
same procedure to remove them from the pattern and find out.

Editing System Exclusive messages

Open the GM_REST.SNG file and look at the pattern in the Event Editor.

Not much to see, is there?

System Exclusive messages have a number of uses. One of the most common is to put a unit into a 
certain mode such as GM, GS or XG    It's also used to edit synthesizer voices but that requires a 
dedicated editor and is beyond the scope of Sound Studio and this help file.

However, because of their flexibility, Sys Ex messages can contain any amount of data. Unlike a 
Controller message which has a Controller Number and a Value, a Sys Ex message could contain several 
dozen - or even a few hundred - bits of data.

Rather than try to show all this in the Event Editor, Sound Studio simply tells you that there is a Sysex 
event there and if you want to see it in more detail double-click on it. 

This is Sound Studio's System Exclusive Editor where you can edit and create Sys Ex messages.

See also the xg sysex commands in the event window page.



The Fast Menu Tutorial
The Fast Menu is a very useful feature designed to save you time. You can program it with the ten 
functions you use most often and to call a function you simply click on its button in the Fast Menu.

If you can't see the Fast Menu on screen, select Show Fast Menu from the Window menu.

To customize the Menu with your top ten items, select Configure Fast Menu... from the Windows menu.

The items on the right are the ones which are currently in the Menu. To remove one, highlight it and click 
on the Delete button.

The list on the left shows the functions which can be placed in the Menu. To add one, highlight it and click 
on the Add button. If there are already ten items in the list, the Add button will be greyed out.

To change the order in which items appear in the Menu, highlight one and click the Up and Down buttons 
to move it through the list.

The default set of items may not be ones you use the most. You have now worked your way through most 
of Sound Studio's major functions and if you found yourself using certain commands a lot, put them in the 
Fast Menu.

You may find that when you are working on certain songs or certain styles of music, you tend to use some 
functions more than others. If that's the case, reconfigure the Fast Menu as you go. It only takes a few 
seconds and it will ensure that the commands you use most often are readily available.



The Mixer Tutorial
Recording Mixer movements
Taking a Snapshot
Grouping Faders together

Sound Studio's Mixer is the computer equivalent of a studio mixing desk. It lets you balance the volume 
levels of the instruments in your music, adjust their pan positions, and set reverb and chorus levels. You 
can also use it to record a live mix so the changes you make are recorded into your music. Sound Studio 
also has an Audio section to the mixer to balance the levels of each Audio track. Each audio channel also 
has pan, reverb, reverb depth, solo and mute buttons.

The Mixer has 16 channels for each MIDI output in your system. These are listed just below the Title bar 
and you select one by clicking on it. The name will highlight by turning blue to show that it is the currently-
selected mixer.

If the Output has not been selected in the Devices... menu, the mixer will be grey and you will not be able 
to move any controls. If the device is an active one, the mixer will be coloured.

The mixers are all part of one long window and you can scroll through them to reach the one you want. 
However, a much easier method is to select the Output and then click on the Auto Size button.
This resizes the window so the one set of 16 channels fits the window exactly.

Each MIDI mixer channel is exactly the same (the Audio section is slightly different).

Working from the bottom up, first there is a Volume fader. The text beneath can show the Track or Patch 
names or simply the word "Volume". These options are set from the Mixer Settings... window which is 
described in detail in the Reference section.

To the right of the slider is a meter which shows when notes on that MIDI channel are being transmitted. It 
responds to the velocity data of the notes, not volume data, so you can see which channels music is 
being transmitted on. This can also help with troubleshooting. If a particular music line is not sounding, 
you can confirm that it is actually being transmitted. If you Mute the channel, the meter will be muted, too.

Next up are Mute and Solo buttons. These work exactly like the Mute and Solo buttons in the Track 
window.

The Pan pot places the sound in the stereo image. Obviously, you need a stereo output in order to hear 
this.

The next two pots are user-definable and can be set to control Pitch Bend, Modulation, Expression or a 
number of other MIDI controllers. The settings are made in the Mixer Settings... window. When you first 
start using Sound Studio they will probably be set to Reverb and Chorus levels.

To adjust one of the rotary pots, click and hold on it and drag the mouse up and down.

Above the pots is a Flat button which sets all the controls on that channel to maximum or to centre 
positions. You can flatten any individual control by holding down Ctrl and clicking on it. This is useful if 
you want to make sure a Pan pot is centered, for example.

The numbers at the top indicate the MIDI channel and cannot be altered.

There's just two more buttons to look at.

The All Flat button flattens all the controls in all of the channels.



When you click on the Snapshot button, it transmits the values of all the knobs and faders via MIDI. If 
you are recording and the Record mixer movements box in the Mixer Settings... window is checked, the 
values will be recorded. This is a good way of storing settings into a song.

Recording Mixer movements

Let's have a bit of fun and do some practical mixing in the process. Load the BUMB_B1.SNG file which is 
The Flight of the Bumble Bee. Open the Mixer Settings... window form the Options menu and make sure 
the Song data to mixer and Record mixer movements are checked.

The first makes the Mixer respond to Volume and Controller data which is in the song. The second 
records changes you make in the Mixer, providing you're recording at the time.

Play the file and watch the Mixer. You won't see anything exciting happening because there's no 
Controller data in the files. Let's make the bee buzz around a bit.

Click on the Add MIDI Track icon in the Track window.

Activate the Record button in the Rec column. If there's no Rec column, select it from the Select Track 
Columns window as described earlier. Set the Track's MIDI Channel to 0. Click on the All Flat button in 
the Mixer and then on the Record button in the Transport window.

Now, any Mixer movements you perform will be recorded into the track. Click and hold on the Pan pot in 
channel 1. This contains the melody so move the "bee" around from one side of the stereo image to the 
other. You can be as wild and erratic as you like but for a more artistic interpretation you might like to try 
smooth movements from one side to the other to imitate a "flight" rather than a jump!

Play it back and you'll see the Pan pot move in response to the Pan data.

Create another MIDI track, click its Rec button, set its MIDI channel to 0 and use it to record movements 
for the second violin part. As this is not so busy, you may like to be a little more restrained with it.

Save the song. Use a different name such as MYBEE. If you want to see one we prepared earlier, load at 
BUMB_B2. Select the first track and open the Piano Roll Editor. Select Pan in the drop-down Display 
menu and you'll see the pan data in the Velocity Display section of the window.

There is probably a lot less of it than in your piece. That's because it has been thinned using the Thin Out 
Continuous Events... function. You might like to thin out the data in your Bumble Bee song. This 
procedure was explained in the Piano Roll Tutorial.

While you're in the Piano Roll Editor you might like to try another way of recording the Pan data and that's 
to draw it in to the Velocity Display.
Recording mixer movements does not operate on Audio channels. To automate your Audio tracks, change 
the values in the audio pattern settings for each pattern.

Taking a Snapshot

After creating a piece of music, you may decide you only need to use one set of parameters for the whole 
piece. Instead of entering this data into the Event Editor, you can create the settings in the Mixer and 
save them directly to a track by taking a Snapshot.

Load the GAUDETE.SNG which is an old Christmassy choral work. Flatten the Mixer and play it. If you 
have better voice and choral sounds than those in the standard GM set then by all means use them.



However, you can improve the GM sounds by adding reverb and chorus and you can make the piece 
more interesting by spreading the voices around the stereo image. Make sure the top two user-definable 
pots are set to Reverb and Chorus. If they aren't, use the Mixer Settings... window to make them so.

Play the piece and adjust the Reverb and Chorus settings. Adding reverb will make the voice appear to 
be in a large hall - it can add considerably to the Cathedral effect. Adding Chorus thickens the sound.

Give each voice its own position in the stereo image. You may like to pan the highest one to the right and 
place the lower ones further to the left or you could pan the two highest voices fairly well left and right and 
place the two lowest ones in between them.

When you have a mix you like, add new track as you did before, click on its record button and set it to 
MIDI channel 0. With Sound Studio recording, when you click on the Snapshot button, all the Mixer 
settings will be recorded into the track.

Obviously, you want these to occur before the first note so you have to click on Record in the Transport 
window and then on the Snapshot button after the count-in has finished but before the first note has 
sounded. That's pretty difficult because the first note actually occurs on the very first beat of the bar. In 
fact, it's impossible!

It's common practice among those who create MIDI files to leave the first bar free for setting-up data. It's 
not just a question of squeezing all the data in before the first note. Some instruments take a short while 
to initialize after receiving certain types of information so you want to make sure they are correctly 
prepared for the music to avoid a glitch.

That's easily done in Sound Studio. Select all the tracks in the Track Editor, either by lassooing them all or 
by selecting Select All from the Edit menu. Make sure Snap is set to Bar and drag them en mass slightly 
to the right where they will snap to the second bar. If this isn't easy to see, zoom in until the bar lines in 
the Timeline are clear.

Now you have a full bar in which to click on the Snapshot button. But don't take too long - do it as soon 
after the count in as possible.

Switch on the metronome in the Transport window to help you. Are you only getting a two-beat count in? 
Check the Metronome Settings... window and look at the Count in Bars section. Does the count in say 
1 bar? And you're still only getting two beats count in. That's because the piece is in 2/2 time which only 
has two beats to the bar. Check it out in the Score Editor or the Conductor.

Change the Count in Bars to 2 and you'll get four clicks count in. The Metronome Settings... window is 
described in detail in the Reference section.

Here's a sort of negative tip. If you click on the Snapshot button during the last two beats of the count in, 
the data will still be recorded but it will be moved to the first beat of the bar - all of it! Try it.

Now, if you absolutely must start the music on the first beat, this is a good way to get your setting up data 
in there, too. You would need to move any notes which actually occurred at position 1:01:000 to a slightly 
later time position to avoid any glitches.

MIDI is a serial transmission protocol which means it can only transmit one item of data at a time. If there 
is lots of data on the same time positions, they are still sent out in a queue. If there is a lot of data, this 
could cause a time delay or a glitch. The moral of the story is to avoid these situations as much as 
possible if you can.

It's a good idea to delete any data which was not required. With this piece that would be all the data on 
channels 5 to 16. In fact, purely in the interests of tidiness, economy and clarity it's a good idea remove all 



surplus data from your sequences.

This is easy to do in the Event Editor - just click and hold on the first event on channel 5, drag downwards 
to select all following events and then delete them.

However, if you want the piece to play correctly on any instrument you would also want to include a GM, 
GS or XG Reset message along with other Controller messages to set the Pitch Bend range, centre the 
Modulation wheel and so on. Some instruments can take a while to respond to a Reset message - a 
"while" in MIDI terms may only be several milliseconds but if the instrument receives a Note On message 
during that time it may not play correctly - so you need to give an instrument time to set itself up.

Now, assuming you have recorded the data after the first beat, take a look at it in the Event Editor.

You'll notice that the data for each channel has been separated by six or seven ticks (ticks and timing 
positions are fully explained in the Reference section). This ensures that the sequencer does not try to 
transmit all the data at once which is a "good thing" as we discussed earlier.

Grouping Faders Together

One of the most handy features of real life mixers is the ability to grab hold of numerous sliders and slide 
them up or down together. Your only limitation is the number of hands you have! Sound Studio allows you 
to group faders together with a simple right mouse button click and move them all at once using the 
mouse. 

You can group as few as 2 or as many as 16 faders together for realtime automation. 

How to group the faders

It's quite easy to group the faders together - all you do is click on a fader using the right mouse button and 
hold the button down. A menu will appear:

Select a group from the list by moving the mouse over the required group and releasing the mouse 
button. You will notice the center band change colour. Assigning the fader to another group will change it 
to a different colour. 

By grouping all 16 faders you can create fade ins or fade outs to your songs. By doing this however - 
please remember that it will create a vast amount of MIDI data and could cause glitches in timing. In this 
case you should trim down the MIDI data.

By default, a fader is not part of any group, and its centre band is grey.

Back to the Tutorials Page





The Piano Roll Editor Tutorial
Quantisation
Partial Quantisation
Changing note lengths
Music for monophonic instruments
The Velocity Display area
Viewing MIDI Controller data
Editing Pitch Bend
Thinning Controller data

The Piano Roll Editor is the note equivalent of the Drum Editor. The Note Display area shows notes as 
rectangular bars on a grid against a keyboard on the left which indicates pitch. It takes its name from the 
Pianola rolls of yesteryear which consisted of rolls of paper with punched holes which triggered the keys 
on an specially-adapted acoustic piano.

Load the PIANOROL.SNG file, select the pattern and open the Piano Roll Editor. Adjust the window so 
you can see all four bars in the display. Use the Vertical Zoom In and Out buttons to set the display to a 
comfortable size.

Like the Drum Editor, you can change the grid resolution with the Grid Selector and if set to too fine a 
resolution the grid lines won't all show in the display until you zoom in. The shortest notes in this pattern 
are 1/16th notes so set the grid to 16.

Activate Cycle mode and set the Left and Right Locators to cycle through the pattern. Listen to it closely. 
You can probably hear that the timing is a little less than perfect. Look closely at the notes. To be in 
perfect time, the beginning of each note should sit squarely on one of the grid lines. Very few do and 
some are as much as 1/32nd out. You may want to zoom in a little to see this better.

You can put this right in two ways - you can adjust the notes manually or you can apply some 
quantisation.

Quantisation

Quantisation is the process of pushing and pulling notes onto certain divisions of the beat, basically to 
correct sloppy timing. It's one of the great functions you can perform with a sequencer but it has been 
much overused - and still is.

Quantisation can produce note-perfect timing but the trouble is, even the greatest musicians in the world 
don't play with such precision. The fact is, it's the small timing differences in a performance which make it 
sound interesting. So, use quantisation by all means but don't regard it as a universal panacea for poor 
playing and timing or your songs will turn out mechanical.

Lecture over. Let's see what we can do to tidy up this bass line.

Look at the grid and you can probably see that the lowest notes are supposed to occur on the beat, the 
highest notes in between the main beats and the middle notes on the beat a sixteenth before the main 
beats.

The lowest notes are fairly accurate so we'll leave them alone for the moment. The highest notes aren't 
too bad, either although a few are a little late. Some of the middle notes, however, particularly in bars 2 
and 3 are almost a thirty-second late. Let's try to sort those out first.

We'll quantize the whole set of middle notes en mass. Drag a lasso around them so they are all 



highlighted. Select Quantize... from the Procedures menu and set the Quantize Setting to 16.

Partial Quantisation

The Quantize routine usefully allows you to perform a partial quantize which is expressed as a 
Percentage Change. A full quantize will move a note onto the nearest specified division of the beat, in 
this case to the nearest sixteenth division. However, a Percentage Change of 50, say, would only move it 
half way towards the division. This improves the timing but doesn't make it perfect so there is still some 
"human feel" left.

We'll go the whole hog and use a setting of 100 percent!

Click on OK and watch the notes - they'll jump to the nearest grid division. But see what's happened - 
some of them have moved the wrong way! Play the pattern now and it'll sound worse than before. That's 
because some notes were so far out of time they were moved onto the wrong division.

However, it's easy to see where the notes should be. The culprits are on the first beat of bar 2 and the 
first beat of bar 3. Deselect the notes by clicking on an empty part of the Display area and, with the Arrow 
tool, drag the two notes back a sixteenth.

Whoops! There's still a note in the middle of bar 2 on the wrong beat. Drag that back a sixteenth, too. No, 
there's still another one. Can you spot it? You'll certainly be able to hear it. Put that right, too. Now what 
does it sound like?

Well, there's still some poor timing in bars 2 and 3. Let's try quantizing the highest notes in these two bars 
only. Drag a lasso around them, select Quantize... and set the Percentage Change to 50.

No, we've got the same problem. One of the notes is so far out it's being pulling onto the wrong beat. 
Drag it onto the right division.

The timing is better but it still sounds a little raggy. That's because even though the timing of the original 
recording was pretty poor, the performer (who shall remain nameless!) was still playing with a sense of 
rhythm. By quantizing selected sections we have destroyed that rhythmic relationship between 
consecutive notes.

But we can fix it. Choose Select All from the Edit menu. All the notes will highlight. Now quantize them all 
with a Percentage Change of 50.

There!

Zoom in and examine the notes. They have been pulled nearer to the beat they are supposed to be on 
but, because we used partial quantisation, they are not "note perfect" and still retain a little human feel.

Now try applying 100 percent quantisation to all the notes. You'll see them move on the grid but can you 
hear the difference? Use Undo and Redo in the Edit menu to flip between the two versions. There's not 
much in it, is there? Without getting into the realms of psychoacoustics, the small variations in the partially 
quantized piece will sound slightly more interesting to the listener, especially if an entire piece of music is 
partially quantized rather than fully quantized.

Changing note lengths

We can experiment further with this bass line. Save the partially quantized pattern so you can retrieve it 
again if you change it beyond recognition through editing.



Start Cycle playback as before, select all the notes and select Change Lengths... from the Procedures 
menu. The pattern consists of 1/8th and 1/16th notes. Let's see what happens if we change them all to 
1/16th notes.

Click on the Fixed Length button, set it to 16 and click on OK. The timing has not changed but the 1/8th 
notes are now shorter and the pattern will sound staccato.

Undo that and apply a Fixed Length of 8. The line will now have many overlapping notes and will have a 
sustained effect.

Undo this and then try Remove Overlaps. You'll see the top set of notes in particular shorten. The line 
will sound smoother, not as clipped as the staccato change, but we have lost the sustain effect of the 
overlapped notes.

Music for monophonic instruments

Which do you prefer? Because of the overlap, the original has more depth, especially when played using 
a piano sound. However, removing overlaps can be useful if you are trying to create an authentic sound 
using a monophonic instrument, that is one which can only play one note at a time such as a trumpet or 
clarinet.

You can see how effective this is by playing the line using different sounds. You don't have to stop 
playback, simply select Patch Lists... from the Options menu and single click on various instruments.

The Velocity Display area

Below the Note Display is the Velocity Display area. At the moment it contains vertical lines which 
represent the velocities of the notes above them. When you highlight a note its velocity highlights, too, 
and vice versa. You can highlight a velocity by clicking on it or by lassooing it. The lasso must completely 
encompass the velocity bar.

You can move a note by dragging its velocity left or right. This method does not allow you to move a note 
up or down and so change its pitch and it's useful if you want to adjust the position of a note and you're 
working on a grid which is zoomed out vertically.

You can edit the Velocity with the Cross hairs cursor. Right-click in the editor window to call up the Mouse 
Tools Selector and select the Crosshairs. 

Moving this across a velocity bar will change the value according to the vertical position of the Crosshairs. 
This is a very easy way to adjust the velocity of a note.

You can also drag the Crosshairs across a number of velocities to create a gradual increase or decrease 
in volume - not withstanding the information given earlier regarding the difference between Velocity and 
Volume data!

If you want to ramp velocities up or down in a straight line or to make a number of velocities the same, 
simply hold down the SHIFT key and click a point for the ramp to start then click again for the ramp to 
end. The velocities between the two points will be adjusted as if an imaginary line had been drawn 
between the two points.

Viewing MIDI Controller data

The Velocity Display can show other types of MIDI controller data - all 128 types, in fact, plus a few 



specialized controllers such as Pitch Bend and Aftertouch. 

They are selected by clicking on the arrow to the right of the Display box and then selecting the required 
controller from the drop-down menu.

You can try selecting other controllers but you won't see anything in the Display area because the pattern 
does not contain any other type of controllers.

Editing Pitch Bend

Load the PITCHBND.SNG file and look at the pattern in the Piano Roll Editor. Select Pitch Bend in the 
Display box. Set the program to Cycle between the three bars and start playback.

As the Play Position moves across the Piano Roll window you'll hear the sound of the guitar bending 
downwards as it reaches the Pitch Bend data in the display. The second note begins after the pitch has 
been lowered and so is affected by the Pitch Bend, too. Instead of playing its own pitch which is E, it 
sounds with a pitch of D.

Look carefully and you'll see a small red dot in the Display just after the second note ends. This is a Pitch 
Bend value of 64 which is the central position of a Pitch Bend wheel and effectively turns Pitch Bend off. If 
this small piece of data was not there, subsequent notes would sound a tone lower than they should 
which could cause all sort of problems.

You can edit the Pitch Bend data simply by dragging the Crosshairs across the Pitch bend data.

You can create new Pitch Bend data with the Pencil tool. Try drawing some curves into the display. Note 
that the Crosshairs only edits or shapes existing data while the Pencil creates new data.

You'll notice that the data you draw in appears in solid red as opposed to the lines of the existing Pitch 
bend data. This is because the original data has been thinned.

Thinning Controller data

Draw some Pitch Bend data into the display and activate playback. Now select Thin Out Continuous 
Events... from the Procedures menu. You can select the type of event you want to thin but as the only 
type in this pattern is Pitch Bend there's no need to select it specifically.

You do need to enter a value in the Delete one event in every box which determines how many events 
will be removed. Leave the setting at 2 which removes every other event, effectively halving the number. 
You'll see the solid block change to lines. Listen to the playback and it's unlikely that you'll notice any 
difference.

You can apply additional "Thins" to the data, each time halving the amount, and you may be surprised at 
just how much data you can remove without it effecting your perception of the sound.

There are three reasons why you may want to thin out Controller data:

* As you have seen, there can often be more Controller data in a piece than is required. MIDI is a serial 
protocol which means notes and events are transmitted one after the other. Even events which are 
supposed to occur at the same time are transmitted sequentially.

It follows, therefore, that if there is a lot of Controller data, some events could be delayed considerably. In 
mild cases you may notice slight irregularities in timing. In extreme cases there may be a most noticeably 
hiccup. So, reducing the amount of Controller data can help preserve timing and ease the transmission 



load.

* Controller data uses memory and takes up space in a file when it's saved to disk so reducing it 
conserves both. In these days when 4Mb and 8Mb of RAM is commonplace, this is not so important as it 
once was but if a piece contains a lot of Controller data the saving could be significant.

* Reducing Controller data to its essentials makes it easier to see and easier to edit.

With a little practise you'll find it's not too difficult to draw in a smooth Pitch Bend curve by hand although 
most musicians find using a Pitch Bend wheel more intuitive.



The Recording Tutorial
We've now looked at Sound Studio's main Editors so it's time to put everything together and record some 
music. This is the longest of the Tutorials but it brings together all the features you have already explored 
and it shows how to use them in a variety of ways which you'll do when creating your own music.

Rechannelising with MIDI Thru
Using Local Control
Metronome Settings
Setting the Tempo and Time Signature
Recording in real-time
Recording in step-time
Recording Audio Tracks

We'll start from scratch. Select New from the File menu.

Sound Studio will give you the option of saving whatever you were previously working on and then give 
you a selection of different types of track to work with; One chord track, one Melody track, four Audio 
tracks and fifteen standard MIDI tracks in that order. All the track parameters will be set to their default 
values which will be OFF or 0.

We'll record a bass line in real-time. First, make sure that the Virtual Keyboard is switched off and close 
its window. Next make the Transport Bar visible by clicking 'Show Transport' from the Fast Menu. Make 
sure the Rec button for Track 1 is on and that you can see the MIDI and Patch Columns. If any of these 
are not showing, select it in the Select Track Columns box as described earlier.

Make sure your keyboard is properly connected and play some notes. If everything is working as it 
should, a red LED will flash in the MIDI column indicating that MIDI data is present on that channel. The 
indicator flashes for both incoming and outgoing data.

Rechannelising with MIDI Thru

If you are using a keyboard with built in sounds to control the sequencer, but you want to hear sounds 
from the computer sound card, turn the volume of the keyboard down. If you are using a MIDI controller 
keyboard, this will not have sounds.

However, if you are using a keyboard with built in sounds for both recording and playback, you will have 
another adjustment to make. You want to be able to hear the keyboard, but not necessarily the current 
sound you are playing.

The solution is to put the keyboard into Multi-timbral or Combi mode. This allows it to play different 
music lines on different MIDI channels via MIDI. The manual will tell you how to do this - it's usually just a 
matter of pressing a button or selecting an option from a menu.

Using Local Control

When using a keyboard with built in sounds with Sound Studio where you want the sequencer to control 
the sounds on the keyboard, you will also need to switch Local Control off. This effectively disconnects 
the physical keyboard from the sound-generating section. The keyboard will still play sounds but only 
those arriving at the MIDI In socket. Most keyboards have Local Control and, again, you'll have to look in 
the manual to see exactly how to switch it off.

When you've done this, you will be able to play different sounds on the keyboard through Sound Studio 



without having to change the instrument or the 'MIDI transmit' channel on the keyboard. You will be able 
to select sounds from Sound Studio's Patch List window.

There is one other thing you may need to check. Open the MIDI Settings... window in the Options menu 
and make sure the Thru Channel Messages box is checked. Also, make sure than none of the Message 
Filters or Channel Filters are checked. The MIDI Settings... window is fully described in the Reference 
section.

Once you have set up Sound Studio, your keyboard and sound card or module, you can begin.

Metronome Settings

You'll need a timing reference to play against when recording. Select Metronome Settings... from the 
Options menu and check that its settings suit you. It uses a Side Stick, MIDI note C#1, for the click but 
you can change this if you wish.

You can also select different sounds and velocities for the main beat and the sub-beats in the bar. The 
default setting is to play the sub-beats with a lower velocity which we think is fine but do change it if you 
don't.

You can use the PC's speaker instead of MIDI for the Metronome output. You might want to do this while 
recording the drum tracks, for example. However, on some PCs the speaker may be rather quiet.

We also prefer to hear the Metronome only during recording so the Record Only box is checked. Finally, 
set the number of count in bars you require. Remember, if a piece is in 2/4, for example, a one-bar count 
in is only two clicks.

Now we're ready to begin. There may seem a lot of setting up to do but once it's done, Sound Studio will 
remember the settings.

Setting the Tempo and Time Signature

These default to 120bpm and 4/4. This piece is going to be a little faster so open the Conductor, click on 
the Conductor Point and change the Tempo to 132. 4/4 is fine.

You could have set the Tempo to 132 in the Transport window and deactivated the Conductor but it's good 
practise to use the Conductor as it means any tempo changes you make are automatically stored.

Recording in real-time

Click in the Patch column of Track 1 and select a bass sound. We've used Syn Saw Wave to produce a 
thick, analogue-type sound. We're going to record a bass line:

The riff is in 1/8th notes so there are eight in a bar and each note is followed by the same one an octave 
higher which we'll indicate by the ^ sign. Start on a low D and play: 

D    ^D    D    ^D    D    ^D    D    ^D        Bar 1
D    ^D    D    ^D    D    ^D    C    ^C        Bar 2
D    ^D    D    ^D    D    ^D    D    ^D        Bar 3
D    ^D    D    ^D Eb    ^Eb F    ^F        Bar 4

Practise it a few times until you're comfortable with it. Click on the Record button in the Transport window, 
tap along to the tempo with the count in and then play the line.



If the tempo is too fast, deactivate the Conductor and slow it down in the Transport window. After the 
recording, as soon as you activate the Conductor again, the 132 tempo will appear again.

Now play it back and listen to it. Does it sound okay? Does it need quantizing to tidy it up? Would you do 
a better job if you recorded it again?

If you answered Yes to the last question, select the Eraser in the Track window, click on the pattern to 
remove it and record it again.

If it's pretty good but you want to tighten the timing a little, Select the pattern and then select Quantize... 
from the Procedures menu.

You've recorded 1/8th notes so select 8 in the Quantize Setting box. We'd recommend a Percentage 
Change of 70 or 80 percent but we'll leave that decision up to you. If it's still not tight enough for you, you 
can increase the percentage.

Now we'll record an Orchestral Hit line. Select Track 2, click on its Rec button, open the Patch Lists 
window and select Orchestra Hit.    (see page 103 of the help manual for the score view).

The lower notes are the same as the notes in the bass line but played two octaves higher. The top notes 
are a fifth higher. In this line the notes occur on the beat, that is on quarter divisions of the bar. The notes 
to play are as follows:

D/A      /          /            /          Bar 1
D/A      /        D/A        C/G        Bar 2
D/A      /          /            /          Bar 3
D/A      /      Eb/Bb      F/A        Bar 4

Practise the line and when you're ready, record it.

You may want to quantize this a little, too. We want the bass line and the Hits to be pretty tight.

Recording in step-time

We're now going to record the following string line:

If it looks complicated, don't worry - we're going to do it the easy way, in step-time.

Select Track 3, click on its Rec button and use the Patch Lists to select String Ensemble 1. In the Track 
window, select the Pencil tool and click and drag a new pattern onto Track 3 running from bar 1 to 4.

Highlight the pattern and open the Score Editor. Make sure the Play Position is at 1:01:000. If it isn't, click 
on the Return To Zero button in the Transport window.



To enter notes in step-time, click on the Step-time icon and it will turn red,

Note lengths are determined by the Note Len setting. We're going to enter 1/16th notes so set this to 16. 
You also want to be able to see the notes correctly so set the Resolution to 16, too.

The first note doesn't occur until the second beat of the bar. You can advance the Play Position by the 
current note duration by pressing the Space Bar so press it four times to move on 4 x 1/16 notes. You'll 
see the Play Position line move and the Position indicator in the Transport window will advance to 
1:02:000.

Now play the notes on your keyboard. The first 20 are simply a chromatic or semitone scale, starting on 
the third D above Middle C. Make sure you take your finger off each key before you press another one. If 
you don't, both notes will appear at the same position - this makes it easy to record chords but we don't 
want any in this part.

The next eight notes are:

F E F F# G A Bb C

That brings us to the end of the second bar.

Press the Space Bar eight times to move the Position to 3:02:000. The next 20 notes are the same as the 
first 20 and the final eight notes are:

Eb F F# G A Bb C D

Now play your recording and see what it sounds like. if the sounds in your module are like ours, you may 
find that the Orchestral Hit part is overpowering the others. Open the Mixer, flatten all the settings and 
adjust the volumes of the parts with the faders.

You might like to do this in Cycle mode. Click on the Cycle button and set the Left Locator to 1:01:000 
and the Right Locator to 5:01:000.

As we've recorded it, all the patterns play at the same time. It would be more effective to build up to this 
state gradually by introducing the parts one at a time.

Hold down Control and drag Track 1 to the end of itself and then drag it again so it occurs three times. 
Move Track 2 to the start of bar 5 and then Control drag a copy to the end of itself. Finally, drag track 3 to 
the start of bar 9.

Deselect Cycle mode and click on Play. That sounds better. What it needs now is a drum track. This has 
been covered in the Drum Editor Tutorial so if you want to expand the piece, please carry on and do so.

See Also Recording Audio Tracks
Back to Tutorials page



The Score and Lyrics Editors Tutorial

Selecting patterns to edit
Improving the score display
Information Line
Selecting notes
Remove Overlaps
Mouse Tools
Kicking a note into pitch
Adjusting the Resolution
Score Settings
Entering Lyrics
Changing the Lyrics display
Triplets

If you read music, like working with "the dots" or want to create a score for printing, the Score Editor is the 
place to be. It shows your song in traditional music notation on the stave.

Converting a recording into notation is a tricky business because we never play music exactly as it is 
written. Even world famous concert musicians "interpret" the music by introducing small timing differences 
into their performance. It is these differences which make it interesting and which give it "feel".

So immediately we have a conflict between a real-time performance and printed notation. We don't want 
to lose the feel of a real-time recording but we need to remove the timing differences to convert it into 
good notation.

Fortunately, Sound Studio has several facilities which can help. The first thing to realise is that none of the 
Score settings and adjustments change any of the MIDI data so there is no need to worry about it 
changing your original recording. All the Score settings do is alter the way the score looks, not the way it 
sounds. However, you can also edit the notes on the stave and this does change the MIDI data.

Selecting patterns to edit

To see a pattern in the Score editor, you simply select it and open the Score window. However, there are 
several factors to take into consideration such as the number of patterns selected and the MIDI channels 
they use.

Sound Studio tries to display the selected patterns in a musically sensible way. If no pattern is selected, 
the first pattern on the currently-selected track is used. If there are no patterns on the currently-selected 
track, Sound Studio creates one, assuming that you want one to write notes into.

If several patterns are selected, they are displayed in ascending order of MIDI channel. If, like most users, 
you assign MIDI channel 1 to track 1, channel 2 to track 2 and so on, then the stave layout will follow the 
order of the tracks in the Track window.

The MIDI channels are taken from the Ch column in the Track window. In other words, the Score editor 
uses the same logic as the Track window.

If Ch is set to 0, Sound Studio uses the MIDI channel or channels the pattern was recorded on. If a 
pattern contains notes which were recorded on more than one MIDI channel, the program puts each 
channel on a separate stave. If you don't want it to do this, simply assign the track a channel in the Ch 
column.

Improving the score display



Load the CUCKOO.SNG which is an extract from Daquin's The Cuckoo. You'll notice that the piece 
contains two tracks assigned to MIDI channels 1 and 2. Select both patterns and open the Score editor. 
Make sure the Resolution combo box is set to 16. 

If you have changed the score settings and want to get back to some default values, quit the program, 
delete the DEFAULT.DEF file and restart the program.

We aren't going to pretend that this is a definitive performance but it was recorded in real-time and 
created to demonstrate how the Score editor works. The timing is a little rough in places and you can see 
that the score contains lots of little inter-note rests. They were definitely not in the original score.

Sound Studio has a simple cure for these. Open the Score Settings... dialog, check the Simplify Display 
box and close it.

The lower stave is immediately brought into line, and most of the upper stave, too.

Information Line

The problem with the dotted quavers is, quite simply, that they are too long but Sound Studio has no way 
of knowing whether it is those notes which are too long or the notes after them.

This can easily be fixed by adjusting the length, but note that you are physically about to change to the 
data and not just the score display. In some circumstances this may not be desirable but in many cases, 
including this one, the notes are clearly much longer than artistic interpretation calls for and a correction 
should even aid the performance.

Select the first problem note which is the sixth note in bar 1 by clicking on it. It will turn red to indicate it 
has been highlighted. You will see some data appear in the Information Line.

This is exactly the same as the Information Line in the Piano Roll Editor and shows the note's Position, 
MIDI Channel, Pitch. Velocity and Length. Left-click on the Length parameter to take it down to 110 or a 
little lower and the note will turn into a quaver!

That's one note fixed, three to go. But is there an easier way? Quantisation, perhaps?

Quantisation pushes and pulls notes onto certain divisions of the beat. It does not change their length. 
However, you may think that the recording would benefit from a little quantisation (yes, we agree!) so feel 
free to quantize it.

Note, however, that this will not change the display - try it! And remember you'll have to quantize to 1/16th 
notes so as not to disturb the two notes at the end of bar 10. Alternatively, you could select all the notes 
except those two and quantize to 1/8th.

Selecting notes

You can select notes individually by clicking on them and collectively by lassooing them as you have done 
in the other editors. You can also select and deselect notes by holding down Shift when you click on 
them.

Remove Overlaps

Open the Change Lengths... dialog in the Procedures dialog. We used this function in the Piano Roll 
Tutorial for a different purpose and although it's not a part of the Score setup, it's very useful for correcting 



scores.

Check the Remove Overlaps box, click on OK and you'll find that the score is now note perfect.

With the exception of an errant note which you can probably hear when you play the piece. It's the F 
natural in bar eight. It should be F sharp to let's put it right.

Mouse Tools

Like the other editors, the score editor has its own set of Mouse Tools. Activate the Mouse Tools selector 
by pressing and holding the right mouse button. Select the tool you want and release the button.

These are described in detail in the Reference section but most functions are self-explanatory. The Arrow 
is the default tool and is used for selecting and dragging notes, and changing items in the Information 
Line.

You can click notes onto the stave with the Note cursor and remove them with the Eraser.

The Glue tool joins two notes of the same pitch together. It's a little like a tie but instead of drawing a tie 
sign between the notes it will physically turn the first one into a long note. A tie sign will be used if the note 
is extended over a bar line or if the niceties of music notation layout demand it.

The Sharp and Flat tools raise (sharpening) and lower (flattening) notes and the Pen is used for entering 
and editing lyrics.

Kicking a note into pitch

We want to change the F natural into an F sharp. You could select it with the Arrow and then adjust its 
pitch in the Information Line. However, an easier way is simply to kick it up a semitone with the Sharp 
cursor.

Select the Sharp tool, click on the note and it will rise a semitone to F sharp.

The score is now, literally, note perfect. Let's see in what other ways we can adjust the format and layout.

Adjusting the Resolution

The Resolution setting is the equivalent of the Grid Resolution in the Piano Roll Editor. However, it has a 
rather different effect on the display. It determines the shortest note duration which will appear in the 
editor.

If there is a 1/16th note in the piece and you select a Resolution of 8, the 1/16th note will be forced onto a 
1/8th beat. The Resolution is also proportional and the lower the Resolution, the more notes the editor will 
display in a given space.

Try this with the Cuckoo piece. The notes will move closer together and the score will appear more 
compact although the last two 1/16th notes in bar 10 will have been squashed onto a 1/8th note so this 
resolution is not suitable for this piece.

Going the other way, select a resolution of 32. This will space the notes out more - far too much for this 
piece - but you may also see that a few 1/32nd notes have appeared. This is because you are now 
allowing the program to display 1/32nd notes and if the timing is out by that amount these notes will show 
up.



Of course, if you quantized the recording - or if you want to quantize it now - using a quantize setting of 
16, the 1/32nd notes will be moved towards 1/16th divisions of the beat and there will be no 1/32nd note 
hangers-on.

Score Settings

Put the Resolution back to 16 and open the Score Settings... window.

Most of the parameters which affect the score layout are set in this dialog. Most of the options are self-
explanatory but they are all explained in detail anyway in the Reference section. Let's see what 
differences they make to the score.

First of all try switching off the Sloping Beams. Some people think this looks neater and in this piece you 
may agree but if you were scoring a scale of notes you'd probably find that sloping beams look better.

If you are printing to a dot matrix printer, sloping beams can look very stepped and you'll get better results 
switching off Sloping beams in the Printer box.

If you liked the compact display when you set the Resolution to 8, reduce the Inter-note value to 7 or 8. 
This, as you will see, determines the space between the notes. Experiment with the Inter-stave Spacing, 
too. Both these settings are extremely useful if you want to fit a certain number of bars onto a page.

Entering Lyrics

Sound Studio's Lyrics Windows displays lyrics which are present in the song. Many commercial "Karaoke" 
MIDI files contained embedded lyrics and you can easily enter your own.

Load SCARBORO.SNG which is the first part of the folk song, Scarborough Fair. It's been arranged using 
the Chord Track and the Waltz accompaniment. There's more about this in the Chord Track Tutorial.

Open the Lyrics window which will be empty and place it at the lower right corner of the screen. Select the 
Melody track and open the Score Editor. Resize the window and put it in the upper left corner of the 
screen. Ideally, you want to see the Lyrics window, too, although this is not essential.

Select the Pen tool and click on the first note. The pen tool will only appear as an option if the correct lyric 
channel is set up in the Score Settings menu.    A text box opens ready for you to enter in a word. Type 
"Are" followed by a space then press Tab. The word will appear under the note and the text box will move 
on to the next note. You will also see the word in the Lyrics window.

Now enter "you" followed by a space and press Tab again. The next word is sung across two notes and 
this is shown by splitting the word with a dash. Type "go-" (no space), press Tab and type "ing", press 
space and then Tab.

"Scarborough" is split into three. Type: "Scar-", Tab, "bor-", Tab, "ough", space, tab, "Fair". Now we want 
to start a new line so type a hash (#) which forces a new line. It appears in the Score window but not the 
Lyrics window.

Now finish off the line:

Pars-ley, Sage, Rose-mar-y and Thyme.

You don't have to worry about the rest at the start of bar 6 because you can only attach lyrics to notes and 
the editor automatically moves onto the first note in bar 6.



When you're finish, press Return which signifies the end of lyric entry.

If you make a mistake you can use Undo to remove the last entry. You can delete lyrics with the eraser 
and you can start entering lyrics again by clicking on a note with the Pen.

Now select the Lyrics window and start playback. The lyrics will highlight in turn as the Play Position 
passes the notes they are attached to.

Changing the Lyrics display

Select Lyric Font... from the Options menu

This is a standard Windows Font selector where you can choose the Font, the Font Style and the Font 
Size that you want the Lyrics window to use.

Although Sound Studio's Score Editor does not include music symbols, you can use the Lyric facility to 
add commands such as pp, ff and other written instructions. Set the Lyrics channel in the Score 
Settings... dialog to the part where you want to place the instructions and enter the instructions as Lyrics.



Thin Out Continuous Events...

Allows you to reduce the density of events such as Modulation, Pitch Bend, MIDI Volume. It displays a 
Dialog where you set the degree of thinning.

If you are thinning Controllers, there are 128 of them to choose from, including Volume, Pan, Data Entry 
etc. Set the Controller Scope to be All or Specific. If thinning a specific Controller, use the combo box to 
choose the one you want to thin out.

Special treatment is given to minimum and maximum values, and centre values for Pan and Pitch Bend. 
These are not removed, ensuring controllers can return to their default positions.

Back to Procedures Menu



Toggle Editors Caption

If the Editors Window's caption bar is visible, it is removed. When it is not visible, it is replaced. Turning off 
the caption bar frees up a little screen space.

Back to Window menu



Toggle Fast Menu Caption

If the Fast Menu Window's caption bar is visible, it is removed. When it is not visible, it is replaced. 
Turning off the caption bar frees up a little screen space.

Back to Window menu



Toggle Transport Caption

If the Transport Window's caption bar is visible, it is removed. When it is not visible, it is replaced. Turning 
off the caption bar frees up a little screen space.

Back to Window menu



Track Window

Zoom In - display fewer bars in the same space

Zoom Out - display more bars in the same space

Vertical Zoom In - increase the height of tracks

Vertical Zoom Out - reduce the height of tracks

Add a MIDI Track - add a MIDI track if any are free

Add a Chord Track - add a Chord Track if one does not already exist

Add an Audio Track - add an Audio Track

To get to the furthest extent of a zoom, hold down the Control key while clicking on a zoom button.

Selectors

This affects how MIDI, Audio and Chord patterns line up when you move them. For example, if it is set to 
'Bar', they will 'snap' to the nearest bar. 
A value of 4 means the patterns will lock to the nearest crotchet beat
A value of 8 means the patterns will lock to the nearest quaver beat
A value of 16 means the patterns will lock to the nearest semi-quaver beat

Displays

1. The Track Display shows the name of each track and various settings associated with it. You can 
choose which settings are visible by changing which Columns are visible. Click on any of the column 
headings and the Select Track Columns Dialog will be displayed. Here you can turn columns on and off 
as required.

To the right of the columns is the Divider. You can drag this left and right so that some or all of the 
columns are obscured by the Pattern Display.

Track settings can be changed directly with the mouse or in the Track Settings Dialog.
Values may be increased by clicking on the value with the right mouse button, and holding the 
mouse button down whilst the values increase. To decrease the values, click and hold on the 
values with the left mouse button.

If you want to give a track a different name, double click on the name and the Track Settings Dialog is 
displayed. Here you can type the new name and change any of the settings which appear in the Track 
Columns.

If you click once on a track's name, you can move it up or down to a new position in the track list by 



dragging it with the mouse.

2. The Timeline shows the bars currently being displayed. The width of each bar depends on the Time 
Signature - this can change if there are Time Signature changes defined in the Conductor Window. If you 
click on the timeline with the left mouse button the left locator moves to the mouse position: use the right 
button to reposition the right locator. By clicking on the timeline while holding down the CONTROL key, 
the Play Position will jump to the mouse position.

3. The Pattern Display is where the patterns containing your recorded MIDI and audio data are 
displayed. They can be moved, copied, deleted or muted in order to change the structure of the 
composition. Double click on a pattern and the Piano roll editor is displayed. You can customize the 
double click action to open any editor screen by going to the Preferences menu.

Chord Track Editing Controls

When the current song contains a chord track, the settings can be edited with the following controls:

The Style Button shows the name of the current style. Click on it to display a menu containing the names 
of all the styles.

When a Chord pattern is highlighted, the following controls are available:

Clicking on the Section setting displays a menu of the 6 different style sections.

Clicking on the Chord setting displays a menu of the 12 possible chord root notes.

Clicking on the Type setting displays a menu of the available chord types.

The Mute Switches control which parts of the accompaniment play in the highlighted chord.

Entering a Chord Sequence

To change the chord in an existing chord pattern, you first need to click on it. This highlights the bar and 
shows all settings associated with it in the Chord, Type and Mute Switch displays. To change the Chord 
(i.e. the root note), click on the Chord display and choose one of the 12 possible notes from the pop up 
menu. Similarly, the chord type can be changed by clicking on the Type display and choosing one of the 
12 available types from the menu. If you double-click on a chord pattern, the Chord and Type menus are 
displayed automatically. To modify the arrangement in the pattern, use the 6 mute switches to enable 
playback of the required parts of the accompaniment. You can use the section menu to change from 
variation 1 to variation 2 or to enter fills, intro or outro.

A useful tip is to double click on an existing chord pattern. The program then takes you automatically 
through the chord pattern menus in order so that you can select all attributes of the chord pattern.

Chord patterns can be added and copied just like any other patterns.



MIDI Patterns

A MIDI/ Audio sequencer such as Sound Studio has many more tracks than any multi-track recorder is 
possible to build. Instead of forcing you to work in a linear fashion from the beginning of a song to the 
end, Sound Studio uses patterns which enables you to assemble a song from musical phrases, dropping 
them into the song wherever you wish. This is infinitely more flexible and is the way many composers 
think and work.
A good example of the way patterns work is when a drum loop is created. A 4 bar loop could be created, 
but you would want to repeat this loop for the remainder of the song. All you do is copy the pattern, and 
paste is numerous times after each other. 
A piano riff with its own pattern might sound great on an organ on another track - no problem - just click 
on the pattern and drag it to its new location on a new track.

There are two types of MIDI pattern: Parent and Child. A parent has a solid border, a child has a dotted 
border. A child pattern has no events of its own - it plays the events of its parent. It also has the same 
name so you can see which parent it belongs to - all other settings can be different from the parent, 
however. A child pattern is created when you copy a parent pattern (unless the 'Copy Patterns as Parents' 
switch is turned on in the Preferences Dialog). A child can be placed on the same or a different track from 
the parent. The illustration above shows a parent pattern, 'Drums1', which is followed by a child, so the 
same four bar drum pattern will play twice. If you were to change the parent in some way - transpose it for 
example - the child would be affected too as it shares the same events. If you were to delete the parent, 
the child would become a parent.

Chord Patterns

Chord patterns allow you to quickly and easily construct a song using the preset styles of the program. 
Chord patterns may be sliced and copied the same way as normal MIDI patterns.
There are two types of Chord pattern: Parent and Child. A parent has a solid border, a child has a dotted 
border. A child pattern has no settings - it plays the settings of its parent. A child pattern is created when 
you copy a parent pattern (unless the 'Copy Patterns as Parents' switch is turned on in the Preferences 
Dialog).

Audio Patterns

Audio patterns allow you to quickly construct a song by copying and pasting segments of audio across 
your tracks. An Audio pattern displays the waveform of the audio contained within it. You may use the 
usual mouse tools to cut, copy and delete audio patterns as you would any MIDI pattern. You cannot copy 
an Audio pattern to a MIDI track or vice versa. Sound Studio allows for audio patterns on up to 16 tracks 
-after that, you get virtual audio tracks. Patterns on virtual audio tracks will not be played.

There are two types of audio pattern: Parent and Child. A parent has a solid border, a child has a dotted 
border. A child pattern uses the same .WAV file as its parent. It also has the same name so you can see 
which parent it belongs to - all other settings can be different from the parent, however. A child pattern is 
created when you copy a parent pattern (unless the 'Copy Patterns as Parents' switch is turned on in the 
Preferences Dialog). If you delete the parent, the child becomes a parent. 
See the Audio Window Tutorial for more information on how audio patterns work.

Track Settings

Name Can contain up to 20 characters.
Prog The MIDI Program Number.
Patch Displays the name of the Patch corresponding to the current MIDI Program Number.
Bank The MIDI Bank controller value, works in conjunction with the Program Number to select 
variations on a sound.
Ch MIDI Channel. Values of 1 - 16 force all patterns on the track to play on the specified channel. A 
value of 0 will play the patterns on the channel(s) on which they were recorded.



P Port - one of the MIDI Out ports installed in the PC. If you hold down the Control key and click on 
the port setting, all tracks are assigned to the same port. A normal click on this setting displays a list of the 
open ports.
Vol MIDI Volume controller.
Pan MIDI Pan controller.
Audio FX Type Selects the effect type for audio tracks. Choose from Off, Delay, Echo or Reverb.
Rev / Audio Delay MIDI Reverb Depth controller. Also controls the delay value for audio tracks.
Chor / Delay Depth MIDI Chorus Depth controller. When an audio track is highlited - controls the 
effect depth.
Vel Velocity modifier - added to all velocities on the track as they are played. A negative value 
reduces velocity. Does not affect the contents of the patterns.
Tran Transpose offset - added to all notes on the track as they are played. A negative value 
lowers the pitch. Does not affect the contents of the patterns.
Time A timing offset. Adds the specified number of clock ticks to the events as they are played 
back. A negative value will make the events play early, a positive one will make them play late.

Track Buttons

Mute Prevents any MIDI data from being sent by a track.
Solo MIDI data will be sent from the soloed track ONLY. All other tracks are muted. You can 
still click on the mute buttons to turn muting off if you want to hear other tracks as well as the soloed one. 
When you click on a solo button, the statuses of all the mute buttons are stored, so that when solo is 
turned off the mute buttons return to their previous settings. If you then solo the SAME track the statuses 
of the mute buttons return to what they were when the track was soloed. If you solo a DIFFERENT track 
to last time, all mute buttons are turned on.
Rec Enables recording on a track. Incoming MIDI messages are rechannelized so they are 
sent from MIDI Out on the channel of the track whose Record button is turned on. If the channel is set to 
zero, the MIDI data is passed through unchanged. For an Audio track, pressing the Rec button opens up 
the Audio Input Monitor window for monitoring the input. 
When Multitrack Record option is enabled from the track window- you may record onto numerous MIDI 
channels simultaneously. Multitrack record mode also allows you to record 1 audio track and any number 
of MIDI tracks simultaneously.

These 3 buttons are also displayed on the mixer screen. Enabling the record button on a channel in the 
mixer screen will automatically update the track columns and vice versa.

Selecting Patterns

You can select patterns with either of these two methods:
1. Click on a pattern - it turns black to indicate selection. Click on another one and that becomes the 

selected pattern. 
2. With the left mouse button click on a part of the Pattern Display where there isn't a pattern. Any 

selected patterns become deselected. While still holding down the left mouse button, drag down and to 
the right, enclosing patterns in the dotted 'drag rectangle' as you go. Release the mouse button. The 
patterns inside the drag rectangle become selected. This method is called lassooing.

3. If you hold SHIFT and click on a pattern you can toggle its status between selected and normal. By 
using SHIFT clicking you can select several patterns. You can also lasso multiple patterns, then hold the 
SHIFT key down and click on other patterns to select them.

Using the Edit, Options & Procedures functions

When using functions from the Edit and Options menus, whether patterns are affected depends on their 
selection states. If you have selected one or more patterns, ONLY those patterns will be affected. If no 
patterns are selected, ALL patterns on the selected TRACK will be affected.
One method of copying one or more patterns is to select them and use the Copy function (Edit Menu) to 
place a copy of them on the clipboard. You can then Paste them into the Pattern Display at the current 



Play Position.

Moving and Copying Patterns

Selected patterns can be moved and copied. Click on any one of them and drag to a new position then let 
go the mouse button. If you hold down the CONTROL key before you click, a copy of the patterns will be 
made at the new position, leaving the originals intact. The newly copied patterns then become the 
selected ones.

Functions Menu

Copy Track Makes a copy of the selected track including the patterns - the child / 
parent status is determined by the setting in the Preferences Dialog.
Delete Track Deletes the selected track and all the patterns on it.
Delete All Tracks Deletes all tracks and patterns.
Delete Unused Tracks Deletes all tracks which do not contain any patterns.
Pattern Dimensions... Displays a Dialog where you can type in new start and end positions for the 
selected pattern.
Insert Between Locators Inserts space between the Left and Right Locators.
Delete Between Locators Deletes everything between the Left and Right Locators.
Slice at Locators Slices all patterns at both the Left and Right Locator positions.
Chords to MIDI Track If a Chord track exists, a MIDI track is created containing all parts of the chord 
track in the current Style.
Extract Pattern If you have a pattern containing events on more than one MIDI channel, this 
function allows you to separate the events into individual patterns, each containing a single MIDI channel. 
The new patterns are allocated their own specially created tracks. The original pattern is not changed.
Merge Patterns This function allows you to merge a number of selected patterns into one 
new pattern, which is given its own track. The original patterns are not changed.
Add MIDI Track Add a MIDI track if any are free.
Add Chord Track Add a Chord Track if one does not already exist.
Add Audio Track Add an Audio Track if one does not already exist.

Mouse Tools

To select a different mouse, hold down the right mouse button to bring up the Mouse Tool Selector. 
Move the mouse until the one you want is highlighted. Let go of the right mouse button - the selector 
disappears and the mouse cursor changes to the new shape.

1. The Arrow is at the top left so you can change back to it quickly - click the right button and release 
immediately - there's no need to drag.

2. The Pencil is used for drawing and sizing. You can draw in a new pattern or change the size of an 
existing one. To move the start position of a pattern click on the left half; to move the end of a pattern click 
on the right half. Drag the mouse to the required position and release the mouse button.



3. The Eraser is used to delete patterns. Click on a pattern with the eraser and it disappears. If you click 
on one of a group of selected patterns, all the selected patterns are deleted.

4. The Mute cursor is used to silence a pattern. Click on a pattern with the mute cursor and it turns grey 
to show it is muted. Click again and it changes back to normal.

5. The Knife is used to slice a pattern in two. The position you click on the pattern determines the end 
position of the first pattern and the start of the second one.

6. The Glue is used to join two patterns on the same track to create one new one which starts where the 
first pattern started and ends where the second one ended. Click anywhere on a pattern and it will be 
glued to the next pattern on the same track.

7. The Nudge Left tool is used in the track window to arrange patterns. If it is clicked on a pattern it will 
shuffle the pattern to the left so that the beginning of the pattern joins up with the end of the previous 
pattern. It will have no effect if there is no gap between the two patterns or the pattern is the first on the 
track.

8. The Nudge Right tool is used in the track window to arrange patterns. If it is clicked on a pattern it will 
shuffle the pattern to the right so that the end of the pattern joins up with the beginning of the next pattern. 
It will have no effect if there is no gap between the two patterns or if the pattern is the last on the track.

More information on mouse tools.

Multitrack Recording

When the switch is On, you can turn on as many track record (Rec) switches as you wish. When the 
switch is turned Off, the program checks to see if more than one Rec switch is on, and makes sure only 
one is left on (the top one). The Rec switches then behave as usual - only one can be turned on. When 
you turn Rec switches on and off while MIDI notes are passing thru, the program monitors your actions 
and makes sure no stuck notes occur. MIDI data is not rechannelized when Multitrack Recording is turned 
on. It is passed thru unchanged, to enable you to correctly hear what is being recorded. The MIDI 
Indicators show the MIDI data on the track which matches the MIDI channel of the incoming data, so 
several Indicators may be flashing at the same time. This is useful to see which channels contain MIDI 
data. The Rec switches are also useful to keep out MIDI channels which you do not wish to hear or record 
- only data arriving on channels enabled by a Rec switch are passed thru or recorded.
Overdub and Replace recording modes are both supported during Multitrack Recording.
Several new patterns may be created by Multitrack Recording. All patterns which are newly recorded or 
were overdubbed into are selected to make them easy to see.

Undo & Redo

You can use the Undo function to reverse the effects of the last editing operation. You can then use the 
Redo function to reverse the effects of the Undo function.

See also:
Adjusting Values, Transport Window, Conductor Window, Audio System Settings, Preferences.



Transport Window
Click on the text for a pop-up window with a decription of the button.

'Tape Recorder' Controls

Rewind 

Fast Forward 

Stop 

Play 

Record 

Auto Return

Record Mode

Toggle Switches

Metronome - 

Cycle 

Follow Position 

Conductor - makes playback obey the contents of the Conductor Window.

Edit Solo 

Punch 

Relocate Buttons

Return To Zero.



Go To End.

Hide / Show

The whole transport bar can be hidden / shown by pressing CTRL-F7 or by selecting hide transport / 
show transport from the window menu. When the program first starts, the transport bar is hidden and can 
be shown by clicking the option on the configurable fast menu.

Display Formats

Position bars:beats:ticks.
Time hours:minutes:seconds:frames.
Left Locator bars:beats:ticks. Click on the text 'Left Locator' to jump to its position. Short Cut 
Key "L"
Right Locator bars:beats:ticks. Click on the text 'Right Locator' to jump to its position. Short Cut 
Key "R"
Tempo beats per minute.
Time Signature beats per bar / beat time.

Chord Detection

The Chord box works out the name of the chord currently being played on the external MIDI keyboard 
and the MIDI tracks.

Each time you press or release a new note on the external keyboard, the program recalculates the chord 
name. For example, if you hold down C, Eb and G it will show Cm. If you add a Bb it will change to Cm7. 
If you then release the Bb, the display again shows Cm.

During song playback all notes except drums are fed into the chord detector. Use the Mute and Solo 
buttons to control which notes are detected - chord detection considers only audible notes.

You can choose to hide the transport window to free up some space in the track window from the 
Hide/Show option in the Window menu. You may also "toggle" the transport window    - although this will 
increase the size of the window and is not necessarily needed.

See also:
Adjusting Values, Track Window, Conductor Window.



Triplets

To insert triplets - First of all, choose which editor you are going to use. Piano roll, drum editor or score 
window? Click on the corresponding icon on the editors' strip. You will be presented with 4 empty bars. 
Click on the step icon. From the Note Length box, select your desired triplet length. 4T would insert 
crotchet triplets. 8T would insert crotchet quavers etc...
Click on your external keyboard (or on screen keyboard) to insert your notes. The notes will be assigned 
a triplet bar as soon as three notes are detected.
If using the toolbox "note" tool to insert notes on the appropriate leger line, you can use the mouse 
position values to help with the positioning of the triplets. For example, if inserting 3 crotchet triplets from 
bar 1 beat 1 , you would insert the first note on mouse position 
1:01:000    the second note would be in position 1:01:128 and the final triplet would be in position 
1:02:064. As soon as the third triplet note was inserted, the triplet sign would be included.



View Menu
The View Menu contains the following Menu Items:

View Menu

The View menu gives you access to all the available windows in Sound Studio. Each window has a short 
cut key assigned to it which you can press for instant access. 
All of the windows (except for the track and pattern settings) may be accessed from the editor strip that 
runs down the right hand side of the program. If this editor strip is closed you can still open the editor 
screens from the view menu.

Track
Piano Roll
Event
Score
Drum
Conductor
Notepad
Mixer
Keyboard
Lyrics
Instant Chord Track (ICT)
Audio
Track Settings
Pattern Settings

Back to Contents



Window Menu
The Window Menu contains the following Menu Items:

Cascade Windows
Tile Windows
Arrange Icons
Close All
Configure Fast Menu...
Hide Transport...
Hide Editors...
Hide Fast Menu...
Toggle Transport Caption...
Toggle Editors...
Toggle Fast Menu...
Large Time Display

Back to Contents



XG Drum Kits

Bank Select    MSB=Bank Number, LSB=000

<--- : Same as Standard Kit
---- : No Sound

Bank 127 127 127 127

Program # 1 2 9 17

Note# Standard Kit Standard2 Kit Room Kit Rock Kit

13 C#-1 Surdo Mute <--- <--- <---
14 D -1 Surdo Open <--- <--- <---
15 D#-1 Hi Q <--- <--- <---
16 E -1 Whip Slap <--- <--- <---
17 F -1        Scratch Push <--- <--- <---
18 F#-1        Scratch Pull <--- <--- <---
19 G -1 Finger Snap <--- <--- <---

20 G#-1 Click Noise <--- <--- <---
21 A -1 Metronome Clic <--- <--- <---
22 A#-1 Metronome Bell <--- <--- <---
23 B -1 Seq Click L <--- <--- <---
24 C    0 Seq Click H <--- <--- <---
25 C# 0 Brush Tap <--- <--- <---
26 D    0      Brush Swirl L <--- <--- <---
27 D# 0 Brush Sla <--- <--- <---
28 E    0      Brush Swirl H <--- <--- <---
29 F    0      Snare Roll Snare Roll 2 <--- <---
30 F# 0 Castanet <--- <--- <---
31 G    0 Snare L Snare L 2 <--- SD Rock M

32 G# 0 Sticks <--- <--- <---
33 A    0 Bass Drum L <--- <--- Bass Drum M
34 A# 0 Open Rim Shot Open Rim Shot 2 <--- <---
35 B    0 Bass Drum M Bass Drum M 2 <--- Bass Drum H 3
36 C    1 Bass Drum H Bass Drum H 2 <--- BD Rock 
37 C# 1 Side Stick <--- <--- <---
38 D    1 Snare M Snare M 2 SD Room L SD Rock
39 D# 1 Hand Clap <--- <--- <---
40 E    1 Snare H Snare H 2 SD Room H SD Rock Rim
41 F    1 Floor Tom L <--- Room Tom 1 Rock Tom 1

42 F# 1        Hi-Hat Closed <--- <--- <---
43 G    1 Floor Tom H <--- Room Tom 2 Rock Tom 2
44 G# 1        Hi-Hat Pedal <--- <--- <---
45 A    1 Low Tom <--- Room Tom 3 Rock Tom 3
46 A# 1        Hi-Hat Open <--- <--- <---
47 B    1 Mid Tom L <--- Room Tom 4 Rock Tom 4
48 C    2 Mid Tom H <--- Room Tom 5 Rock Tom 5
49 C# 2 Crash Cymbal 1 <--- <--- <---
50 D    2 High Tom <--- Room Tom 6 Rock Tom 6
51 D# 2 Ride Cymbal 1 <--- <--- <---

52 E    2 Chinese Cymbal <--- <--- <---
53 F    2 Ride Cymbal Cup <--- <--- <---
54 F# 2 Tambourine <--- <--- <---
55 G    2 Splash Cymbal <--- <--- <---
56 G# 2 Cowbell <--- <--- <---
57 A    2 Crash Cymbal 2 <--- <--- <---
58 A# 2 Vibraslap <--- <--- <---
59 B    2 Ride Cymbal 2 <--- <--- <---
60 C    3 Bongo H <--- <--- <---
61 C# 3 Bongo L <--- <--- <---
62 D    3 Conga H Mute <--- <--- <---



63 D# 3 Conga H Open <--- <--- <---

64 E    3 Conga L <--- <--- <---
65 F    3 Timbale H <--- <--- <---
66 F# 3 Timbale L <--- <--- <---
67 G    3 Agogo H <--- <--- <---
68 G# 3 Agogo L <--- <--- <---
69 A    3 Cabasa <--- <--- <---
70 A# 3 Maracas <--- <--- <---
71 B    3      Samba Whistle H <--- <--- <---
72 C    4      Samba Whistle L <--- <--- <---
73 C# 4 Guiro Short <--- <--- <---
74 D    4      Guiro Long <--- <--- <---
75 D# 4 Claves <--- <--- <---

76 E    4 Wood Block H <--- <--- <---
77 F    4 Wood Block L <--- <--- <---
78 F# 4 Cuica Mute <--- <--- <---
79 G    4 Cuica Open <--- <--- <---
80 G# 4      Triangle Mute <--- <--- <---
81 A    4      Triangle Open <--- <--- <---
82 A# 4 Shaker <--- <--- <---
83 B    4 Jingle Bell <--- <--- <---
84 C    5 Bell Tree <--- <--- <---
85 C# 5 ---- ---- ---- ----
86 D    5 ---- ---- ---- ----
87 D# 5 ---- ---- ---- ----

88 E    5 ---- ---- ---- ----
89 F    5 ---- ---- ---- ----
90 F# 5 ---- ---- ---- ----
91 G    5 ---- ---- ---- ----

Bank 127 127 127 127
Program # 1 25 26 33
Note# Standard Kit Electro Kit Analog Kit Jazz Kit

13 C#-1      Surdo Mute <--- <--- <---
14 D -1      Surdo Open <--- <--- <---
15 D#-1 Hi Q <--- <--- <---
16 E -1 Whip Slap <--- <--- <---
17 F -1      Scratch Push <--- <--- <---

18 F#-1      Scratch Pull <--- <--- <---
19 G -1 Finger Snap <--- <--- <---
20 G#-1 Click Noise <--- <--- <---
21 A -1 Metronome Clic <--- <--- <---
22 A#-1 Metronome Bell <--- <--- <---
23 B -1 Seq Click L <--- <--- <---
24 C    0 Seq Click H <--- <--- <---
25 C# 0 Brush Tap <--- <--- <---
26 D    0        Brush Swirl L <--- <--- <---
27 D# 0 Brush Sla <--- <--- <---
28 E    0      Brush Swirl H Reverse Cymbal Reverse Cymbal <---

29 F    0      Snare Roll Snare Roll 2 <--- <---
30 F# 0 Castanet Hi Q Hi Q <---
31 G    0 Snare L Snare M SD Rock H <---
32 G# 0 Sticks <--- <--- <---
33 A    0 Bass Drum L Bass Drum H 4 Bass Drum M <---
34 A# 0 Open Rim Shot <--- <--- <---
35 B    0 Bass Drum M BD Rock BD Analog L <---
36 C    1 Bass Drum H BD Gate BD Analog H BD Jazz
37 C# 1 Side Stick <--- Analog S Stick <---
38 D    1 Snare M SD Rock L Analog Snare L <---

39 D# 1 Hand Clap <--- <--- <---



40 E    1 Snare H SD Rock H Analog Snare H <---
41 F    1 Floor Tom L E Tom 1 Analog Tom 1 Jazz Tom 1
42 F# 1      Hi-Hat Closed <--- Analog HH Cl1 <---
43 G    1 Floor Tom H E Tom 2 Analog Tom 2 Jazz Tom 2
44 G# 1      Hi-Hat Pedal <--- Analog HH Cl2 <---
45 A    1 Low Tom E Tom 3 Analog Tom 3 Jazz Tom 3
46 A# 1      Hi-Hat Open <--- Analog HH Open <---
47 B    1 Mid Tom L E Tom 4 Analog Tom 4 Jazz Tom 4

48 C    2 Mid Tom H E Tom 5 Analog Tom 5 Jazz Tom 5
49 C# 2 Crash Cymbal 1 <--- Analog Cymbal <---
50 D    2 High Tom E Tom 6 Analog Tom 6 Jazz Tom 6
51 D# 2 Ride Cymbal 1 <--- <--- <---
52 E    2 Chinese Cymbal <--- <--- <---
53 F    2 Ride Cymbal Cup <--- <--- <---
54 F# 2 Tambourine <--- <--- <---
55 G    2 Splash Cymbal <--- <--- <---
56 G# 2 Cowbell <--- Analog Cowbell <---
57 A    2 Crash Cymbal 2 <--- <--- <---
58 A# 2 Vibraslap <--- <--- <---

59 B    2 Ride Cymbal 2 <--- <--- <---
60 C    3 Bongo H <--- <--- <---
61 C# 3 Bongo L <--- <--- <---
62 D    3 Conga H Mute <--- Analog Conga H <---
63 D# 3 Conga H Open <--- Analog Conga M <---
64 E    3 Conga L <--- Analog Conga L <---
65 F    3 Timbale H <--- <--- <---
66 F# 3 Timbale L <--- <--- <---
67 G    3 Agogo H <--- <--- <---
68 G# 3 Agogo L <--- <--- <---
69 A    3 Cabasa <--- <--- <---
70 A# 3 Maracas <--- Analog Maracas <---

71 B    3      Samba Whistle H <--- <--- <---
72 C    4      Samba Whistle L <--- <--- <---
73 C# 4 Guiro Short <--- <--- <---
74 D    4      Guiro Long <--- <--- <---
75 D# 4 Claves <--- Analog Claves <---
76 E    4 Wood Block H <--- <--- <---
77 F    4 Wood Block L <--- <--- <---
78 F# 4 Cuica Mute Scratch Push Scratch Push <---
79 G    4 Cuica Open Scratch Pull Scratch Pull <---
80 G# 4        Triangle Mute <--- <--- <---

81 A    4        Triangle Open <--- <--- <---
82 A# 4 Shaker <--- <--- <---
83 B    4 Jingle Bell <--- <--- <---
84 C    5 Bell Tree <--- <--- <---
85 C# 5 ---- ---- ---- ----
86 D    5 ---- ---- ---- ----
87 D# 5 ---- ---- ---- ----
88 E    5 ---- ---- ---- ----
89 F    5 ---- ---- ---- ----
90 F# 5 ---- ---- ---- ----
91 G    5 ---- ---- ---- ----

Bank 127 127 127
Program # 1 41 49
Note# Standard Kit Brush Kit Classic Kit

  

13 C#-1        Surdo Mute <--- <---
14 D -1        Surdo Open <--- <---
15 D#-1 Hi Q <--- <---
16 E -1 Whip Slap <--- <---



17 F -1        Scratch Push <--- <---
18 F#-1        Scratch Pull <--- <---
19 G -1 Finger Snap <--- <---
20 G#-1 Click Noise <--- <---
21 A -1 Metronome Clic <--- <---
22 A#-1 Metronome Bell <--- <---
23 B -1 Seq Click L <--- <---
24 C    0 Seq Click H <--- <---
25 C# 0 Brush Tap <--- <---

26 D    0      Brush Swirl L <--- <---
27 D# 0 Brush Sla <--- <---
28 E    0      Brush Swirl H <--- <---
29 F    0      Snare Roll <--- <---
30 F# 0 Castanet <--- <---
31 G    0 Snare L Brush Slap L <---
32 G# 0 Sticks <--- <---
33 A    0 Bass Drum L <--- Bass Drum L2
34 A# 0 Open Rim Shot <--- <---
35 B    0 Bass Drum M <--- Gran Cassa
36 C    1 Bass Drum H BD Soft Gran Cassa Mute
37 C# 1 Side Stick <--- <---
38 D    1 Snare M Brush SlapMarching Sn M

39 D# 1 Hand Clap <--- <---
40 E    1 Snare H Brush Tap Marching Sn H
41 F    1 Floor Tom L Brush Tom 1 Jazz Tom 1
42 F# 1      Hi-Hat Closed <--- <---
43 G    1 Floor Tom H Brush Tom 2 Jazz Tom 2
44 G# 1      Hi-Hat Pedal <--- <---
45 A    1 Low Tom Brush Tom 3 Jazz Tom 3
46 A# 1      Hi-Hat Open <--- <---
47 B    1 Mid Tom L Brush Tom 4 Jazz Tom 4
48 C    2 Mid Tom H Brush Tom 5 Jazz Tom 5
49 C# 2 Crash Cymbal 1 <--- Hand Cym.Open L

50 D    2 High Tom Brush Tom 6 Jazz Tom 6
51 D# 2 Ride Cymbal 1 <--- Hand Cym.Closed L
52 E    2 Chinese Cymbal <--- <---
53 F    2 Ride Cymbal Cup <--- <---
54 F# 2 Tambourine <--- <---
55 G    2 Splash Cymbal <--- <---
56 G# 2 Cowbell <--- <---
57 A    2 Crash Cymbal 2 <--- Hand Cym.Open H
58 A# 2 Vibraslap <--- <---
59 B    2 Ride Cymbal 2 <--- Hand Cym.Closed H
60 C    3 Bongo H <--- <---
61 C# 3 Bongo L <--- <---
62 D    3 Conga H Mute <--- <---

63 D# 3 Conga H Open <--- <---
64 E    3 Conga L <--- <---
65 F    3 Timbale H <--- <---
66 F# 3 Timbale L <--- <---
67 G    3 Agogo H <--- <---
68 G# 3 Agogo L <--- <---
69 A    3 Cabasa <--- <---
70 A# 3 Maracas <--- <---
71 B    3      Samba Whistle H <--- <---
72 C    4      Samba Whistle L <--- <---
73 C# 4 Guiro Short <--- <---
74 D    4      Guiro Long <--- <---
75 D# 4 Claves <--- <---
76 E    4 Wood Block H <--- <---

77 F    4 Wood Block L <--- <---
78 F# 4 Cuica Mute <--- <---
79 G    4 Cuica Open <--- <---
80 G# 4      Triangle Mute <--- <---
81 A    4      Triangle Open <--- <---



82 A# 4 Shaker <--- <---
83 B    4 Jingle Bell <--- <---
84 C    5 Bell Tree <--- <---
85 C# 5 ---- ---- ----
86 D    5 ---- ---- ----
87 D# 5 ---- ---- ----
88 E    5 ---- ---- ----
89 F    5 ---- ---- ----
90 F# 5 ---- ---- ----
91 G    5 ---- ---- ----

Bank 127 126 126
Program # 1 1 2
Note# Standard Kit SFX 1 SFX 2

  

13 C#-1      Surdo Mute ---- ----
14 D -1      Surdo Open ---- ----
15 D#-1 Hi Q ---- ----
16 E -1 Whip Slap ---- ----
17 F -1      Scratch Push ---- ----
18 F#-1      Scratch Pull ---- ----
19 G -1 Finger Snap ---- ----
20 G#-1 Click Noise ---- ----
21 A -1 Metronome Clic ---- ----

22 A#-1 Metronome Bell ---- ----
23 B -1 Seq Click L ---- ----
24 C    0 Seq Click H ---- ----
25 C# 0 Brush Tap ---- ----
26 D    0      Brush Swirl L ---- ----
27 D# 0 Brush Sla ---- ----
28 E    0      Brush Swirl H ---- ----
29 F    0      Snare Roll - --- ----
30 F# 0 Castanet ---- ----
31 G    0 Snare L ---- ----
32 G# 0 Sticks ---- ----
33 A    0 Bass Drum L ---- ----
34 A# 0 Open Rim Shot ---- ----

35 B    0 Bass Drum M ---- ----
36 C    1 Bass Drum H Gtar Cut Noise Dial Tone
37 C# 1 Side Stick Gtar Cut Noise2 Door Creaking
38 D    1 Snare M ---- Door Slam
39 D# 1 Hand Clap String SlapScratch
40 E    1 Snare H ---- Scratch 2
41 F    1 Floor Tom L ---- Windchime
42 F# 1      Hi-Hat Closed ---- Telephone Ring2
43 G    1 Floor Tom H ---- ----
44 G# 1      Hi-Hat Pedal ---- ----
45 A    1 Low Tom ---- ----

46 A# 1      Hi-Hat Open ---- ----
47 B    1 Mid Tom L ---- ----
48 C    2 Mid Tom H ---- ----
49 C# 2 Crash Cymbal 1 ---- ----
50 D    2 High Tom ---- ----
51 D# 2 Ride Cymbal 1 ---- ----
52 E    2 Chinese Cymbal FL.Key Click Engine Start
53 F    2 Ride Cymbal Cup ---- Tire Screech
54 F# 2 Tambourine ---- Car Passing
55 G    2 Splash Cymbal ---- Crash
56 G# 2 Cowbell ---- Siren
57 A    2 Crash Cymbal 2 ---- Train

58 A# 2 Vibraslap ---- Jetplane
59 B    2 Ride Cymbal 2 ---- Starship
60 C    3 Bongo H ---- Burst Noise
61 C# 3 Bongo L ---- Coaster 



62 D    3 Conga H Mute ---- SbMarine
63 D# 3 Conga H Open ---- ----
64 E    3 Conga L ---- ----
65 F    3 Timbale H ---- ----
66 F# 3 Timbale L ---- ----
67 G    3 Agogo H ---- ----
68 G# 3 Agogo L Rain Laughing
69 A    3 Cabasa Thunder Screaming
70 A# 3 Maracas Wind Punch

71 B    3        Samba Whistle H Stream Heartbeat
72 C    4        Samba Whistle L Bubble Footsteps
73 C# 4 Guiro Short Feed ----
74 D    4        Guiro Long ---- ----
75 D# 4 Claves ---- ----
76 E    4 Wood Block H ---- ----
77 F    4 Wood Block L ---- ----
78 F# 4 Cuica Mute ---- ----
79 G    4 Cuica Open ---- ----
80 G# 4        Triangle Mute ---- ----
81 A    4        Triangle Open ---- ----
82 A# 4 Shaker ---- ----

83 B    4 Jingle Bell ---- ----
84 C    5 Bell Tree Dog Machine Gun
85 C# 5 ---- Horse Gallop Laser Gun
86 D    5 ---- Bird 2 Explosion
87 D# 5 ---- ---- FireWork
88 E    5 ---- ---- ----
89 F    5 ---- ---- ----
90 F# 5 ---- Gorst ----
91 G    5 ---- Maou ----

See also XG Normal Voices



XG Normal Voices
This page acts as a quick reference guide to accessing the XG voices on Yamaha cards such as the 
DB50XG and the SW60XG.

XG Normal Voice List

Bank Select    MSB=000, LSB=Bank Number

Program        #                  Bank #        Voice Name             Element  
Piano

1 0 GrandPno 1
1 GrndPnoK 1
18 MelloGrP 1
40 PianoStr 2
41 Dream 2

2 0 BritePno 1
1 BritPnoK 1

3 0 E.Grand 2
1 ElGrPnoK 2
32 Det.CP80 2
40 ElGrPno1 2
41 ElGrPno2 2

4 0 HnkyTonk 2
1 HnkyTnkK 2

5 0 E.Piano1 2
1 El.Pno1K 1
18 MelloEP1 2
32 Chor.EP1 2
40 HardEl.P 2
45 VX El.P1 2
64 60sEl.P 1

6 0 E.Piano2 2
1 El.Pno2K 1
32 Chor.EP2 2
33 DX Hard 2
34 DXLegend 2
40 DX Phase 2
41 DX+Analg 2
42 DXKotoEP 2
45 VX El.P2 2

7 0 Harpsi. 1
1 Harpsi.K 1
25 Harpsi.2 2
35 Harpsi.3 2

8 0 Clavi. 2
1 Clavi. K 1
27 ClaviWah 2
64 PulseClv 1
65 PierceCl 2

Chromatic
Percussion

9 0 Celesta 1
10 0 Glocken 1
11 0 MusicBox 2



64 Orgel 2
12 0 Vibes 1

1 VibesK 1
45 HardVibe 2

13 0 Marimba 1
1 MarimbaK 1
64 SineMrmb 2
97 Balafon2 2
98 Log Drum 2

14 0 Xylophon 1
15 0 TubulBel 1

96 ChrchBel 2
97 Carillon 2

16 0 Dulcimer 1
35 Dulcimr2 2
96 Cimbalom 2
97 Santur 2

Organ 17 0 DrawOrgn 1
32 DetDrwOr 2
33 60sDrOr1 2
34 60sDrOr2 2
35 70sDrOr1 2
36 DrawOrg2 2
37 60sDrOr3 2
38 EvenBar 2
40 16+2"2/3 2
64 Organ Ba 1
65 70sDrOr2 2
66 CheezOrg 2
67 DrawOrg3 2

18 0 PercOrgn 1
24 70sPcOr1 2
32 DetPrcOr 2
33 LiteOrg 2
37 PercOrg2 2

19 0 RockOrgn 2
64 RotaryOr 2
65 SloRotar 2
66 FstRotar 2

20 0 ChrchOrg 2
32 ChurOrg3 2
35 ChurOrg2 2
40 NotreDam 2
64 OrgFlute 2

65 TrmOrgFl 2
21 0 ReedOrgn 1

40 Puff Org 2
22 0 Acordion 2

32 AccordIt 2
23 0 Harmnica 1

32 Harmo 2 2
24 0 TangoAcd 2

64 TngoAcd2 2
Guitar

25 0 NylonGtr 1



16 NylonGt2 1
25 NylonGt3 2
43 VelGtHrm 2
96 Ukulele 1

26 0 SteelGtr 1
16 SteelGt2 1
35 12StrGtr 2
40 Nyln&Stl 2
41 Stl&Body 2
96 Mandolin 2

27 0 Jazz Gtr 1
18 MelloGtr 1
32 JazzAmp 2

28 0 CleanGtr 1
32 ChorusGt 2

29 0 Mute.Gtr 1
40 FunkGtr1 2
41 MuteStlG 2
43 FunkGtr2 2
45 Jazz Man 1

30 0 Ovrdrive 1
43 Gt.Pinch 2

31 0 Dist.Gtr 1
40 FeedbkGt 2
41 FeedbGt2 2

32 0 GtrHarmo 1
65 GtFeedbk 1
66 GtrHrmo2 1

Bass
33 0 Aco.Bass 1

40 JazzRthm 2
45 VXUprght 2

34 0 FngrBass 1
18 FingrDrk 2
27 FlangeBa 2
40 Ba&DstEG 2
43 FngrSlap 2
45 FngBass2 2
65 ModAlem 2

35 0 PickBass 1
28 MutePkBa 1

36 0 Fretless 1
32 Fretles2 2
33 Fretles3 2
34 Fretles4 2
96 SynFretl 2
97 Smooth 2

37 0 SlapBas1 1
27 ResoSlap 1
32 PunchThm 2

38 0 SlapBas2 1
43 VeloSlap 2

39 0 SynBass1 1
18 SynBa1Dk 1
20 FastResB 1



24 AcidBass 1
35 Clv Bass 2
40 TeknoBa 2
64 Oscar 2

65 SqrBass 1
66 RubberBa 2
96 Hammer 2

40 0 SynBass2 2
6 MelloSB1 1
12 Seq Bass 2
18 ClkSynBa 2
19 SynBa2Dk 1
32 SmthBa 2 2
40 ModulrBa 2
41 DX Bass 2
64 X WireBa 2

Strings
41 0 Violin 1

8 SlowVln 1
42 0 Viola 1
43 0 Cello 1
44 0 Contrabs 1
45 0 Trem.Str 1

8 SlowTrStr 1
40 Susp Str 2

46 0 Pizz.Str 1
47 0 Harp 1

40 YangChin 2

48 0 Timpani 1
Ensemble

49 0 Strings1 1
3 S.Strngs 2
8 SlowStr 1
24 ArcoStr 2
35 60sStrng 2
40 Orchestr 2
41 Orchstr2 2
42 TremOrch 2
45 VeloStr 2

50 0 Strings2 1
3 S.SlwStr 2
8 LegatoSt 2
40 Warm Str 2
41 Kingdom 2
64 70s Str 1
65 Str Ens3 1

51 0 Syn.Str1 2
27 ResoStr 2
64 Syn Str4 2
65 SS Str 2

52 0 Syn.Str2 2
53 0 ChoirAah 1

3 S.Choir 2
16 Ch.Aahs2 2



32 MelChoir 2
40 ChoirStr 2

54 0 VoiceOoh 1
55 0 SynVoice 1

40 SynVox2 2
41 Choral 2
64 AnaVoice 1

56 0 Orch.Hit 2
35 OrchHit2 2
64 Impact 2

Brass
57 0 Trumpet 1

16 Trumpet2 1
17 BriteTrp 2
32 WarmTrp 2

58 0 Trombone 1
18 Trmbone2 2

59 0 Tuba 1
16 Tuba 2 1

60 0 Mute.Trp 1
61 0 Fr.Horn 2

6 FrHrSolo 2
32 FrHorn2 1
37 HornOrch 2

62 0 BrasSect 1
35 Tp&TbSec 2
40 BrssSec2 2
41 HiBrass 2
42 MelloBrs 2

63 0 SynBras1 2
12 QuackBr 2
20 RezSynBr 2
24 PolyBrss 2
27 SynBras3 2
32 JumpBrss 2
45 AnaVelBr 2
64 AnaBrss1 2

64 0 SynBras2 1
18 Soft Brs 2
40 SynBras4 2
41 ChorBrss 2
45 VelBras2 2
64 AnaBras2 2

Reed
65 0 SprnoSax 1

66 0 Alto Sax 1
40 Sax Sect 2
43 HyprAlto 2

67 0 TenorSax 1
40 BrthTnSx 2
41 SoftTenr 2
64 TnrSax 2 1

68 0 Bari.Sax 1
69 0 Oboe 2
70 0 Eng.Horn 1



71 0 Bassoon 1
72 0 Clarinet 1

Pipe
73 0 Piccolo 1
74 0 Flute 1
75 0 Recorder 1
76 0 PanFlute 1
77 0 Bottle 2
78 0 Shakhchi 2
79 0 Whistle 1
80 0 Ocarina 1

Synth Lead
81 0 SquareLd 2

6 Square 2 1

8 LMSquare 2
18 Hollow 1
19 Shmoog    2
64 Mellow 2
65 SoloSine 2
66 SineLead 1

82 0 Saw.Lead 2
6 Saw 2      1
8 ThickSaw 2
18 DynaSaw 1
19 DigiSaw 2
20 Big Lead 2
24 HeavySyn 2
25 WaspySyn 2
40 PulseSaw 2
41 Dr. Lead 2
45 VeloLead 2
96 Seq Ana 2

83 0 CaliopLd 2
65 Pure Pad 2

84 0 Chiff Ld 2
64 Rubby 2

85 0 CharanLd 2
64 DistLead 2
65 WireLead 2

86 0 Voice Ld 2
24 SynthAah 2
64 VoxLead 2

87 0 Fifth Ld 2
35 Big Five 2

88 0 Bass &Ld 2
16 Big&Low 2
64 Fat&Prky 2
65 SoftWurl 2

Synth Pad
89 0 NewAgePd 2

64 Fantasy2 2
90 0 Warm Pad 2

16 ThickPad 2
17 Soft Pad 2
18 SinePad 2



64 Horn Pad 2
65 RotarStr 2

91 0 PolySyPd 2
64 PolyPd80 2
65 ClickPad 2
66 Ana Pad 2
67 SquarPad 2

92 0 ChoirPad 2
64 Heaven2 2
66 Itopia 2
67 CC Pad 2

93 0 BowedPad 2
64 Glacier 2
65 GlassPad 2

94 0 MetalPad 2
64 Tine Pad 2
65 Pan Pad 2

95 0 Halo Pad 2
96 0 SweepPad 2

20 Shwimmer 2
27 Converge 2
64 PolarPad 2
66 Celstial 2

Synth Effects
97 0 Rain 2

45 ClaviPad 2
64 HrmoRain 2
65 AfrcnWnd 2
66 Caribean 2

98 0 SoundTrk 2
27 Prologue 2
64 Ancestrl 2

99 0 Crystal 2
12 SynDrCmp 2
14 Popcorn 2
18 TinyBell 2
35 RndGlock 2
40 GlockChi 2
41 ClearBel 2
42 ChorBell 2
64 SynMalet 1
65 SftCryst 2
66 LoudGlok 2
67 XmasBell 2
68 VibeBell 2
69 DigiBell 2
70 AirBells 2
71 BellHarp 2
72 Gamelmba 2

100 0 Atmosphr 2
18 WarmAtms 2
19 HollwRls 2
40 NylonEP 2
64 NylnHarp 2
65 Harp Vox 2
66 AtmosPad 2



67 Planet 2
101 0 Bright 2

64 FantaBel 2
96 Smokey 2

102 0 Goblins 2
64 GobSyn 2
65 50sSciFi 2
66 Ring Pad 2
67 Ritual 2
68 ToHeaven 2
70 Night 2
71 Glisten 2
96 BelChoir 2

103 0 Echoes 2
8 EchoPad2 2
14 Echo Pan 2
64 EchoBell 2
65 Big Pan 2
66 SynPiano 2
67 Creation 2
68 Stardust 2
69 Reso Pan 2

104 0 Sci-Fi 2
64 Starz 2

Ethnic
105 0 Sitar 1

32 DetSitar 2
35 Sitar 2 2
96 Tambra 2
97 Tamboura 2

106 0 Banjo 1
28 MuteBnjo 1
96 Rabab 2
97 Gopichnt 2
98 Oud 2

107 0 Shamisen 1
108 0 Koto 1

96 T. Koto 2
97 Kanoon 2

109 0 Kalimba 1
110 0 Bagpipe 2
111 0 Fiddle 1

112 0 Shanai 1
64 Shanai2 1
96 Pungi 1
97 Hichriki 2

Percussive
113 0 TnklBell 2

96 Bonang 2
97 Gender 2
98 Gamelan 2
99 S.Gamlan 2
100 Rama Cym 2
101 AsianBel 2

114 0 Agogo 2



115 0 SteelDrm 2
97 GlasPerc 2
98 ThaiBell 2

116 0 WoodBlok 1
96 Castanet 1

117 0 TaikoDrm 1
96 Gr.Cassa 1

118 0 MelodTom 2
64 Mel Tom2 1
65 Real Tom 2
66 Rock Tom 2

119 0 Syn.Drum 1
64 Ana Tom 1
65 ElecPerc 2

120 0 RevCymbl 1
Sound Effects

121 0 FretNoiz 2
122 0 BrthNoiz 2
123 0 Seashore 2
124 0 Tweet 2
125 0 Telphone 1
126 0 Helicptr 1
127 0 Applause 1
128 0 Gunshot 1

See also XG Drums
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Trouble-shooting
This section contains numerous hints and tips on how to get the most out of Sound Studio, and contains a 
list of FAQs (frequently asked questions). This should (hopefully) save you a phone call to our support 
dept.! Click on the appropriate topic for hints and tips:-

Program not working as it was at first
I can't seem to delete the chord or melody track
I can't record and playback audio at the same time
Inserting notes after bar 5
Printing Problems
Cannot input from keyboard
No Sound from Soundcard
Cannot change tempo
Accessing XG voices
Recording mixer movements
What's a duplex card?
Audio driver error
Cannot delete patterns
General Protection Faults
Audio Stuttering
Screen Size Problem

To view the Frequently Asked Questions document on the web, click on the web help button here. This 
answers all common questions and more are added as they come in. It is kept right up to date.

Back to technical support



Q. The program has been working perfectly OK, but sometimes I get a general protection fault 
and have to close down the program. What should I do?
A. Locate the directory where you installed the program e.g. "C:/Program Files/Sound_Studio" and 
delete two files called "default.def" and "default.wnd". Now try running the program. A general protection 
fault is often caused by a conflict between the software and other programs/devices on your system. 
These bugs if reported would be fixed in updates to the software. Deleting the default files returns the 
program to its original settings.



Q Working in the Piano Roll window I have been entering notes in Step Time. However, after I 
have played the notes back, I can't enter any more notes - beyond position 5.01.000. What do I do?
A. You need to close the editor screen. From the main track window, click on the right muse button to 
see the toolbox. Select the pencil tool. Click with the left mouse button on the right hand side of the 
pattern you are working on and stretch the pattern to the right. This will create more workspace for you to 
insert additional notes from bars 5 onwards.



Q. I cannot get my colour printer to work from the score editor. How do I fix it ?
A. The probable cause for this problem would be the drivers which accompany some colour printers. If 
you choose a Black & White (monochrome) printer driver then it should work fine. For example the HP 
Deskjet 500 rather than Deskjet 550C. These drivers will be found on the Windows disks/CD-ROM. Also 
check the Evolution web site for updates to the software.



Q. I've plugged my keyboard into the soundcard and can hear demo songs OK when I play them. 
I can even hear sounds when playing from the on-screen keyboard but I can't hear anything when 
playing from the external keyboard. What am I doing wrong?

A. This probably means your soundcard has not been fully installed. Please follow the checklist below:

1. Are the MIDI cables properly set up? MIDI OUT from the keyboard to the IN of your Soundcard?
2. Is the keyboard switched on?
3. Start a new file in Sound Studio by going to the file menu and selecting "New". This should enable 
channel 1 for recording by default. Play the keyboard and check the MIDI column for an input signal. 
(Represented by a red bar). If a red bar appears but no sound is heard - this is good news - all you need 
to do now is choose an appropriate MIDI output driver from the devices menu. If no input signal is 
observed or heard, either install the soundcard again, or try installing the MPU401 driver from the 
Windows disks or Win95 CD-ROM.



Q. When I change the tempo of a song and then start recording - it always changes back to 120. 
Why does it do this?
A. You must change the tempo in the Conductor Screen if you wish to make a permanent change in 
tempo. (A bit like the Master Track in other programs). Alternatively you could turn off the "Conductor 
Follow" button on the transport bar. This means it would ignore any tempo events you had in the 
conductor window.



Q. How do I access some of the XG voices on my Yamaha Card using Bank Select messages 
such as Voice 1, Bank 40 (Piano Str)?
A. Go to the Options menu/Devices., Make sure the XG mode is selected for your MIDI Output device. 
Double click in the patch column on the voice you wish to change. Press the XG button. As soon as the 
XG mode is enabled, you may input a value in the bank section. Type in 40. Click on OK, and you should 
hear your new sound.    You may also change the Bank values from the track columns. To do this, - Click 
on the "Track Columns" option from the Options menu. Click on the "Bank" option. This will give you a 
bank column where you can insert your bank values.



Q. How do I record the mixer movements on a new track ?
A. You must select channel 0 to record a global mix for all tracks.



Q. I can't record and playback audio at the same time 
A. You need to check first of all that your soundcard is 'full duplex' as explained below. You will only be 
able to record and playback audio simultaneously if your soundcard has full duplex support. Next get up 
the windows control panel called 'Multimedia' (Start Menu-Control Panels-Multimedia). On the 'Audio' tab, 
check that you have an audio output device and an audio input device selected and that they are 
different. Run Sound Studio again making sure that no other audio programs are open. 

Q. What is a duplex soundcard? 
A. A duplex soundcard is a card which can record and playback audio simultaneously. Most modern 
soundcards will support this feature. If your soundcard is not fully duplex - get in touch with your 
soundcard manufacturers and they might have some new software drivers that would convert your card 
into a duplex card. 



Q. The program tells me that it cannot find the audio output driver. What do I do ?
A. You need to quit the program; go to your control panel in Windows, and check that your audio driver 
is properly installed. If no Audio driver is found, click on "Add driver" , and give the path of your Sound 
directory. If you are still having problems, try re-installing the soundcard and use the default values. If all 
else fails contact your soundcard manufacturer.



Q. I cannot copy or delete patterns in the main track window. What am I doing wrong?
A. You need to close any editor screen that’s already open. Sometimes the editor screens will be hidden 
behind the track window so use the tile windows option to check before closing all editor windows.



More Recording Examples

Recording from a Microphone along with a MIDI song. 
Karaoke Files
Recording to the Line-In of the soundcard.
Recording from multimedia (CD-ROM)
Creating Wave files for transferring to CD-ROM
Converting MIDI files into .WAV wave files.

This chapter contains some typical recording scenarios when using Sound Studio.    Audio recording may 
be done from a variety of sources including microphone, hi-fi, synthesizer, DAT recorder, CD-ROM - in 
fact if you can plug the cable from the device into your soundcard you can record from anything! 

Recording from a Microphone along with a MIDI song.

Open the song file you wish to record onto.

Plug your microphone into the Mic In of your soundcard. If your microphone has a ¼ inch jack connector, 
you’d need to have a converter for it to connect to the mini jack socket on the soundcard.
If you can hear the signal coming from the mic through the speakers, you are almost there! If not, go to 
your soundcard mixer. 

For most sound cards you may access the sound card mixer by double clicking on the loudspeaker icon 
on your task bar  (Win95/98). If no icon exists, select Settings-Control Panels from the Start Menu and 
double click the multimedia control panel icon. On the Audio tab there should be a check box labelled 
'Show volume control on the taskbar'. Make sure this is ticked. 

A double click on the loudspeaker icon will launch the mixer. By default it should show the playback 
volume of the MIDI, Audio and CD level. This may be configured from the options menu. If the Audio level 
is turned right down or is muted - un-mute it and increase the volume level using the slider. Talk into your 
microphone to check the input level. 

Once you have the microphone outputting through your speakers, you need to check the recording level 
of the microphone. 

Task switch back into Sound Studio using the task bar, or the Alt + Tab keys. If an Audio track already 
exists, click on the record button for this audio channel. This will open up the Audio Input Monitor. If no 
Audio track exists, go to the functions menu from the track window, click on Add Audio Track and enable 
the track for recording.

Check the level of the microphone again by talking/singing into it at the desired level. If the VU meters 
start flashing on the Audio Input Monitor - you’re getting Audio input into the program. If not, go to the 
sound card mixer screen once more and from the options menu select Properties. Click on the Recording 
button. This shows the Recording levels of the Audio, MIDI, CD-ROM, Line-In and any other recording 
devices into the soundcard 

To enable the microphone for recording you must click in the Select box under the microphone slider. 
Adjust the volume slider until you can hear your voice coming through your speakers.

Task switch back to Sound Studio and check the input levels on the VU meters. If the green bars are 
short, increase the mixer input volume level. If the bars are green, yellow and red you need to decrease 
the microphone input level as it will distort.

The next step is to decide on the quality of the subsequent recording. Go to the Audio/Audio System 



Settings menu and click on low, medium or high quality. Don’t worry about the buffer size for now - you 
should only alter this if you have problems with the playback of audio.

From the Audio Input Monitor, choose whether to record in mono or stereo. 

Handy Hint!!
Most microphones will be mono so there would be little point in doubling hard disk space by recording in 
stereo.

If you wish to assign a name for your recording, click in the Wave file section of the Audio Input Monitor. 
Type in a name (no longer than 8 characters) and click OK. If you don’t enter a name, a default name will 
be chosen which you can change at a later date if you so wish.

At last we’re ready to start our first recording!
Rewind the song to the start. A fast way of doing this is to press the Go to Start button This will also send 
a MIDI reset command to your soundcard so that the correct voices are played from the start.

Press the Record button on the transport bar. (Short Cut key +). You will get a 4 beat count-in before the 
song starts playing. 

When you’ve finished your recording - press stop (or the spacebar). A message box will appear to ask if 
you were happy with the recording. If you click OK, it will draw a new audio pattern in the audio track. If 
you click cancel, you can try the recording again. 
Click on OK and close the Audio Input Monitor.
Rewind the song to the start and press play. You will hear your new recording played back in sync with 
your song.

If you wish to record some more audio at a later position in the song, move the play cursor to a new 
position. 

Handy Hint!!
Use the left locator to set the start position of a recording. You may then use the L key on your PC 
keyboard to move the play position to that locator from anywhere in the track window.

From the diagram below you may see that the Left locator is positioned at the end of the original sample 
on bar 21, the play cursor is also set at bar 21 so the recording will commence from that position. 
Each time you click on an audio channel for recording, the Audio Input Monitor window will open with a 
new file name so you don’t need to worry about over-writing existing audio.

Karaoke Files
One cool way to check out the audio recording in Sound Studio is to sing along to Karaoke files. If you 
have a MIDI file that contains lyrics, open it and click on the Lyric Screen button. Add an Audio track from 
the functions menu of the main tracks window and follow the same procedure as the Microphone 
recording tutorial above. 
Once the recording has finished - why not play back your recorded voice singing the song as the lyrics 
update on the screen. You could even add fancy effects such as reverb or echo to your voice to give it 
that professional touch.

Recording to the Line-In of the soundcard.

If you wish to record Audio from an external synth/keyboard or hi-fi you would need to connect the output 
of that device into the line input of your soundcard. To set up the recording/playback levels, follow the 
same procedure as that for the microphone tutorial above. Instead of enabling the Mic input, enable the 
Line-Input. 
Recording using this method would allow you to overdub any existing song with audio such as a wacky 
synth sound from an external keyboard, or maybe recording your favourite tunes from a tape player.



Recording from multimedia (CD-ROM)

Sound Studio is excellent for a compilation of all your favourite tracks from CDs. Before you can do that 
however you must be able to input data from your CD-ROM into your soundcard. If your soundcard/CD-
ROM have been properly installed you should have a connecting cable from the CD-ROM into the 
soundcard - this is so that any audio on the CD-ROM drive may be played through your soundcard.
If everything is configured properly, the next step is to test the recording input level from the CD-ROM into 
your soundcard. 
Follow the same procedure as that for setting up the microphone for recording, but enable the CD 
Audio/Mix Out level for recording.

Please note that if the MIDI slider is also enabled for recording - you will record the MIDI data as you 
input from CD-ROM. 
To start playback of the CD you should call up the CD controller of your choice. The standard player that 
comes with Windows is in the Accessories section and is called the Media Player.

Handy Hint!!
For fast operation between your Media Player and Sound Studio, use the Alt +Tab keys on your keyboard 
to switch between applications.

There are 2 ways of recording from your CD. You may either:-

· Press play on your CD-player (Media player or other). Task switch to Sound Studio and press the 
record button on the transport bar. This means you would have to start playback of the CD before the 
section you were hoping to record.

· Press record on the transport bar of Sound Studio then task switch to your Media Player and press 
play. This way you can ensure you are recording only the appropriate audio from the CD. You will 
however record a small amount of additional audio in the time it takes to task switch between Sound 
Studio and the Media Player. You can trim out this audio at a later date.

Creating Wave files for transferring to CD-ROM

With CD Writers becoming far more accessible to PC users - creating your own Audio CDs couldn’t be 
any easier. Sound Studio has all the right tools for creating and editing your songs which may then be 
sent down to your CD Writer in the correct .WAV format.

· Save your songs or MIDI files in wave file format (digital audio) and transfer them to an Audio CD in 
any order you wish.

· Record your favourite vinyl records into Sound Studio- then transfer to your own compilation CD. 
(Usual copyright restrictions apply)

· Store your completed songs on data CD-ROMS as digital data (.WAV) format for any third party to 
listen to using any Windows Wave player.

Converting MIDI files into .WAV wave files.

As long as your soundcard can support duplex operation, you can save your MIDI sequences directly as 
wave files. To do this you would have to do the following:-

1. Open your MIDI song file. Click on the Add Audio track from the functions menu in the track window.
2. Click on the record enable button in the Audio track. This will open the Audio Input Monitor window.
3. Press play on the transport bar. If the VU bars start flashing in the Recorder window it means the MIDI 

song may be recorded as Digital Audio. 



4. Check your soundcard mixer record levels and enable the MIDI levels for recording.
5. Press Record on the transport bar. The MIDI file will begin playback and the output will be recorded 

into the Audio track. If you wish, you may record the microphone input simultaneously.
6. The end result will be a new wave file in the Audio track. Click on the waveform and enter the Audio 

Window. The wave form will be displayed on screen.
7. Go to the File menu and click on Save    As.. option. Click on the .WAV extension and choose a name 

for this wave file for later reference.
8. To save the complete song as a Wave file you would have to convert the MIDI first into a wave file then 

perform a track bounce (Audio menu) on the whole song to include all other audio patterns in the 
bounce.

9. Open your CD Writer’s software and locate your new wave file for transferring onto the CD. Please 
note that with most CD Writers - when recording digital audio the process is one-shot which means 
you can only write one time to each CD so get all your wave files together before transferring as you 
cannot add any more at a later date.

10. If the wave files are stored as .WAV files on a data CD-ROM, you may continue to add wave files at a 
later date as the CDs will be Multi Sessioned. 

Please refer to your CD-ROM writer help for more information on writing audio to disks.



Select Track Columns...

Displays a Dialog where you can choose which of the columns are displayed in the Track Window. For 
example, if you prefer to see Patch Names instead of Program numbers, turn on the Patch switch and 
turn off the Program switch.

Back to Options menu



Windows
Detailed explanation of the contents of each editing window.

1. Track

2. Piano Roll

3. Event

4. Score

5. Drum
Tab for re-positioning editors.

6. Conductor

7. Notepad

8. Mixer

9. Keyboard

10. Lyrics

11. Instant Chord Track

12. Audio 

Transport
Fast Menu
Mouse Tools

See also:
Adjusting Values, Keyboard Shortcuts.



Procedures Menu
The Procedures Menu contains the following Menu Items:

Transpose...
Change Velocity...
Change Lengths...
Quantize...
Move Events...
Change Timing...
Delete Events...
Thin Out Continuous Events...
Delete Identical Events
Reverse Notes

When one of the above is called from the Track Window only the selected pattern(s) will be treated. If you 
have not selected any patterns, all patterns on the selected track will be treated.

Back to Contents



Options Menu
The Options Menu contains the following Menu Items:

Preferences...
MIDI Settings...
Metronome Settings...
Mixer Settings...
Devices...
Patch Lists...
Score Settings...
Lyric Font...

Back to Contents



Arrow
1. The Arrow is at the top left so you can change back to it quickly - click the right button and release 
immediately - there's no need to drag. The arrow is used for lassooing objects or for moving patterns 
around in the track window. 



Pencil
2. The Pencil is used for drawing and sizing. You can draw in a new pattern or change the size of an 
existing one. To move the start position of a pattern click on the left half; to move the end of a pattern click 
on the right half. Drag the mouse to the required position and release the mouse button.



Eraser
3. The Eraser is used to delete patterns. Click on a pattern with the eraser and it disappears. If you click 
on one of a group of selected patterns, all the selected patterns are deleted.



Mute
4. The Mute cursor is used to silence a pattern. Click on a pattern with the mute cursor and it turns grey 
to show it is muted. Click again and it changes back to normal.



Glue
6. The Glue is used to join two patterns on the same track to create one new one which starts where the 
first pattern started and ends where the second one ended. Click anywhere on a pattern and it will be 
glued to the next pattern on the same track.



Arrow
1. The Arrow is at the top left so you can change back to it quickly - click the right button and release 
immediately - there's no need to drag.



Pencil 
2. The Pencil is used for drawing and sizing. In the Note Display you can draw in a new note or change 
the size of an existing note. To move the start position of a note click on the left half; to move the end of a 
note click on the right half. Drag the mouse to the required position and release the mouse button.
You can also draw in the Velocity Display. If any event type except Velocity is chosen as the display type, 
you can use the pencil to draw in new data, a pitch bend curve, for example.



Eraser
3. The Eraser is used to delete events. It works in both the Note and Velocity Displays. Click on an event 
with the eraser and it disappears. If you click on one of a group of selected events, all the selected events 
are deleted.



Crosshairs
4. The Cross hairs cursor is used for modifying existing data in the Velocity Display. Hold down the left 
button and drag the mouse around - if the cross hairs move across any data it will change to a new value 
proportional to the height of the cross hairs in the display. You can use a single click to change a single 
value or drag the mouse right and left to reshape a controller curve. If Velocity is the display type you can 
create a crescendo by dragging the cross hairs left to right across the velocities, moving up the screen as 
you go.



Glue
6. The Glue is used to join two notes of the same pitch to create one new note which starts where the first 
note started and ends where the second one ended. Click anywhere on a note and it will be glued to the 
next note of the same pitch.



Arrow
1. The Arrow is at the top left so you can change back to it quickly - click the right button and release 
immediately - there's no need to drag.



Note
2. The Note cursor enters a note with a length specified by the Note Len combo box. The pitch and 
position are calculated from where the mouse button clicks on the stave. These values are shown in the 
Information Line. The Note cursor can also be used to change the length of an existing note - the note's 
length changes to that of the cursor.



Eraser
3. The Eraser is used to delete notes. Click on a note with the eraser and it disappears. If you click on 
one of a group of selected notes, all the selected notes are deleted. The eraser can also be used to 
delete lyrics - just click on the lyric.



Glue
4. The Glue is used to join two notes of the same pitch to create one new note which starts where the first 
note started and ends where the second one ended. Click on a note and it will be glued to the next note 
of the same pitch. This can also be thought of as a means to tie two notes.



Accidentals
5, 6. The Sharp and Flat cursors are used for modifying existing notes. One sharpens a note, the other 
flattens it. If the SHIFT key is held down the note changes by an octave, otherwise it changes by a 
semitone.



Pen
7. The Pen is used to enter and edit lyrics. Click on an existing lyric and an edit control appears, into 
which text can be typed. TAB moves to the next lyric, RETURN terminates editing.

If you want to add lyrics, click on the head of the note under which the lyric is needed; a new lyric is 
created. When you have finished editing this lyric, press TAB to advance to the next note without a lyric 
and type again. When you have finished, press RETURN to stop editing.

When you make a change to the lyrics, they will immediately be reflected in the Lyric Window if it is open. 
You can cause a line feed by typing a lyric event containing a # sign only. This allows you determine the 
line breaks for when the lyrics are printed in the Lyric Window.



Knife
5. The Knife is used to slice a note in two. The position you click on the note determines the end position 
of the first note and the start of the second one.



Knife
5. The Knife is used to slice a pattern in two. The position you click on the pattern determines the end 
position of the first pattern and the start of the second one.



Arrow
1. The Arrow is at the top left so you can change back to it quickly - click the right button and release 
immediately - there's no need to drag.



Drum Sticks
2 & 4. The Drum Sticks are used to enter new hits. The large stick enters a hit at the Velocity setting for 
that drum. The small stick enters a hit at a velocity 10 less than the Velocity setting. These two sticks 
therefore allow the entry of two levels of velocity, which can be regarded as normal and accented hits. If a 
stick clicks on an existing hit, it changes that hit's velocity.



Eraser
3. The Eraser is used to delete hits. Click on a hit with the eraser and it disappears. If you click on one of 
a group of selected hits, all the selected hits are deleted.



Velocity Modifiers
5 & 6. Velocity Modifiers - The Up arrow increases the velocity of a hit by 10. This would make a purple 
hit red. The Down arrow decreases the velocity of a hit by 10. This would make a purple hit blue.



Arrow
1. The Arrow is at the top left so you can change back to it quickly - click the right button and release 
immediately - there's no need to drag.



Pencil
2. The Pencil is used for entering new points. Click in the Time Signature, Key Signature or Tempo 
Displays and a new point is added. A warning message is displayed if there is already a point at that 
position. Time Signatures must be entered on bar lines in order to make musical sense. When you enter a 
Time Signature, it will be 4/4. If you need to change this, click on it to select it, then change its value in the 
Information Line with the left and right mouse buttons. Similarly, a Key Signature starts off as C, so click 
on it and change it in the Information Line to the signature you require.



Eraser
3. The Eraser is used to delete points. Click on a point with the eraser and it disappears. If you click on 
one of a group of selected points, all the selected points are deleted. The first entry in each display cannot 
be deleted - in order to make musical sense the Conductor must contain an initial Tempo, Time Signature 
and Key Signature.



PC Keyboard
By using keys (A - #) and (W-]) you can play one and a half octaves of the keyboard. Holding down the 
Shift Key whilst hitting a key will transpose the keys up an octave thus increasing the range of the screen-
keyboard!

Hitting the "Scroll Lock" button will transpose the keyboard down one octave. This is useful for playing 
single fingered chords using the QWERTY keys.



Adjusting Values

Functions Menu

Displays a pop-up menu containing functions relevant to that window.

Adjusting Values

The left and right mouse buttons are used to change the values displayed in a window as follows:

Left Button -1
SHIFT + Left Button -10 (-12 when adjusting note values - one octave)
Right Button +1
SHIFT + Right Button +10 (+12 when adjusting note values)

Holding down a mouse button causes the values to change repeatedly until the limit for that particular 
value is reached. To move quickly through the values without using the SHIFT key, hold down the 
opposite mouse button to the one you started with. For example, click on the left button to reduce a value 
in steps of 1. Without taking your finger off the left button, hold down the right button - the values will start 
to reduce in steps of 10 (12 for notes). Take your finger off the right button and the values revert to 
reducing in steps of 1.



Rewind
Rewind is used to move the Play Position to an earlier one. If used during play, the new position will take 
effect when Rewind is released. If the right mouse button is used to press Rewind, the winding speed is 
three times as fast. If you are working in an editing window (e.g. Piano Roll, Event) winding speed is 
slower in order to give you finer control over the Play Position.



Fast Forward
Fast Forward is used to move to a later position in the song.



Stop
Stop does just that - it stops playback or recording.



Play
Play has two functions:

1. It starts playback when the sequencer is not running.
2. It punches out when recording is in progress - the sequencer keeps running but the record button 

returns to the off position and any recorded material is displayed.



Record
Record has two functions:

1. It starts recording when the sequencer is not running. Recording is preceded by a count in (unless 
the number of count in bars is set to zero in the Metronome Settings Dialog).

2. It punches in when playback is in progress - the sequencer keeps running but the play button 
returns to the off position. No count in is given in this instance - recording begins immediately.



Auto Return
This tells the program where to send the Play Position when the sequencer stops. There are three 
possible settings:

1. Off - the Play Position stays where it is.
2. Zero - the Play Position goes to the start of the song.
3. Last Start - the Play Position goes to the position from where playback last started.



Record Mode
Click to choose either Replace or Overdub.    Overdub  will overwrite any existing data without deleting the 
original data. Replace mode will replace any existing data with the new recorded data.



Metronome
turns on the metronome click, as defined in the Metronome Settings dialog.



Cycle
allows for the looping of sections between the left and right locators.



Follow Position
will scroll the pages if the play cursor reaches the end of the screen. Turn this off if you notice glitches 
during playback of audio.



Conductor
Conductor makes playback obey the contents of the Conductor Window. When this is off, it ignores any 
tempo changes in the conductor window.



Edit Solo
Plays only the contents of the current edit window.



Punch
Punch enables the automatic Punch In and Out function. This takes place between the left and right 
locators. During playback, when the left locator is reached, the program will automatically go into Record 
mode. When the Right locator is reached it will automatically drop out of record mode.



Go To End
moves the play cursor to the end of the last pattern in a song.



Return To Zero
rewinds the song to the start. It also sends a reset message to your soundcard according to which mode 
you are in (GM, GS or XG).



Fast Menu Window
The Fast Menu can hold ten commands which can access simply by clicking on a button. 
The    Configure Fast Menu Dialog lets you customise the contents of the menu.
The left side lists the commands which can be used in the Menu. The right side shows the current 
selection. To remove a command, highlite it and click on the Delete button. The Empty button will remove 
all entries.
To add a command, highlite it on the list on the left and click the Add button. If the menu already has ten 
commands, the Add button will be greyed out.
You can reorder the positions of the commands by highlighting one and clicking on the Up or Down 
button.
There's more information on the fast menu in the Fast menu tutorial.

See also:
Adjusting Values. Toggle Captions



GS Variations
When setting up your sound module to play back MIDI, it is suggested that you send a "Reset All 
Controllers" command prior to your sequence. This ensures all volume, pan, and program changes are 
reset. After any initialisation message, at least 200mS of interval (a few MIDI clicks) should be inserted 
before the first note data.

Handy Hint!!

For GS sound modules - the variation sounds are accessed by using MIDI controller number 0 followed 
by a program change. The controller numbers will be in the order of 0,8,16,24 or 32. The patch list screen 
of Sound Studio contains useful buttons for accessing these Sub Capital tones at a simple click of the 
mouse. For GM or XG modes, the buttons are disabled but you ,may still type in the appropriate bank 
value in the Bank value area.
When GS mode is enabled you should be able to see a GS patch list appear. Most of the variation 
sounds for GS happen to be in bank 8 - but you'll also find excellent sounds elsewhere!

Handy Hint 2 !!
To access the TG300B mode on XG sound modules - go to the Options menu and from the Devices 
menu select the GS option next to your MIDI Output driver. When the "Home" key is pressed on your 
QWERTY keyboard a GS reset command will be sent to your card and will switch your XG card in to 
TG300B mode.



Snap

The Snap setting helps you line up patterns when you move them as they will automatically "snap" to the 
bar division set in the Snap box. Zoom in so you can see the first two bars clearly and then click and drag 
the Child pattern to the first 1/8th division of bar 1.



The Audio Tutorial 
Quick Overview
Importing/Exporting Wave files
Recording Audio
Checking Audio Input Levels
Viewing the Audio waveform
Record While Playback
Controlling the Volume, Pan and Reverb Levels
Digital Delay
Echo
Reverb
Altering the Parameters of an audio pattern
Track Bouncing Audio
Looping Audio Patterns
Recording in loop mode
Punch In Record for Audio
Snapping Audio Patterns

Quick Overview

Sound Studio supports record and playback of up to 4 digital audio tracks to run in sync with MIDI. The 
number of Audio tracks you can actually play back will be hardware dependent. The faster the machine 
and hard disk - the more tracks you’ll be able to play back. Sound Studio will play a maximum of 4 tracks, 
but will support unlimited virtual Audio tracks. Virtual tracks will display a V in the channel column in the 
track window when all 4 Audio tracks are open. Audio patterns on Virtual Audio tracks will not be 
outputted through your soundcard - only the first 4 tracks. When working with more than 4 audio tracks it 
will always be the top 4 tracks that will play so if you want to hear a virtual track lower down the list, 
simply move it up to the top.

Sound Studio records and plays back 16 bit mono or stereo samples at 11025, 22050 or 44100 Hertz. It 
allows the recording of    one mono or one stereo track at a time. Sound Studio allows simultaneous 
recording and playback of audio (as long as your soundcard supports this feature) and will allow you to 
import up to 100 wave files (.WAV) into Sound Studio at any one time - more than enough!

The Audio window is the editor screen for all Digital Audio wave files present in Sound Studio. The 
Wave window displays the audio recording as a digital waveform from left to right. 

Importing/Exporting Wave files

Go to the file menu and select the New option. This will open the empty track window - ready for your new 
track. Click on the Red Wave Insert icon (situated to the right of the chord insert icon and to the left of the 
Snap section ) to add an empty wave pattern into your track window.
This will open up the Audio window. It will have no waveform showing as we have not opened one yet.!
Open a    .wav file by clicking on the button marked "Click to select a Wave file" and locating the wave file 
in the Waves directory off the Sound Studio directory.

Once the wave file is open it will show up in the wave window as a red-coloured waveform. Press play on 
the transport bar. You will now hear the wave file. - Sounds slightly better than the sounds on your 
soundcard doesn’t it!!    We are now listening to true digital audio. 

Place your mouse cursor half way across the waveform and click with your left mouse button. This will set 
the start point of the sample. You will notice that the waveform to the left of the cursor will be coloured 
dark grey to indicate it is not being played. Press the rewind button so that the position display on the 
transport bar shows 1:01:000. Now press play. You will now hear the sample being played from the new 



start position. If you wish, you can click on the waveform using the right hand mouse button. This will set 
the end point of the sample. Again, the remainder of the waveform to the right of this cursor will be a dark 
grey colour. Experiment with these cursor positions for a while until you are comfortable with the 
operation. 

For fine tuning the start and end points of a sample you can click in the start and end sections of the 
information line running above the sample waveform. To increase the values, click with the right mouse 
button. To increase the values a lot faster in steps of 10, hold down the left mouse button after first 
pressing the right mouse button. To decrease the values in the start and end boxes, click on the values 
with the left mouse button and hold. To speed up the process, click and hold down the right mouse button 
after first pressing the left mouse button. The active area of the sample will have a white background.

The information line also contains information on the wave file format such as sample rate; mono or 
stereo; the duration of the sample in seconds and the amount of hard disk space the file takes up in kB. 
The start and end points and the duration are also given in milliseconds at the end of the information line 
in brackets.

Let’s now take the start and end points back to their original values. To do this, click on the Recall button 
on the same line as the Close button. 

Recording Audio 

Congratulations! You have seen how easy it is to manipulate the start and end points of a sample - but 
now we’re going to make our own recording. Follow these simple guidelines and you’ll get to grips with 
Sound Studio in no time at all!

First things first.

Open a New file from the File menu.

Before recording any audio, you must decide what kind of results you are after. Do you want CD Quality 
stereo samples, recorded at 44.1kHz which will use up ~10.1Mb of your hard disk space per minute, or 
could you make do with mono samples of 22kHz which will use up ~2.5Mb of hard disk space per 
minute. Quite often you will notice no significant difference between samples recorded at 44.1kHz and 
those recorded at 22kHz.

Go to the Audio System Settings option from within the Media menu and click on the desired settings. 
Let’s say we choose a Sampling frequency of 22050 Hertz.

The next step is to decide which track to record to. From the main track window, click on one of the record 
buttons on one of the four Audio tracks.

This will automatically open up the Audio Input Monitor    window. If the Audio Record Window does not 
show up, check the preferences options from the Audio Window.

The Audio record window shows the full path and filename for the new wave file which is to be made. It 
also displays the format of the recording (16 bit stereo 22050 Hertz). All recordings in Sound Studio will 
be 16 bit. 

To the left of the window you will find a tick box with stereo written next to it. If this option is ticked - the 
recording will be in stereo otherwise it will be a mono recording.

By default, the program calls the first file name SS-001.WAV, and will record to the Waves directory.. - 
Don’t worry though -    you can change the name/path later! The number (001) will increment with every 



audio recording you make.

Checking Audio Input Levels

The next step is to listen to your Audio source to check the levels. This is where the fun starts!

If inputting from a microphone through your soundcard, you must make sure the Mic Record is enabled in 
your soundcard mixer. (See the Trouble Shooting section ). Speak into your microphone and check the 
VU meters on the Audio Input Monitor Window. You will notice the VU bars will start flashing green and 
maybe yellow (depending on how loud you sing!)

This is good news. The signal is not distorting. If the VU bars were red, that would mean the incoming 
signal was too loud and would likely to distort on playback - so STAY OUT OF THE RED!!

When you’re ready to record, hit the record button on the transport bar. (Short Cut key is + on the numeric 
keypad. You will get a 4 beat count-in. (The amount of count-in beats is specified by the value in the 
metronome settings in the Options menu).

Recording Format

This option specifies if a recording will be monophonic or in stereo. A mono recording will take up half the 
disk space of a stereo recording - but will have the same signal coming through left and right speakers. A 
stereo recording is ideal when sampling , say, a weird synth-like panning effect from left to right in the 
stereo field. You can however pan mono recordings in Sound Studio. We will come to this later on.

After the count-in - start singing! When you’ve finished your recording - press Stop on the transport bar 
(or press the space bar). A message screen will then appear to ask you if you want to keep the recording. 
If you are happy - click on OK. If not, click on Cancel to re-record your audio. You must press one of these 
buttons before you can carry on working with your song. Don’t forget to rewind your play position to the 
start of the song before attempting the recording again!
You can choose to either close down the Audio record window, or leave it open for recording another 
audio track. The Track number will be updated in the Audio Input Monitor window when a different Audio 
track is enabled for recording. The filename will automatically change before making a new recording so 
that your original file is not over-written. You see - we think of everything!!

If you click on OK, your Audio recording will appear in its own pattern on the first Audio track.

Handy Hint: 

To move the play position to a new position, click on Ctrl key and click the left mouse button anywhere in 
the bar display area of the track window.

Viewing the Audio waveform

Click on the pattern with the left mouse button to highlight it. Now click on the Audio Edit Window icon 
situated at the bottom of the editor strip.

Your recording will appear as a waveform in the Audio Window. Click on Normalize from the Audio menu if 
you wish to increase the level of the sample. When happy, close the window. 

(There’s more on Normalizing files later on in the reference section.)

Now we’re ready to overdub some audio on another track. 



This time we will give our new recording a different file name from the default name supplied by the 
program. First of all, click on the record enable button for the second audio track. This will open the Audio 
record Window if it’s not already open. To change the file name click on the box next to where it says 
Wave File. 

This will display the Save File dialog box. Type the path and new filename of your next recording and click 
on OK. This will display the new name in the Audio Record window. 

Again, check your levels - then hit record on the transport bar. One of two things could happen here. 
1. You will hear Audio Track 1 being played as you record your new track.
2. You will get a warning message telling you that the wave device is already in use.

Record While Playback

If a warning screen doesn’t appear when playing 2 or more audio tracks - it means your soundcard is 
capable of Record While Playback (RWP). The cards which support this feature are sometimes known as 
Full Duplex cards and allow you to listen to existing Audio tracks as you record new Audio tracks. 

Stop the recording after a few seconds and click on OK to accept the recording. You should now see a 
new pattern on the second Audio track. Rewind the song to the start and press play. 

This goes to show just how easy it is to multi-track record Audio!!!

If your card doesn’t support record while playback, you may turn off that option from the 
Audio/Preferences menu.
If you do get a warning screen, go to the Audio menu and disable the Play Audio Tracks While Recording 
mode from the preferences option. This will allow you to record on a different Audio Track but won’t play 
back existing audio on other    tracks whilst in record mode.

Controlling the Volume, Pan and Reverb Levels

When playing back multiple Audio patterns on different tracks you might hear a distorted effect. To get 
around this problem, we have introduced Volume sliders for all Audio tracks in the mixer screen. These 
volume sliders work in real time which means you can alter the levels as your song is playing. If you have 
a large buffer value set up in the Audio System Settings menu you will notice a slight lag between moving 
the fader and hearing the result. To overcome this problem - simply decrease the buffer size until the 
response is faster. Let’s test this out.

Copy some wave files numerous times across the track screen. 

Handy Hint:

A fast way of copying multiple patterns is to single left click on the pattern to highlight it, then hold down 
the Ctrl key and left click and hold again on the pattern whilst you move it across horizontally. Release the 
left mouse button when you wish to drop it in place. You can highlite multiple patterns by holding the Shift 
key as you first click on them.

Now we'll open the mixer screen by clicking on the mixer icon on the editor's strip. Alternatively, you could 
select the mixer option from the View menu (F9).

Mixer Screen

You’ll notice that the mixer screen has a strip of device names across the top. These are the MIDI Ports 
recognised by your system. Try clicking on them to see what happens.



If you click on a Port name and it displays a grey looking mixer, it means you haven’t enabled that port 
from the Options/Devices menu. This mixer is a multiple port mixer which means you have a separate 
mixing console for each of your outputs. This is ideal if you are playing the internal sounds on your 
soundcard AND sending MIDI messages to an external sound module/synth or if your soundcard has 
more than one MIDI instrument.

The last Port name is called Audio. This is where we change the levels of the Audio patterns. Click on the 
Audio button at the top right of the mixer screen. The Audio device in use is dependent on the device set 
up in the Multimedia section of your control panel (Windows 95 / 98).

You will see that four of the sliders and controls are available and the rest of the mixer is in grey. This 
shows the four available audio output channels. Each Audio track has it's own set of Volume slider, Pan 
control, Reverb Depth Control, Reverb Delay control, Mute and Solo buttons. First, we'll only change the 
volume level.

Rewind your song to the start. You should have a few samples spread across one of the tracks. Press 
play. You will see the VU display flashing in the corresponding Audio track in the mixer screen. If the 
recording is in stereo, you should see 2 narrow coloured strips flashing independently of each other in the 
VU meter section of the mixer. If the recording was done in mono, both coloured strips will flash in 
tandem. If you wish to conserve processing power for other purposes, you can turn off the VU meters in 
the mixer screen by disabling the Display Audio Meters on Mixer option in the Preferences section of the 
Audio System Settings menu. 

Try moving the volume fader up and down by clicking on it with the left mouse button and moving it 
vertically. You are now behind the desk of a professional Digital Mixing console - on your own PC !

Altering Audio Pan Levels

Sound Studio allows you to play back either mono or stereo samples in every Audio Track. In other 
words, you don’t have to specify which mode you wish to be in. In other Audio sequencers you would 
need to assign 2 Audio tracks if playing back stereo samples. Sound Studio uses a more intelligent 
system!

To change the pan settings of an Audio sample, simply click on one of the Pan knobs in the mixer screen 
with the left mouse button and move the mouse up and down (vertical movement on screen). You’ll be 
able to see the Pan pot rotate from left to right. Again, you might notice some lag time between moving 
the pan pot and hearing the effect - this is down to the Buffer Size in the Audio System Settings menu.

Adding Reverb and Delay to your Audio Tracks

When a recording is made into Sound Studio - the result will be Dry. This means the sample has no other 
effects added to it to change the overall quality of the sound. Sound Studio has three very powerful digital 
effects which you may assign to each audio track or per sample. These digital effects will transform the 
audio to give you professional studio quality results. 

Digital Delay

The delay effect will do just that - it will delay the signal by a specified amount. You will therefore hear the 
original recording followed by a copy of the recording. 

The time it takes before the delay is determined by the Delay Value. A value of 1 will almost be 
instantaneous, whilst a value of 127 will cause a delay of 700ms. If the sample used is a 44.1kHz sample 
- the delay time will be 350ms. 



The level at which the delay will play back at is governed by the Effect Depth Value. (0 = OFF; 1 being 
very quiet and 127 being an exact copy of the original level). Be careful that your effect does not distort at 
very high values.

Let's try this: We will open an existing wave file and add some digital effects to it. 

Go to the file menu and click on New to open a new file. 

Now click on the audio window icon. This will insert an audio pattern on Audio track 1. You may select 
which wave file to play from within this Audio Window. Close the Audio window. You should see the audio 
pattern with the appropriate wave form in the main track window. Click on the vertical Zoom-In button to 
see more of the waveform.

Depth columns will be set to OFF. This will soon change!!

You need to first make sure the 'Audio FX Type', 'Reverb / Audio Delay' and 'Chorus / Audio Depth' 
columns are visible. If they are not showing, select them in the Select Track Columns dialogue box.

The Audio FX Type column determines what effect type is assigned to each channel. To change the 
Effect type, click with the left mouse button in this column so that the audio track is hilighted. Next click 
the right mouse button to flick through the various effect types. The first option is Delay. If you press play 
you will hear the sample being played exactly as it was recorded, i.e. dry. Even though we have set a 
delay type to the audio track, we have not yet specified any Delay Depth or Value. To do this, click and 
hold with the right mouse button in the Delay column and increase the value to about 70. Do the same in 
the Depth column. These values should be noticeable. Rewind the sample to the start and press play.

The sample will probably sound very messy as the delay kicks in. You can cure this by reducing the Delay 
depth value. If you try various values in the Delay column you might be able to find a delay that is in time 
with the original sample
The maximum value possible when using the delay is 700ms. This is equivalent to a value of 127 in the 
delay column.

If the wave is a 22050Hz wave you get 700ms, but if it is a 44100Hz wave you’ll get a maximum delay 
time of 350ms. If the Delay value is set to OFF - no effect will be heard.

Echo 

The Echo effect is very similar to the delay effect in that it replays the original sample a few milliseconds 
later. The only difference here is that the echo will repeatedly play the original sample until it dies away. 
The time between each echo is governed by the value set up in the Delay column. A value of 127 in the 
track column will give a longer gap between each echo whereas a value of 1 will almost be 
indistinguishable from the original sample.

The level of the echoes is determined by the number in the Delay Depth Value column. A low number 
corresponds to a low volume whereas a value of 127 would probably end up in distortion - but enough of 
all these technical facts and figures let’s hear the effect!

Load up a wave file. Change the effect type in the Audio FX Type column to Echo (see delay section if the 
Audio FX Type column is not visible). Increase the values in the Delay and depth (as above) columns to 
around 70 (just so we hear some effect).

Press play. Try changing the values to vary the amount of echo you hear. If the signal distorts, decrease 
the echo depth or alternatively decrease the overall level of the audio track either from the mixer screen 
or from the Vol. track column.



You’ll probably notice that the echo effect will stop when the play cursor reaches the end of the pattern. 
This is because the effect can only take place if there is audio data present. One solution to this is to have 
additional space at the end of the sample. Enough free space would be created if the stop button was 
pressed a few seconds after the end of a recording.

Reverb

Reverb can be used to make vocalists sound better, but also to instrumental sounds to give them a live 
feel. Reverb may be added to a sound to give the impression that it is played in a large stadium or, say, a 
small room 

The reverb is created using very complex mathematical equations and can be quite demanding on the 
PC’s processor - so over-using this feature might reduce the overall performance of the program (as with 
the other effects)

Setting up Reverb for an Audio channel is done the same way as you’d assign echo or delay to an Audio 
channel. Change the effect type to Reverb in the 'Audio FX Type' column (see delay section if the Audio 
FX Type column is not visible). Before the Reverb effect is audible we must set up the Delay Value and 
Depth (as above). Click and hold with the right mouse button in the Delay column until the value reaches 
about 70. Do the same in the Depth Column. 

The Depth determines how loud the effect will be. A value of 127 will most probably cause the sample to 
distort as the signal will continue get louder, so a value of 80 or so should be fine for most samples. If the 
sample was recorded at a lower level, you might have to increase the depth value in order to hear the 
results.

Using the Mixer Screen to alter the Delay, Echo and Reverb Levels

If you don’t like dealing with numbers / milliseconds etc. you can always use the friendly looking graphical 
mixer screen to change the effect levels. To do this, select the effect type from the Audio FX Type column 
in the main track window then open up the mixer screen (see delay section if the Audio FX Type column is 
not visible).

Click on the Audio Tab situated at the top (right) of the mixer screen. This will display 16 rows of Audio 
channels (four enabled). Each channel will have its own Volume slider, Mute / solo buttons, Pan Delay 
and Depth knobs and record button. 

To alter the effect values in the mixer screen, simply move your mouse to the Delay knob and click on the 
dial with your left mouse button. Move your mouse vertically up/down your mouse mat to 
increase/decrease the values. The knobs will rotate depending on the position of your mouse. Before you 
can hear the effect you must also turn the Depth knob otherwise the depth level will be set to zero!

There will probably be a slight lag between moving the knobs and hearing the effect. This is governed by 
the value set up in the Audio Menu / System Settings for the Buffer Size. A smaller buffer size will give a 
faster response to any changes you make. A larger buffer size is needed however to cope with more 
audio tracks, so the best advice is to find a happy medium between response time and number of audio 
tracks. On a very fast machine with a SCSI Drive you should have no problems getting all the Audio 
tracks with realtime effects working.

Altering the Parameters of an audio pattern

Up until now, to change the Audio parameters such as Volume or Reverb levels we have done it on a per 
channel basis. Sound Studio however allows you to alter the parameters of each audio pattern contained 
within a track. What does this actually mean ? This means you can effectively automate your whole song 
by assigning different volume/pan levels to each audio pattern. How would I do this? 



Here's an example:

To change the Audio parameters of a pattern, you must first open a wave file (or record one into one of 
the tracks). Once the pattern is displayed in the track window, click on it to highlite it. Go to the View menu 
and click on the Pattern Settings option. (Short cut key Shift + F10).

Changing the Volume level of an Audio Pattern. 

To change the Volume level of an Audio pattern, simply click the left mouse button in the Volume box. 
Type in the new value (use the delete key to erase current value). Click on OK. Play the song again and 
you’ll notice the volume of the Audio pattern has been changed. To make doubly sure you hear the effect, 
change the Volume level to a very high value such as 127. 

If the output distorts when playing numerous wave files, try reducing the volume level of the individual 
audio patterns until it stops distorting.

Changing Pan Levels of an Audio Pattern

To automate the Pan levels of your Audio track you can insert Pan values to each Audio pattern within an 
Audio track. This is done the same way as the Volume levels. (See above). The Pan values range from 
-64 (pan hard left) to 63 (pan hard right). If the Pan value is set to OFF the pattern will pick up the Pan 
event value in the Pan track column. Any value in the Pan section of the Audio Pattern settings will over-
ride the Pan value in the track column. A value of 0 will pan the Audio pattern centrally. 

Changing Delay, Echo and Reverb levels of an Audio pattern

When placing your audio patterns in an audio track you might decide to have a reverb effect assigned to 
one section and not to another. For this reason we have included the additional option of changing the 
reverb levels on a per pattern basis rather than on the whole track. This allows you to have a number of 
different wave files each assigned different reverb levels.

In order for the effect to take place you must have an effect type set up in the FX type column in the track 
window (see section on digital delay above). You can only have one effect type per Audio track but this 
does not stop you from having an echo effect on Audio track 1, reverb on Audio track 2 and Delay on 
track 3 for example.

The Audio parameters such as Pan, Volume, Reverb effects are all non-destructive edits which means 
they don’t affect the original sample in any way. Should you wish to add a permanent reverb effect to a 
sample you would have to perform a track bounce (see next section). The track bounce function would 
include all the Audio parameters within the selected region and generate a new wave file which you could 
save off with a new name.

Track Bouncing Audio

Sound Studio allows 4 tracks of digital audio to be played back simultaneously. When you have filled 
these in your arrangement but you still need more audio tracks, you can use the track bouncing function. 

Track bouncing works by combining the audio data on one or more tracks onto a new track. In this way 
you can bounce the audio on say, tracks 1 to 3 to a new pattern on track 4, thus freeing up another 3 
audio tracks to work with. Because all of this is done in the digital domain - there is no loss in quality. This 
effectively means you can bounce your tracks an infinite    amount of times without degrading the sound - 
Excellent! 

Track bouncing in Sound Studio works in two ways:- for the whole song or between the left and right 



locators. To access the track bouncing feature go to the Audio menu. When you move your mouse to the 
right of the Bounce Audio Tracks option you will get 2 options for the track bounce. Let’s try the first option 
of bouncing the audio tracks of the whole song.

We must first insert some wave files on at least 2 tracks. Do this as described at the start of this chapter. 
Place the patterns along the track as in this diagram. Now click on the Bounce Audio Tracks option and 
select the Whole Song function. You will see a progress report on the screen whilst the track bouncing is 
in operation. If the wave files are long, or are stereo 44100 Hertz samples, the track bouncing might take 
a long time due to the amount of digital data to be processed. 

The track bounce will create a new pattern on a new audio channel. This pattern will contain the audio 
data of all the patterns in the song. If you are bouncing down four audio tracks, the newly created track 
will be a virtual track. You will need to move this track to one of the top four track positions in order to hear 
the result of your track bounce.

If the audio patterns contained parameters such as reverb levels or pan values, this information will be 
included in the bounced pattern. These parameters will be embedded in the new pattern and therefore 
cannot be undone. This feature is very convenient when creating an audio pattern with a permanent 
reverb, delay or echo effect assigned to it. This new pattern may be saved off as a new wave file thus 
allowing you to delete the original patterns on the first few tracks.

When the Bounce between Locators option is selected, the bounce will only affect audio patterns which 
exist between the left and right locators. 

Handy Hint:

You can change the position of the left and right locators by clicking with the left and right mouse buttons 
respectively in the bar number display area of the track window.

Looping Audio Patterns

Similarly to MIDI tracks, you can also loop audio tracks. This is done in the same way as a MIDI track 
loop whereby the left and right locators represent the start and end points of the loop. If you notice 
glitches during the looping of audio patterns you should check the following:

· Are the left and right locators set exactly on the bar? Look at the left and right locator boxes on the 
transport bar to check the values are integer bar values.

· Is the BPM of the pattern the same as the Tempo on the transport bar? (This is only valid if you 
already know the BPM value of your Wave file.)

· If the Audio stutters, increase the buffer size in the Audio System Settings section of the Audio menu.

Recording in cycle/loop mode

Similarly to MIDI - you can record audio whilst in loop mode. This makes it convenient to rehearse your 
audio overdub whilst the MIDI accompaniment is looping around. Looping is done between the Left and 
right locators in the track window as long as the Cycle button is enabled on the transport bar.

When recording with loop mode enabled - the following conditions apply:
1. If recording starts at left locator and section loops a few times - a pattern of the last recorded loop will 
appear when stop is pressed 
2. If recording starts before    the left locator, if a complete cycle is recorded - the pattern starts where 
recording began and will end at the right locator.
3. If recording starts before  the left locator and two or more cycles are recorded - the pattern will fit the 
loop and the left and right locators are set to play the last    recorded cycle.



Punch In Record for Audio

As with MIDI recordings - you can set the left and right markers (or locators) at certain bar positions to 
trigger an automatic recording of audio. This is called Punch In and may be enabled by pressing the 
Punch-In button on the transport bar. 

"Punching In" is used to insert additional audio in the middle of a section where everything else is OK. 
Rather than recording the complete track again - you may choose a section to record into. The song will 
start playing when the play button is pressed - but as soon as the play position reaches the left marker - 
the current audio track record mode will become active and it will start in record mode until the play 
position reaches the right marker. When the play position reaches the right marker - the recording will 
stop and you will get a message on the screen asking if the recording was OK.

Snapping Audio Patterns 

To snap audio pattern together to ensure there are no gaps between them use the Nudge Left and 
Nudge Right (7 & 8) mouse tools from your mouse tool box.

Open a wave file and place them a bar apart. Click on the right mouse button to bring up the tool box. 
Move your cursor to the left pointing arrow. Click on the second audio pattern. This will snap the second 
pattern to the end of the first one. 

You will end up with something like this. This tool is very useful for snapping patterns together which are 
not the exact length of a bar or number of bars.

The right facing arrow in the tool box works in a similar way, only it would snap the first pattern to the start 
of the second one.

If you experience "clipping" when playing back multiple audio patterns - reduce the volume levels of each 
track/pattern until no clipping occurs. If you encounter stuttering effects when playing /recording audio - 
have a look at the trouble shooting section of this help text for possible solutions.

Return to Tutorials Page



Mouse Tools

Each editing window has its own tool box which is accessed by pressing the right mouse button.

To select a different mouse, hold down the right mouse button to bring up the Mouse Tool Selector. 
Move the mouse until the one you want is highlighted. Let go of the right mouse button - the selector 
disappears and the mouse cursor changes to the new shape.

Click on the appropriate tool for more info.

Track window Mouse Tools

Piano Roll Window Mouse Tools

Score Window Mouse Tools

Drum Window Mouse Tools

Conductor Window Mouse Tools





Q. The Audio stutters on playback - what can I do to avoid this?
A. There are many ways to avoid stuttering during the playback of audio tracks.

1. Reduce the number of audio patterns playing at any one time.
2. Reduce the Sample Playback Rate before recording.
3. Record in mono rather than stereo.
4. Defragment your hard disk by using the Defrag tool. (From the Start Menu select 'Run'. Type 
'DEFRAG' and press ENTER)
5. Turn off any screen savers.
6. Close down other applications.
7. Check that your Virtual memory setting is set to the recommended value i.e. 'Let Windows 95 
Manage Your Virtual Memory'.
8. Increase the value of the Buffer Size from the Audio System Settings option from the Audio menu in 
Sound Studio.



Q. I have my soundcard installed, but I cannot hear anything when playing a demo song in Sound 
Studio . What should I do?
A. Most of Evolution's technical support calls are soundcard related rather than software related. If you 
have a soundcard problem, before ringing your soundcard manufacturers' support lines spend some time 
reading the following checklist to make sure you have tried every possible solution 
to your problem.

1. Go to the "Options " menu in Sound Studio. Go to the    "Devices..." section. If no driver names appear 
in the Input /Output columns, you need to re-install your soundcard. The driver names in the devices 
screen allow you to tell Sound Studio which sounds you want the program to play. The input drivers will 
determine which MIDI IN port you are going to use. For normal usage, you would need only one input 
selected. For a    soundblaster card, the input driver would be called something like "SB16 MIDI IN". Other 
cards would have driver names such as "ESS MIDI IN ", Tahiti MIDI IN" or "SB Live! MIDI In [E800]". 
Older soundcards would rely on using the MIDI driver that comes with Windows. This driver is called the 
"MPU401". If you have the Roland MPU401 driver showing, then you should be able to select that for 
input and output.    If no MIDI IN drivers are showing, install the Microsoft MPU401 driver from the Add 
New Hardware section of the control panel.

Go into your control panel and go to the "Add New Hardware" section.    Click on Next. When it asks for 
automatic detection of hardware - click NO. Click on "Next". Scroll down to the "sound Video and games 
controllers section. Click on next. In the manufacturers section - go to "Microsoft". Click on the "MPU401 
compatible driver option on the right hand side. Click on Next. It will try to install the driver - but will 
probably ask for the Windows 95 CD-ROM. Follow the instructions and it should spring into life. Reboot 
your machine. Go into Sound Studio and select the MPU401 driver for input and output from the 
Options /Devices menu

The output driver column allows you to choose which sounds you are going to hear when playing your 
songs. Most soundcards will have an option such as "FM synth" or "OPL3 MIDI Synth". Click on these 
driver names to play the sounds of your soundcard. Most modern cards will have additional sounds. 
These driver names would be similar to "SBAWE32 MIDI Synth". Click on the driver name of your choice.

Rule of Thumb: If you have numerous output drivers enabled (highlited in blue) and cannot hear any 
output, deselect all but one of them and try again. Repeat this process until you hear some sound.

2. If using the MIDI mapper as your output port, you will have to check that your MIDI mapper is 
configured properly.    After double clicking on your MIDI Mapper, click on "Edit". Check that all output 
ports are displaying a driver name. If a MIDI OUT is showing the data will be sent to a) an external 
keyboard through the MIDI OUT cable or b) a wave table connected to your sound card.



Q. Why can't I see much of the pattern area of the track window?
A. We suggest you use a screen resolution of at least 800 x 600 to view all edit screens comfortably



Audio Input Monitor

Audio Input Monitor

The Audio Input Monitor option opens the Record window for Audio tracks. If the Audio Input Monitor is 
already open, clicking on this option will move the focus to the Audio record window. If no Audio tracks are 
present, this option will be greyed out.



Delete Outside Markers 

Delete Outside Markers 
After setting your left and right markers in the wave form display to specify the start and end points of 
your sample, you can choose to delete the unwanted bits to the left and right of the markers respectively. 
To do this, choose the Delete Outside Markers option. This will help free up valuable disk space.



Delete Between Markers
Delete Between Markers
This function will do the inverse of the above be deleting any audio data present between the left and 
right markers. This function is very useful for removing coughs or stutters for example from a recorded 
speech.



Distort

This function introduces a distortion effect to your sample which adds a rough edge to the sound - you’ll 
get a better idea of the effect by listening to it rather than reading about it.



Swap Left and Right

Swap Left and Right

This function only affects stereo samples    - and it does basically what it says. It swaps the right hand 
signal with the left hand signal.



Normalize

Normalize

This function will probably be the most used and the most useful editing tool of all. If a recording is 
normalized - the program scans the waveform for the highest signal and then increases the overall level 
of the sample to its maximum possible level without distorting.
Use the Normalize function if your recording was too quiet and you wish to amplify it without using the 
volume sliders in the mixer screen.
Normalizing will work between the locators only. If the start and end points are 0 and 999999 respectively 
then Normalize will affect the whole sample. If you only wish to normalize a certain range within the 
complete sample you can set your markers in the appropriate positions and then perform the normalize.



Load Video...

The Load Video option opens up a dialog box which asks you to specify a file name for a .AVI file. These 
AVI Video images may be played back in sync with your Music. When an AVI file is loaded, it will start 
playing as soon as the play button is pressed on the transport bar. 
Once an AVI is loaded it will play even if a new song is opened. 



Unload Video...

Handy Hint!
There must be some MIDI or Audio patterns present in the track window in order for the AVI to play back. 
If no patterns are present, use the pencil tool to quickly draw in an empty pattern on one of the tracks.

If you do not wish to associate your song to the AVI you have loaded, simply click on the Unload Video 
option and this will disable the AVI. Don’t worry about using this function - unloading the video will not    
delete the AVI from your hard disk!!

The AVI window will automatically mute any existing audio embedded in the AVI. You may resize the 
screen but please note that the larger the screen - the poorer the quality.



Large Time Display

When this option is chosen, a time display will appear in its own window on your screen. The Window 
uses a True Type font which allows you to resize this window to suit your needs. The Time display shows 
units of hours, minutes, seconds and frames and is a very convenient visual reference when syncing to 
an external device such as a Video tape recorder

Back to Window menu



Delete...

The delete option allows you to remove any file type associated with Sound Studio from your hard disk or 
floppy. 
This is convenient when deleting large unused wave files. Simply locate the directory path and filename 
of your file and click on OK to delete.

Note: The deleted files will not be moved to the recycle bin - so be careful which files you delete!

Back to File menu



Print

The Print function can print anything which can be displayed on the score screen. The score screen must 
be open otherwise the print options will be greyed out in the file menu.    All settings in the Score Settings 
Dialog apply to printer output. Printing also obeys the settings in the Print Dialog - which pages to print, 
how many copies and whether copies are collated.

Printing can be aborted while the page is being sent to the printer. Press the Abort button to abort printing.

Back to File menu



Printer Setup

Click on this option to configure your printer to print scores from Sound Studio. 

Back to File menu



Audio Window

1. File Open section. Click here to import a wave file into the audio window.
2. Information Line - Contains information such as the Start and End points of the sample; the file size (in 
Kb), the sample duration, mono or stereo and sample resolution.
3. Unplayable region.
4. Defined range. The waveform with the white background will be played in the track window when Audio 
window is closed. Use the left and right mouse buttons in this area to set the start and end points of the 
sample.
5. Unplayable region. This shaded area is dependent on the value in the End box. 

Buttons

Close the window.

Restore the pattern's original contents.

 Brings up the Open File window for you to select a Wave file to import.

Shows the start and end points of currently selected range. Use the left and right mouse buttons to set 
start and end points respectively
 in the waveform display area.    See the Adjusting Values page for more information.

Each value in the Start and End boxes may be clicked on to increase/decrease the number for fine 
editing of the start and end points of the sample. 
If the mouse is clicked on the last digit, the number changes in steps of 1. If it is clicked on the 
penultimate digit it changes in steps of 10, and so on. The usual shift key / opposite mouse button works 
to change the numbers in 10 times larger steps.

When the window is closed, the pattern in the track window will be updates with the new range selected 
in the Audio window. If no range is selected, the pattern will be the same length as the complete sample.
If the sample plays back at the wrong speed - change the value of the sample playback rate in the audio 
system settings.

If an edit is performed on the waveform such as normalize or distortion, when the window is closed it will 
ask you if you want to save the changes to the wave file. If you answer "yes" - the .WAV file will be edited 
permanently. If you click on "No" - no changes will be made to the sample when you close the window.

If you close the window after altering the start and end points - the new pattern length in the track window 
will reflect these changes. The wave file will not be affected in any way by these markers - the program 



simply refers to the wave file    by its start and end markers)..

See also The Audio Window Tutorial



Pattern Settings

This option (Shift + F10) is very useful for altering parameters on a pattern basis rather than to a whole 
track.
The pattern settings window contains information relating to the program number, bank, channel, volume, 
pan, reverb, chorus, velocity, transpose and time values. You may edit any of these settings so that each 
MIDI Pattern has its own set of levels. Any value in the pattern settings will override values in the track 
columns in the track window. 
It is in the Pattern Settings window that you assign each MIDI pattern a new name if you so wish.

The Pattern Settings window is a very useful and powerful musical editing tool and must not be 
disregarded. 

An Audio pattern will also have its own pattern settings, but will only contain information on pattern name; 
volume, Pan, Effect delay, Effect depth and Time offset.

The Pattern settings window does not have a graphical icon on the editor strip - so for quick access use 
the Short Cut key "Shift + F10"). If you would rather make more use of the pattern settings - you can 
configure the preferences menu so that a double click on a MIDI or Audio pattern opens up the pattern 
settings rather than one of the other editors.

Back to View Menu



Track Settings
This option (Shift + F9) is very useful for altering the parameters for a track such as the overall Volume 
level or reverb level. Any subsequent volume events in a pattern would over-ride this initial track level.

When importing a standard MIDI file into Sound Studio - some MIDI information such as the program 
changes and initial volume levels will be stored in the track settings and may be viewed by selecting the 
appropriate column in the Select track columns option. All these values are editable by using the left and 
right mosue buttons to click and hold to increase/decrease the values.

As the track columns take up a lot of space on the main track window - use the Short Cut keys "Shift + 
F9"    to view all track parameters. 
The currently highlited track (in grey) will be viewed in the track settings window. If an Audio track is 
highlited - the track settings for the audio track will be displayed. The Audio track settings allows you to 
edit the Track name, initial volume, pan, FX delay, FX Depth, FX type and Time offset. 

Back to View Menu



Between Locators

When track bouncing between locators - the left and right locators govern which samples are contained in 
the bounce. Any audio patterns or part of a    pattern outside of the locators will not be included in the 
bounce.
The track bouncing function will create a new wave file on    new audio track. This new track will have a 
"Bounced" in the track name column to indicate the pattern is a result of a track bounce.



Whole Song

When this option is selected - all audio patterns in your song will be included in the track bounce 
regardless of where the left and right markers are.

The result of the bounce sounds the same as if you had played the original audio, so it excludes muted 
tracks / patterns and includes all Volume, Pan and Effects (Reverb/Echo) settings and any Time offsets in 
tracks or patterns.
This is a convenient way of creating a wave file with a permanent reverb/effect assigned to it.



Bounce Audio Tracks

Between Locators

Whole Song

Bounce Audio Tracks is a powerful tool that allows you to combine audio patterns across 
numerous tracks down to one final wave file.

The Track Bounce function creates a new WAV file which is displayed in a new track and pattern. The 
result of the bounce sounds the same as if you had played the original audio, so it excludes muted 
tracks / patterns and includes all Volume, Pan and Effects (Reverb/Echo)    settings and any Time offsets 
in tracks or patterns.

Track Bouncing will work on the whole song , i.e. all wave files in the current song, OR it can bounce 
only those audio patterns present between the Left and Right locators. The progress bar operates during 
this function to let you know it’s actually working on the track bouncing and not just sitting there doing 
nothing!!.

Track bouncing is very useful for creating a mix down of your Audio song as one .WAV file which you can 
then play back from any audio player such as Windows’ Media Player. 

Please note: Track bouncing only affects Audio patterns and will ignore any MIDI patterns it comes across 
on the tracks. An analogous process for MIDI patterns may be found in the Functions menu from the main 
track window and is called Merge Patterns



Instant Chord Track

The Instant Chord Track button (or ICT) is an excellent way to create a    song with the least amount of 
effort.
The "create chord track" button will generate a musical chord sequence in the chord track. The    length of 
the sequence depends on the duration slider. Each style has three different chord sequences and various 
loop lengths. Experiment with different durations by moving the time / bars slider and also try out the 
different chord sequences.

The Instant Chord Track window not only creates a chord track for you - but it will even convert this music 
into standard MIDI file format which means you can view and edit the style in any of the editor windows.

Please Note: It's recommended that the ICT feature be used when in the main track window. This 
makes it easier to see the chord track being generated in the pattern display area.

Style This box contains all 20 preset styles ranging from 'Rck&Roll' to 'March'. Click on the "down 
arrow" to the right of the style name to see all the styles.

Chord Sequence This control allows you to select which of the available chord sequences you 
would like to use to create your chord track. Click on the "down arrow" to the right of the number '1' to 
choose a different sequence. There are three sequences for each style numbered 1, 2 and 3. 

Duration This section contains a horizontal slider which determines the length of the chord track. 
By moving the slider left to right    you may see the bar numbers increasing along with the track duration. 

Replace Current Track When this option is off, the chord sequence will be added to the end of the 
current chord track.



Loop When this option is enabled,    the left and right locators are placed at the start and end of the 
newly created chords, and the Cycle switch is turned on. This ensures seamless looping of the whole 
track.

Create Chord Track Click on this button to generate the instant chord track.

Convert to MIDI Track This will convert the chord track into MIDI information. By default it will generate 
a file in format 0 - this means all the information will be on one channel. When converting the chords to 
MIDI you will get a message on the screen asking "Do you want to extract to multiple tracks?". If you click 
on "yes" - it will convert the MIDI data to the appropriate channels so that the drums appear on channel 
10, and the accompaniments on channels 11 to 15.

Please Note: When the chord track is converted to MIDI tracks, the original chord track will be muted to 
avoid any doubling of notes.

Close This closes the ICT window.

Handy Hint:
You can create a song made up of different styles by staying in the ICT window and converting styles to 
MIDI tracks as you go along. Try this method:-

Choose your style. Create chord track. Convert to MIDI track. Change style. Disable "Replace current 
track" option. Create chord track. Convert to MIDI track. Change style ....etc....

This way you can create a medley of styles, and see the music on the screen in an editable format. 
Simply cut and paste the patterns in the desired order to construct your song.
By choosing the "select all" option from the edit menu and then clicking on the score editor button (F5) 
you can view/edit the complete song across multiple staves as a full score! You can then print it out!!



Audio Menu
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Audio Preferences
Audio Input Monitor
Wave Files in Use...
Bounce Audio Tracks
Delete Outside Markers
Delete Between Markers
Distort 
Swap Left and Right
Normalize

Back to Contents



Audio System Settings

TheAudio System Settings dialog box is used to configure various digital audio settings and has three 
sections:

Sampling Frequency

This section has three options. The units are in Hertz which is the unit for frequency. If you are not sure 
what frequency means in this context, just remember the following guidelines:

44100 Hz Higher quality recording / More hard disk space required
22050 Hz Medium quality recording / requires only half the disk space of a 44100 recording.
11025 Hz Lower quality recording / Requires a quarter    of the disk space of a 44100 recording

Playback
Sound Studio can only play back samples of the same sampling frequency within a song. If for example a 
.WAV file of sampling frequency 22050 is played in the same song as a .WAV file of 44100 Hertz (Hz) and 
the sampling frequency is set to 44100, then the sample at 22050 Hertz will be played back at twice its 
normal speed and will sound strange. The inverse would happen if the sampling frequency was set to 
22050. The sample at 44100 Hertz would play back at half its normal speed. For these reasons, select 
your sample rate at

Recording
The Sampling Frequency option also determines the frequency at which an audio recording is made. 
For high quality recordings select the 44100 option.

Handy Hint!!
Please note    - you’ll achieve more audio tracks by sampling at a lower Sampling Frequency.

Anti- Clipping
The Anti-Clipping button is very handy for eliminating awkward clipping or distortion effects from your 
songs. If 2 or more audio tracks are played back simultaneously, it’s quite possible that the output will 
distort if the volume levels are quite high. The Anti-clipping function works by reducing the volume level of 
each audio track by a certain amount so as to avoid any digital clipping noises. 

The Buffer Size combobox lets you set the amount of RAM your PC uses to buffer the Audio data. In 
general, the slower your PC, the larger the buffer you will need. If you hear gaps during playback of 
a .WAV file, try increasing the buffer size.

Any Audio track which has effects such as reverb or echo assigned to it needs a buffer size of at least 
64K. The size of the audio buffer determines the lag time between changing a setting and hearing the 
effect. The greater the value - the longer the lag.



Wave Files in Use

Wave Files in Use

The Wave Files in Use window will display the file names and directory paths of every wave file used in 
the current song. If a wave file is removed from a song it will no longer show up in this window.



Audio Preferences

Audio Preferences 

Show Names in Patterns displays the name of the audio files in the patterns in the main track window. 

Draw Waves in Patterns draws a representation of the waveform in the audio pattern in the track 
window. 

Show Record Window will display the VU meters when an Audio recording is made. These meters will 
display as red bars if the incoming signal is too loud and is likely to distort. If the flashing bars are green - 
the audio signal is OK. 

Play Audio Tracks while Recording will allow you to listen to existing audio tracks as you overdub with 
another audio track. This feature will only work with soundcard that are fully duplex in operation. (Check 
the trouble shooting section)

Use Undo Files when editing WAVs Undo will only undo the last Audio edit made rather than restoring 
to the original waveform. Again, the Undo option must make a temporary wave file which will use up hard 
disk space. By default the Use Undo Files option is ON

Warn Before Glueing Audio Patterns will display a warning message whenever two audio patterns are 
about to be glued together. This process entails having to copy the audio data of two patterns and 
creating one new wave file. If the two wave files are large, this process might take a long time and might 
end up creating a very large wave file. If there’s a blank region between the two patterns where nothing is 
playing, the resultant wave file will have the same blank space, but will have the same amount of audio 
data as if there was some audio present. This again could create a very large .WAV    file on your hard 
disk. 

Unless absolutely    essential - do not glue Audio patterns together as it may eat up unnecessary hard disk 
space. 

Display Audio Meters in Mixer. 
On some slower machines, having the VU meters flashing in the mixer screen might cause timing 
problems due to the increased demand on the processor. For this reason you can turn off the VU meters 
from the mixer screen. The MIDI VU meters will be unaffected by this switch.



The Anti-Clipping button is very handy for eliminating awkward clipping or distortion effects from your 
songs. If 2 or more audio tracks are played back simultaneously, it’s quite possible that the output will 
distort if the volume levels are quite high. The Anti-clipping function works by reducing the volume level of 
each audio track by a certain amount so as to avoid any digital clipping noises.
This feature has been improved so that no volume reduction will take place if audio patterns on different 
tracks do not overlap each other. The program determines if 2 or more patterns are played simultaneously 
- if so - the anti-clipping feature will operate. This ensures a far better signal to noise ratio when patterns 
are scattered across a number of tracks.



Show Video...

Use this option to bring the AVI window to the front. If the AVI window is closed, this option will re-open it.



XG Support

- Full voice listings. 
- How to change voices using new patch screen layout.
- Event Window has XG controllers listed by name.(controllers 71-74)
- XG sysex commands easily accessed from the event window.
- Mixer screen can have XG controllers assigned to the knobs - making it easy to tweak the sounds.
- Sysex THRU 

XG is a new MIDI standard developed by Yamaha which gives much more editing control over your MIDI 
sequences. It is basically an extension of the GM (General MIDI) standard which has been very succesful 
over the past few years. Whereas the GM standard has support for 128 voices - XG makes use of Bank 
Select messages to access literally hundreds of extra sounds. 

All these sounds are fully editable allowing you to change certain characteristics of the sound such as 
darkening or lightening voices, delaying or accelerating voice start up and all kins of other manipulations 
to the sound. And of course you can do all of this using Sound Studio.

GM had reverb and chorus effects but MIDI had no standard means for controlling the type of reverb used 
or the reverb time. The XG format gives much more control over effect types and depths and allows you 
to come up with some amazing digital effects

Setting up Sound Studio for XG. 
Go to the Options menu and click on the XG button next to your MIDI OUT driver. When you click on OK, 
the program will ask you if you want to see the patch list for the XG mode. Click on OK. Then load a .MID 
designed for XG and the program decodes the bank messages into XG modes which it stores    with each 
track - you will see the Patch column shows XG names. The program also recognizes the XG reset 
message and sends it before the set up data, ensuring the program changes, bank messages etc are 
correctly set up.

- TG300B sounds may be accessed by sending a GS reset command. Simply select GS mode from the 
Options /Devices menu then press the "Home" key on your QWERTY keyboard.

- XG or any other patch list may be edited in any text editor to include additional banks of sounds.

Back to Contents



XG Features

XG Voice lists
XG Normal Voices 
XG Drum Kits
TG300B Voices

To enter XG mode - go to the Options menu and in the Devices menu click on the XG radio button next to 
your Output driver. In most cases you would need to select your MIDI OUT driver to access the sounds on 
your XG sound module.
Click on the sections below for more info on the XG voice selection procedure.

Prog Column
XG Patch column
Bank Column
Name Column
XG SFX voice
XG Drum kit

XG Patch screen
When you click on a voice name in the patch column (double click if voice not currently highlghited)- it will 
open up the patch list screen (see below). If in XG mode it should display "XG Normal Voices" in the 
Current Instrument section. This ensures all correct voice names will appear in the patch screen. If 
another patch name appears here - click on the down arrow next to the Current Instrument box - and 
select the XG Normal Voices patch from the list.

Click on each section of the diagram below for help on each topic.



Current Instrument
Add/Remove
Patch Display Area
Bank Values

Back to XG page



file name



Changing the program number in the Prog column will update the voice name in the Patch column. 
Changing the bank value in the bank column will also change the patch name as long as a variation 
sound exists in that bank.
Clicking on any voice name in the patch column will call up the patch list screen. In here you can 
graphically select another voice name (rather than using numbers).
The voice names in the patch screen will have the words "XG" then the XG bank name in brackets 
followed by the XG voice name.



If the voice name has XG followed by "SFX" - then the voice name - it means the voice is from the SFX 
bank of XG sounds. 
Clicking on this voice name in the patch column will call up the XG SFX bank of sounds. This is an easy 
graphical way of changing sounds.



The drum kit type may be changed by clicking on the drum kit name in the patch screen and opening up 
the patch list screen. In the patch screen you can choose from any of the other numerous XG drum kits.



The Bank column allows you to quickly flick through the various XG sounds. Using the right and left 
mouse buttons you can increase/decrease the bank values from 0 to 127. If an XG variation sounds 
exists in a bank- the name will appear in the patch column. If no variation sound exists when selecting a 
different bank value- it will display the default GM sound name (bank 0).



The Name column displays the name of each MIDI track. If the MIDI file was extracted from a format 0 file 
(all on channel 0) into a format 1 file (on 16 channels) - the name of the original track will be displayed 
across all extracted channels.



These columns will remain the same as in GM or GS mode- The only difference being that XG allows you 
to have drum kits on numerous MIDI channels not just on channel 10 as is defined in the GM standard. 
See the section on Routings for more info about this.



List of available patches stored in the program's memory. To change to a different patch list - click on the 
down arrow and select a new patch list. If your patch list is not present in memory - you must remove a 
patch (an unused one) and locate your patch list (.PLS file) on your machine.



Click on these buttons to add or remove a patch list to or from the program's memory.



Displays the current Intrumeny name



Displays the Instrument name prefix and in the case of XG displays the current bank name.



Displays the current patch selected from the list. This is updated when another voice is highlighted.



Displays the current program number. By default it will start from 0 and go up to 127 but you may change 
this in the preferences menu so that it goes from 1 to 128 which is the same numbering system used by 
the XG standard.



Displays the variation names for each bank of XG sounds. If no sounds are present in a certain bank - a 
minus sign will appear in the patch list to indicate no variation sound.



Use the scroll bar to access other half of patch list voices.



The bank box displays the current Bank value for each channel. You may increase or decrease the bank 
values by using the up and down arrows next to the box. As the bank values are changed you will see the 
voice list update its sounds. If no sounds at all are present in a bank - the patch names will all appear as 
a "-".
You can also type in your own values in the bank box. When the OK button is pressed - that bank will be 
selected and the correct voices will appear in the track window.



Changing the bank type here will update the patch screen with the correct patch list. Loading in an XG 
MIDI file should enable the XG bank type button.



Deselects a voice from that channel



Use the Routings box to assign various patches to different channels. This is also the place to set up 
multiple drum kits on various MIDI channels.



XG has special banks of sounds which you can access directly by pressing the appropriate button here 
on the patch list screen.
Pressing the XG SFX button for example will call up the SFX bank of sounds.
If you get piano sounds coming from channel 10 when you expect to get drums - click on the XG Drum Kit 
button.

If you select XG SFX Kit or XG Drum Kit the drum flag is set, so if you go into the Routings dialog the 
drum switch for that port/channel is on, and the drum editor can be opened for patterns on the related 
track.



Disregard any changes you have made and return to previous screen



Accept any changes you have made to the current screen



Video Menu
Sound Studio is a true Multimedia program which integrates MIDI, Audio and Video for Windows files in 
an all-in-one PC Studio environment. 

Load Video
Show Video
Unload Video

Back to Contents



The Prog column displays program numbers from 0 to 127 (or 1 to 128). Changing to program numbers 
using the left and right mouse buttons will update the patch column with the appropriate voice name. The 
Prog column will also be updated whenever a voice is changed from the patch list screen or if a bank 
value accesses a    variation sound.



GS is a standard developed by Roland to allow for more sounds accessed by using bank select 
messages.
The Capital Buttons are enabled when in GS mode. 
When each of the capital buttons are pressed - the correct bank values will be displayed in the bank 
column for easy access 



Sysex THRU

Sound Studio allows for sysex messages to be "echoed" THRU the software from another application 
such as "XG-Edit". Using a multiple MPU driver will then allow you to have both programs running 
simultaneously - and tweaking knobs and sliders in one will be audible in the other.

To record the sysex events you must first enable a track for recording - then press the record button on 
the transport bar. Incoming sysex messages will be displayed in the event editor window once the 
recording has ended. A red bar will flash in the "MIDI" track column when incoming sysex is detected. - 
This is a good test to determine if the sysex is being received by the system.
If sysex messages are not recorded - check the Settings/MIDI menu incase the sysex filter is enabled.



Evolution Product Range

Evolution is the premier manufacturer of MIDI and Audio products for the PC

Evolution offers a wide range of hardware and software with the emphasis on affordable music products 
for the novice and professional PC Musician alike. Expand your musical horizons with the exciting range 
of Evolution products, all designed with ease of use in mind.

Evolution products are recommended by the top magazines...

 

 

 

 

 



 

 

Upgrading your software - The Evolution Upgrade Path

You can upgrade Sound Studio to one of Evolution's exciting new products by clicking on the web help 
button here. This will take you to straight to the Evolution Upgrade Shop. It's the quickest way to find 
special offers on the latest Evolution products. 

Browse Evolution's Product Range

For more information on any of our products, visit our web site, or e-mail us here at Evolution: 
info@evolution.co.uk 

Ordering Online

You can order direct and online by clicking on the web help button here or by visiting    
www.evolution.co.uk/shopping, alternatively send an email to sales@evolution.co.uk 



We accept all major credit cards and can deliver worldwide. 

Further Information by Post

If you do not have access to the internet you can call us or write to us at:

Evolution Electronics
8 Church Square,
Leighton Buzzard,
Bedfordshire,
LU7 7AE.
United Kingdom

Tel: 01525 - 372621
Fax: 01525 - 383228

International:
Tel: +44 1525 372621
Fax: +44 1525 383228

Back to Contents



Q I've been working with the program for a bit now and I'm afraid I might have upset some of the 
settings. Is there a way in which I can get back to the beginning again, as if I'd just installed it?
A. There are two files called DEFAULT.DEF and DEFAULT.WND that reside in the program directory. If 
you delete both these files, the program will return to its 'Factory Default Settings' as if it had just been 
installed. This is often a very useful way of making sure that a problem has not accidentally been caused 
by a setting in the program.

N.B. You must close the program before deleting these files.
(otherwise the program will write these files again on exit)

The very easiest way to locate these files is to do the following:

1) Close Evolution Sound Studio
2) Right-click 'My Computer' on the desktop

(a menu should appear)
3) Left-click find files
4) In the 'Named' box type 

DEFAULT.DEF;DEFAULT.WND
(take note of the files in the 'Sound Studio' directory)

5) Single left click on the first of the files (DEFAULT.DEF) and press delete on the keyboard
6) Repeat for the second of the files (DEFAULT.WND)

Sound Studio will now be reset. Run the program in the usual way. 

Remember that doing this will also reset your Options-Devices settings for MIDI Inputs and Outputs. You 
will most probably need to change these when running the program for the first time after deleting the 
DEFAULT.* files.



Save Song

This is a quick way of saving the Song you are working on. The File Dialog is not displayed - the filename 
of the current song is used so you don't need to tell the program again.

If you try to use this to save an untitled song, the File Dialog will be displayed, but only the .SNG file type 
will be allowed.

Back to File menu



Revert to Saved

This option re-loads the file you are currently working on, abandoning all changes you have made since 
the last save.

Back to File menu



Transpose...

Allows you to change the pitch of one or more notes. It displays a Dialog where you set the number of 
Semitones, whether the notes will be transposed Up or Down, and the Scope of the change.

Back to Procedures Menu



Cascade Windows

Overlaps all open windows but does not disturb the Transport, Editors or Fast Menu Windows.

Back to Window menu



Copy

Copies the selected items to the Clipboard.

See also:
Cut, Paste.

Back to Edit menu



Cut

Copies the selected items to the Clipboard and removes them from the song.

See also:
Copy, Paste.

Back to Edit menu



Hide Editors

Hides the Editors Window. When the Editors Window is hidden, it changes to Show Editors.

Back to Window menu



Hide Fast Menu

Hides the Fast Menu Window. When the Fast Menu Window is hidden, it changes to Show Fast Menu.

Back to Window menu



Hide Transport

Hides the Transport Window. When the Transport Window is hidden, it changes to Show Transport.
Short Cut key Ctrl + F7

Back to Window menu



Menus

click above for help on menus

More help on Mouse Tools

Extra help: You can access help on any of the menu items from within the program by first selecting the 
menu item and then pressing F1.



Move Events...

Allows you to change the start positions of one or more events. It displays a Dialog where you set the 
number of ticks by which the events will be changed (either Forward or Back).

Back to Procedures Menu



Paste

Moves the data from the Clipboard to the song. The new items become the selected ones, which makes it 
easy to move them elsewhere if required.

See also:
Copy, Cut.

Back to Edit menu



Redo

Reverses the effect of Undo. For example, - if a note is deleted, clicking on Undo will make it re-appear. 
Cllicking on Redo will delete it once more.

Back to Edit menu



Tile Windows

Places all open windows side by side but does not disturb the Transport, Editors or Fast Menu Windows.

Back to Window menu



Undo

Reverses the effect of the last editing operation. For example, if you just used the Transpose function 
(called from any window), Undo will restore the notes to their original pitches.

See also:
Redo.

Back to Edit menu



Change Velocity...

Allows you to change the velocity of one or more notes. It displays a Dialog where you set the Amount by 
which the notes will be changed, and the Scope of the change. You can change velocities Up or Down or 
set all velocities to a Fixed amount. Use the Maximum and Minimum settings to limit the change in 
velocity.

Back to Procedures Menu



Q. I can't seem to delete the chord or melody track. How do I do it?
A. The chord track and melody track are always present when the Virtual Keyboard is switched on. If 
you use the delete track or delete all tracks functions, the chord and melody tracks will be re-created. To 
get rid of these tracks, switch the keyboard off and then delete the tracks in the usual way.



Nudge Left
7. The Nudge Left tool is used in the track window to arrange patterns. If it is clicked on a pattern it will 
shuffle the pattern to the left so that the beginning of the pattern joins up with the end of the previous 
pattern. It will have no effect if there is no gap between the two patterns or the pattern is the first on the 
track.



Nudge Right
8. The Nudge Right tool is used in the track window to arrange patterns. If it is clicked on a pattern it will 
shuffle the pattern to the right so that the end of the pattern joins up with the beginning of the next pattern. 
It will have no effect if there is no gap between the two patterns or if the pattern is the last on the track.



About Sound Studio...

Displays a Dialog with brief details about the program including how many Kilobytes of free memory are 
available in the system and the version number.



Sound Studio Tutorials

Step by step help on all the features of Sound Studio.

The Arranging Tutorial
The Drum Editor Tutorial
The Piano Roll Editor Tutorial
The Event Editor Tutorial
The Score and Lyrics Editors Tutorial
The Conductor Tutorial
The Mixer Tutorial
The Recording Tutorial
The Audio Tutorial 
The Chord Track Tutorial
The Fast Menu Tutorial

See also:- More Recording Examples, Mouse Tools



Chords and Melody Recorder

You can record what you play and play it back using these controls. Click on the rec / play buttons 

 and they will change from 'off' to 'rec' (record) or 'play' (playback). Initially they will both be 
off.

These two buttons are linked with black lines to two indicators showing 'chord'  and 'melody' 

. When you change the 'rec' / 'play' buttons by clicking on them, these indicators will change 
too. A red LED will show to indicate record mode and a green LED will show to indicate playback mode.

Possible Combinations

chord-rec melody-off Record chords. Do not playback or record melody.
chord-play melody-rec Record melody by playing along with previously recorded chords.
chord-play melody-play Listen to the finished tune! Playback both chords and melody.

chord-off melody-rec Record melody on its own. Do not playback chords.
chord-rec melody-rec Record chords and melody at the same time.
----etc.

These controls link to tracks in the sequencer so that the chords are recorded on the chord track and the 
melody is recorded on the first available empty midi track (one is created if there are none available). 

As you change the state of the chord and melody record / play buttons you will see the mute and rec 
buttons in the track window switch on and off for the top two tracks (Chords and Melody). If you click on 
these buttons the buttons on the keyboard will also change.



LCD Display Window

This is where the currently selected voice group and style are displayed. 
As you play the keyboard the chord name and type are also displayed in this window. 

Changing Voice

You can change the currently selected voice by clicking on one of the voice names in the LCD display 
window. To view more voices, move the mouse pointer over the voice select buttons. As you move the 
mouse the voice list will change in the LCD display. Click on one of the buttons to fix the voice list or 
group and click on one of the names in the display to change the selected voice.



Mode Button

Each time this button is pressed the keyboard chord play mode will change. There are four modes:

SFC or Single Finger Chord Mode

In this mode the program plays the accompaniment in the key of the note that you press in the lower part 
of the keyboard (up to the split point). You can press combinations of notes to get 4 different chord types: 

    Single note = major
    Note + any black note below = minor
    Note + any white note below = major dom 7th
    Note + any white note and any black note below = minor dom 7th

This is the same format as used on Yamaha home keyboards.

Piano Mode

In this mode the program will follow the chords you play with your left hand regardless of where you play 
on the keyboard. The accompaniment will play in the key that you play in!!

Fingered Chord Mode

When this mode is selected the program will play the accompaniment based on the chord that you play in 
the lower part of the keyboard. The chord name and type is shown in the LCD display.

Off

If the fingered LED is lit and you press the mode button once more, the keyboard chord play will switch 
off. In this mode the keyboard will still flash the notes as you play and you can still use the automatic 
drums but there will be no chord play. 



Normal and Playrite

    Normal play mode allows you to play the right hand freely on the keyboard above the split 
point.

    Playrite mode changes the notes that you play so that you can not play a wrong note!! This 
only works while a style is playing (to start a style click the start 

 button). It plays notes based on the chord recognised. This is shown in the LCD display. 

Note: The playrite feature will not work in piano mode.



On Button

    This switches the Virtual Keyboard on and off!



Split Point

The split point is the point at which the keyboard changes from left hand chords to right hand melody.

  

The notes under the blue part of the line control the style play and are used for changing chords. The 
notes under the pink part of the line play in a normal way and are used to play along with the style. You 
can play in this area to record a melody track.

The split point can be changed by clicking elsewhere on the thin blue / pink line. Just click at the point 
where you want the new split point to be and the display will then update to show this.

Use this facility to make more room for playing fingered chords with the left hand, for example, or to make 
more room for playing in playrite mode with the right hand.



Start Button

Press this button  to start the style playing. The button will change to say 'stop'. Press again to 
stop the style playing. 

Before hitting a key below the split point or when keyboard chord play mode is set to off, only the drums 
of the selected style will play.



Style Select Buttons

As your mouse pointer moves over each button the name of the style will be shown in the LCD display. To 
choose a style, press one of the buttons.



Style Volume

Use this to balance the volume level of style against the melody or other tracks in your recording
 



Sustain Mode

Sustain mode  lengthens the notes played in the top part of the keyboard above the split point. 
It adds a sustaining effect to the sound. It is particularly effective when used with playrite mode and a 
sound like, for example, harp. It allows you to strum the keyboard as you would a real harp.



Syncro Start

When this button is pressed  the program will start playing as soon as you press a key on your 
external keyboard below the split point or click with the mouse on the VK-61 below the split point. 

If you have this button and the intro button selected, the program will start with the intro section as soon 
as you press a key.

What you hear when pressing a key is dependent on the variation buttons and also on the chord mode 
selector. Also, if the sequencer controls are set to play for the chord track, the sequencer will play when 
you press a key.



Tempo Control

Use the  buttons to increase / decrease the tempo or

Click on the tempo figure  with the right mouse button to increase or the left mouse button to 
decrease the tempo.

Click both buttons together to make the value change quicker.



Style Section Buttons

Each style has an intro, an outro, 2 fills and 2 variations. These can be selected using these buttons

When you next hit a key in the lower part of the keyboard below the split point, the style will start playing 
from the intro and then go automatically to variation 1. Just start playing along! 

You can change directly between variations by clicking on the LEDs  or you can use the fills:

Click on  to get a drum fill and change of style then 

 LED will light and variation 2 will play. To go back to variation 1 click on 

 and you will hear a drum fill and musical change followed by variation 1 again.

If the style is playing and you click on intro or outro or one of the variation LEDs, the program will cue the 
section to change at the end of the current bar. If you click on one of the fill buttons, the fill will start 
immediately based on the current position within the bar.

Keyboard Shortcuts

You can use the following keys on the keyboard instead of clicking with the mouse.

1 - Intro
2 - Variation 1
3 - Variation 2
6 - Fill 1
7 - Fill 2
0 - Outro



Voice Select Buttons

As your mouse pointer moves over each button the name of the voices available in each voice group will 
be shown in the LCD display. Click on a button to select a voice group. The last selected voice from that 
group will be selected and shown as highlighted in the LCD display. To change a voice, click on a voice 
name displayed in the LCD display window.



ON-LINE REGISTRATION

If you see a dialogue box like this when you run the program, you have the shareware version of Sound 
Studio, which will lock up after 30 days or 180 uses. You can buy a registration code at anytime direct 
from our Web site which will turn your shareware version into the full version. Go to... 

www.evolution.co.uk/registration

If you need further information, email us at info@evolution.co.uk





Web Music

Add some spice to your web site using the easy music editing tools of Sound Studio. All the best web 
sites will have true multimedia support which allows for incidental background music as you surf

Sound Studio allows you to create, edit and save off your music in a format recognised by most web 
browsers

Web Music Editing features:

Create instant backing tracks by using any of the 20 fully arranged styles.
(No copyright restrictions on the styles)

Play around with various chord types and create amazing chord sequences

Convert your finished masterpiece to a Standard MIDI file in one easy step ready to be included on your 
web site

Record Audio at various sample rates - even 11kHz mono which is ideal for web pages






